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Safety Information

Before installing this product, read the Safety Information book.

Antes de instalar este produto, leia o Manual de Informações sobre Segurança.

Před instalací tohoto produktu si přečtěte příručku bezpečnostních instrukcí.

Læs hæftet med sikkerhedsforskrifter, før du installerer dette produkt.

Lue Safety Information -kirjanen, ennen kuin asennat tämän tuotteen.

Avant de procéder à l’installation de ce produit, lisez le manuel Safety Information.

Vor Beginn der Installation die Broschüre mit Sicherheitshinweisen lesen.

Przed zainstalowaniem tego produktu należy przeczytać broszurę Informacje Dotyczące
Bezpieczeństwa.

Prima di installare questo prodotto, leggere l’opuscolo contenente le informazioni
sulla sicurezza.

Lees voordat u dit product installeert eerst het boekje met veiligheidsvoorschriften.

Les heftet om sikkerhetsinformasjon (Safety Information) før du installerer dette
produktet.

Antes de instalar este produto, leia o folheto Informações sobre Segurança.

Перед установкой продукта прочтите брошюру по технике безопасности
(Safety Information).
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Pred inštaláciou tohto produktu si pre ítajte Informa nú brožúrku o bezpe nosti.

Preden namestite ta izdelek, preberite knjižico Varnostne informacije.

Antes de instalar este producto, lea la Información de Seguridad.

Läs säkerhetsinformationen innan du installerar den här produkten.

Installálás el tt olvassa el a Biztonsági el írások kézikönyvét !

Statement 1:

DANGER

Electrical current from power, telephone, and communication cables is
hazardous. To avoid a shock hazard:

v Do not connect or disconnect any cables or perform installation,
maintenance, or reconfiguration of this product during an electrical
storm.

v Connect all power cords to a properly wired and grounded electrical
outlet.

v Connect to properly wired outlets any equipment that will be attached to
this product.

v When possible, use one hand only to connect or disconnect signal
cables.

v Never turn on any equipment when there is evidence of fire, water, or
structural damage.

v Disconnect the attached power cords, telecommunications systems,
networks, and modems before you open the device covers, unless
instructed otherwise in the installation and configuration procedures.

v Connect and disconnect cables as described in the following table when
installing, moving, or opening covers on this product or attached
devices.

To connect:

1. Turn everything OFF.

2. First, attach all cables to devices.

3. Attach signal cables to connectors.

4. Attach power cords to outlet.

5. Turn device ON.

To disconnect:

1. Turn everything OFF.

2. First, remove power cords from outlet.

3. Remove signal cables from connectors.

4. Remove all cables from devices.
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Statement 2:

CAUTION:

When replacing the lithium battery, use only IBM Part Number 38L3386 or an
equivalent type battery recommended by the manufacturer. If your system has
a module containing a lithium battery, replace it only with the same module
type made by the same manufacturer. The battery contains lithium and can
explode if not properly used, handled, or disposed of.

Do not:

v Throw or immerse into water.

v Heat to more than 100 C (212 F)

v Repair or disassemble

Dispose of the battery as required by local ordinances or regulations.

Statement 5:

CAUTION:

The power control button on the device and the power switch on the power
supply do not turn off the electrical current supplied to the device. The device
also might have more than one power cord. To remove all electrical current
from the device, ensure that all power cords are disconnected from the power
source.

1

2
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Preface

This book provides information for configuring an IBM
®

Netfinity
®

ServeRAID™

controller, installing device drivers, and installing and using the ServeRAID utility
programs.

Note: The IBM ServeRAID product can be either a controller on an adapter, such
as the one in this option package, or a controller on the system board of
your server. For consistency in this manual, the ServeRAID product is
referred to as a ServeRAID controller, unless it is specifically noted
otherwise.

To install device drivers and utility programs for an IBM ServeRAID controller
that comes as a standard feature on an IBM Netfinity or PC Server system
board, see the installation instructions and CDs provided with your server for
instructions.

How this book is organized
“Chapter 1. Getting started” on page 1 contains introductory information about the
IBM ServeRAID-4H controller and general information about RAID technology.

“Chapter 2. Installing and configuring ServeRAID controllers” on page 13 explains
the ServeRAID installation and configuration process. You can refer to the
information in this chapter when configuring one or more devices attached to a
ServeRAID controller.

“Chapter 3. Configuring two ServeRAID controllers in a failover environment
(Windows NT 4.0 and Windows 2000 only)” on page 61 contains instructions for
configuring two ServeRAID controllers in a failover environment.

“Chapter 4. Introduction to IBM ServeRAID Cluster Solution” on page 69 through
“Chapter 10. Monitoring and updating an IBM ServeRAID Cluster Solution” on
page 101 contains information for installing and configuring ServeRAID controllers
in a clustering environment.

“Chapter 11. Using utility programs” on page 107 contains instructions for using the
Mini-Configuration, IPSSEND, and IPSMON programs. You can use these
operating-system specific programs to maintain and monitor your ServeRAID
subsystem.

“Chapter 12. Solving ServeRAID problems” on page 125 describes the ServeRAID
POST error codes and startup messages. This chapter also includes some basic
information for rebuilding a defunct drive.

“Chapter 13. Getting help, service, and information” on page 147 provides
information about accessing the IBM HelpCenter and World Wide Web sites to
obtain future code and information updates for the ServeRAID controller.

“Appendix. Product warranties and notices” on page 155 contains warranty
information, product notices, and trademarks.

© Copyright IBM Corp. 2000 xi



Notices used in this book
This book contains notices to highlight information as follows:

v Notes: These notices provide important tips, guidance, or advice.

v Attention: These notices indicate possible damage to programs, devices, or
data. An attention notice is placed just before the instruction or situation in which
damage could occur.

v Caution: These notices indicate situations that can be potentially hazardous to
you. A caution notice is placed just before descriptions of potentially hazardous
procedure steps or situations.

Related publications
The following books are available on the IBM ServeRAID Support CD in the
/BOOKS directory:

v IBM Netfinity ServeRAID-4H Ultra160 SCSI Controller User’s Reference
(4SRAIDUR.PDF)

v IBM Netfinity ServeRAID-3H, ServeRAID-3HB, and ServeRAID-3L Ultra2 SCSI
Controllers Installation and User’s Guide (3SRAIDUG.PDF)

The following booklets are extracted from the IBM Netfinity ServeRAID-4H Ultra160
SCSI Controller User’s Reference and are available on the IBM ServeRAID Support
CD in the /BOOKS directory:

v IBM ServeRAID-4H Ultra160 SCSI Controller Installation Guide (4INSTALL.PDF)

v Configuring IBM ServeRAID Controllers for Failover (4FAILCFG.PDF)

v Installing the IBM ServeRAID Cluster Solution (4CLUSTER.PDF)

v Understanding IBM ServeRAID Technology (4TECHNOL.PDF)

Note: Use Adobe Acrobat Reader to view these files. The IBM ServeRAID Support
CD has the Acrobat Readers for Microsoft Windows, IBM OS/2, and Linux in
the /BOOKS directory.

If you are installing the IBM ServeRAID Cluster Solution, you might need to refer to
the IBM Shared Disk Clustering Hardware Reference.This book provides general
information about planning and configuring a shared-disk cluster using IBM Netfinity
and PC Server products. It contains illustrations, descriptions, and parts listings for
various high-availability, shared-disk cluster examples.

Note: You can obtain this publication from the IBM Support Web site. See
“Downloadable files from the World Wide Web” on page 14 for additional
information.
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Chapter 1. Getting started

This book provides information needed to install and configure an IBM
ServeRAID-4H Ultra160 SCSI controller. This high-performance, redundant array of
independent disk (RAID) controllers are ideally suited for data-storage environments
that require superior performance, flexibility, and reliable data storage. (See
“Controller features” on page 15 for more information.)

You also can use the configuration and reference information in this book to
configure the IBM ServeRAID controllers provided on some IBM Netfinity and PC
Server system boards.

Option package contents
In addition to this book, the ServeRAID option package contains:

v IBM Netfinity ServeRAID-4H Ultra160 SCSI controller

Attention: Do not open the static-protective bag containing the controller until
you are instructed to do so.

v IBM ServeRAID Support Package:

– IBM ServeRAID Support CD

– IBM ServeRAID Device Drivers diskette

– IBM ServeRAID Device Drivers for SCO Operating Systems - UnixWare HBA
and OpenServer BTLD diskette

See “Obtaining ServeRAID updates” on page 13 and “Step 4: Installing device
drivers” on page 33 for more detailed information.

Contact your place of purchase if any items are missing or damaged.

Understanding RAID technology
RAID is the technology of grouping several physical drives in a computer into an
array that you can define as one or more logical drives. Each logical drive appears
to the operating system as a single drive. This grouping technique greatly enhances
logical-drive capacity and performance beyond the physical limitations of a single
physical drive.

When you group multiple physical drives into a logical drive, the ServeRAID
controller can transfer data in parallel from the multiple drives in the array. This
parallel transfer yields data-transfer rates that are many times higher than with
nonarrayed drives. This increased speed makes the system better able to meet the
throughput (the amount of data processed in a given amount of time) or productivity
needs of the multiple-user network environment.

The ability to respond to multiple data requests provides not only an increase in
throughput, but also a decrease in response time. The combination of parallel
transfers and simultaneous responses to multiple requests allows disk arrays to
provide a high level of performance in network environments.

© Copyright IBM Corp. 2000 1



Stripe-unit size
With RAID technology, data is striped across an array of physical drives. This
data-distribution scheme complements the way the operating system requests data.

The granularity at which data is stored on one drive of the array before subsequent
data is stored on the next drive of the array is called the stripe-unit size.

You can control the stripe-unit size and maximize the performance of your
ServeRAID controller by setting a stripe-unit size to a value that is close to the size
of the system I/O requests. You can set the stripe-unit size to 8 KB, 16 KB, 32 KB,
or 64 KB. For example, performance in transaction-based environments, which
typically involve large blocks of data, might be optimal when the stripe-unit size is
set to 32 KB or 64 KB. However, performance in file and print environments, which
typically involve multiple small blocks of data, might be optimal when the stripe-unit
size is set to 8 KB or 16 KB.

The collection of stripe units, from the first drive of the array to the last drive of the
array, is called a stripe.

The ServeRAID-4H controller supports 16 physical drives in an array if the
stripe-unit size is set to 32 KB or 64 KB.

Supported RAID levels
Disk arrays are used to improve performance and reliability. The amount of
improvement depends on the application programs that you run on the server and
the RAID levels that you assign to the logical drives.

The ServeRAID controllers support RAID level-0, 1, 1E, 5, 5E, 00, 10, 1E0, and 50.

Understanding RAID level-0
RAID level-0 stripes the data across all the drives in the array. This offers
substantial speed enhancement, but provides no data redundancy. RAID level-0
provides the largest storage capacity of the RAID levels that are offered, because
no room is taken for redundant data or data-parity storage.

RAID level-0 requires a minimum of one drive and, depending upon the level of
firmware and the stripe-unit size, supports a maximum of 8 or 16 drives.

The following illustration shows an example of a RAID level-0 logical drive.

Start with two physical drives.
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Create an array using the two physical drives.

Then, create a logical drive within that array.

The data is striped across the drives, creating blocks.

Notice that the data is striped across all the drives in
the array, but no redundant data is stored.

1 2

3 4

5 6

7 8

A physical drive failure within the array results in loss of data in the logical drive
assigned RAID level-0, but only in that logical drive. If you have logical drives
assigned RAID level-1, 1E, 5, or 5E in the same array, they will not lose data.

Note: If you have an array that contains only one physical drive, you can assign
only RAID level-0 to the logical drive in that array.

When you replace a failed drive, the ServeRAID controller can rebuild all the RAID
level-1E and RAID level-5E logical drives automatically onto the replacement
physical drive. However, any data stored in a failed RAID level-0 logical drive is
lost.

Although the risk of data loss is present, you might want to assign RAID level-0 to
one of the logical drives to take advantage of the speed this RAID level offers. You
can use this logical drive to store data that you back up each day and for which
safety is not of primary importance, that is, data that you can re-create easily. You
also might want to use a RAID level-0 logical drive when you require maximum
capacity.

Understanding RAID level-1
RAID level-1 provides 100% data redundancy and requires only two physical drives.
With RAID level-1, the first half of a stripe is the original data; the second half of a
stripe is a mirror (that is, a copy) of the data, but written to the other drive in the
RAID level-1 array.

Chapter 1. Getting started 3



Because the data is mirrored, the capacity of the logical drive when assigned RAID
level-1 is 50% of the array capacity.

The following illustration shows an example of a RAID level-1 logical drive.

Start with two physical drives.

Create an array using the two physical drives.

Then, create a logical drive within that array.

The data is striped across the drives, creating blocks.

Notice that the data on the drive on the right is a copy
of the drive on the left.

1 1

2 2

3 3

4 4

With RAID level-1, if one of the physical drives fails, the ServeRAID controller
switches read and write requests to the remaining functional drive in the RAID
level-1 array.

Understanding RAID level-1 Enhanced
If you have three or more physical drives in the array, you cannot select RAID
level-1; you can select RAID level-1 Enhanced (RAID level-1E).

RAID level-1E combines mirroring with data striping. This RAID level stripes data
and copies of the data across all of the drives in the array. As with the standard
RAID level-1, the data is mirrored, and the capacity of the logical drive is 50 percent
of the array capacity of the grouping of physical drives in the array.
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RAID level-1E requires a minimum of 3 drives and, depending upon the level of
firmware and the stripe-unit size, supports a maximum of 8 or 16 drives.

The following illustration is an example of a RAID level-1E logical drive.

Start with three physical drives.

Create an array using the physical drives.

Then, create a logical drive within that array.

The data is striped across the drives, creating
blocks.

Notice that the stripe labeled . is the data
stripe and the stripe labeled .. is the copy of
the preceding data stripe. Also notice that
each block on the mirror stripe is shifted one
drive.

1 2

6

3

5

4

1

4 6

5

3

2

*

*

**

**

With RAID level-1E, if one of the physical drives fails, the ServeRAID controller
switches read and write requests to the remaining functional drives in the RAID
level-1E array.

Understanding RAID level-5
RAID level-5 requires a minimum of three physical drives. This RAID level stripes
data and parity across all drives in the array. When you assign RAID level-5 to an
array, the capacity of the array is reduced by the capacity of one drive (for
data-parity storage).
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RAID level-5 offers both data protection and increased throughput. RAID level-5
gives you higher capacity than RAID level-1, but RAID level-1 offers better
performance.

RAID level-5 requires a minimum of 3 drives and, depending upon the level of
firmware and the stripe-unit size, supports a maximum of 8 or 16 drives.

The following illustration is an example of a RAID level-5 logical drive.

Start with four physical drives.

Create an array using three of the
physical drives, leaving the fourth as a
hot-spare drive.

Then, create a logical drive within that
array.

The data is striped across the drives,
creating blocks.

Notice that the storage of the data
parity (denoted by .) also is striped,
and it shifts from drive to drive.

A parity block (.) contains a
representation of the data from the
other blocks in the same stripe. For
example, the parity block in the first
stripe contains data representation of
blocks 1 and 2.

1 2

3

5

7

4

6

8

2*

*

*

*
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If a physical drive fails in the array,
the ServeRAID controller switches
read and write requests to the
remaining functional drive in the RAID
level-5 array, which is a hot-spare
drive.

2

3

5

4

8

2*

*

*

1

7

6

*

Understanding RAID level-5 Enhanced
RAID level-5 Enhanced (RAID level-5E) requires a minimum of four physical drives.
RAID level-5E is also firmware-specific. You can think of RAID level-5E as “RAID
level-5 with a built-in spare drive.”

Reading from and writing to four disk drives is more efficient than three disk drives
and an idle hot spare and therefore improves performance. Additionally, the spare
drive is actually part of the RAID level-5E array, as shown in the following example.
With such a configuration, you cannot share the spare drive with other arrays. If you
want a spare drive for any other array, you must have another spare drive for those
arrays.

Like RAID level-5, this RAID level stripes data and parity across all of the drives in
the array. When an array is assigned RAID level-5E, the capacity of the logical
drive is reduced by the capacity of two physical drives in the array (that is, one for
parity and one for the spare).

RAID level-5E offers both data protection and increased throughput, in addition to
the built-in spare drive.

Note: For RAID level-5E, you can have only one logical drive in an array. When
using RAID level-5E, you can have a maximum of seven logical drives on
the controller.

RAID level-5E requires a minimum of 4 drives and, depending upon the level of
firmware and the stripe-unit size, supports a maximum of 8 or 16 drives.

The following illustration is an example of a RAID level-5E logical drive.

Start with four physical drives.
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Create an array using all four physical
drives.

Then, create a logical drive (labeled
as 1) within the array.

Notice that the distributed spare drive
is the free space (labeled as 2) shown
below the logical drive.

2

1

The data is striped across the drives,
creating blocks in the logical drive.

The storage of the data parity
(denoted by

*
) is striped, and it shifts

from drive to drive as it does in RAID
level-5.

Notice that the spare drive is not
striped.

5

7

1*

*

2

6

8

4

*

3

9

If a physical drive fails in the array,
the data from the failed drive is
compressed into the distributed spare
drive. The logical drive remains RAID
level-5E.

When you replace the failed drive, the
data for the logical drive
decompresses and returns to the
original striping scheme.

9

3

5

7

1*

*

*

*

2

6

8

4

*

Note: The ServeRAID Manager program Express configuration does not default to
RAID level-5E. If you have four physical drives, Express configuration
defaults to RAID level-5 with a hot-spare drive.

Understanding RAID level-x0
RAID level-x0 refers to RAID levels-00, 10, 1E0, and 50. RAID level-x0 includes
more physical drives in an array. The benefits of doing so are larger logical drives,
increased performance, and increased reliability. RAID levels-0, 1, 1E, 5, and 5E
cannot use more than 16 physical drives in an array. However, RAID levels-00, 10,
1E0, and 50 include more physical drives by managing an array of arrays, or a
spanned array. The operating system uses the spanned array logical drive the
same as a regular array logical drive.

Note: RAID level-x0 is only available on the IBM ServeRAID-4H Ultra160 SCSI
controller.

RAID level-x0 requires a minimum of 2 drives and supports a maximum of 60
drives.
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The following illustration is an example of a RAID level-10 logical drive.

Start with six physical drives.

Create three arrays (labeled
A, B, and C), each array
using two physical drives.

AA B CA

Then, create a spanned array
(labeled as 1) that spans the
three arrays. AA B C

111

A

1

A sub-logical drive is created
within each array (A, B, and
C). Then, the data is striped
across the physical drives in
the array, creating blocks.

Notice that, in each array, the
data on the drive on the right
is a copy of the drive on the
left. This is because the
sub-logical drives (A, B, and
C) are RAID level-1 in a RAID
level-10 implementation (see
the following table).

AA B C

1

1

2

3

4

5

7

6

8

1

2

3

4

5

7

6

8

1

2

3

4

5

7

6

8

1

2

3

4

5

7

6

8

1

2

3

4

5

7

6

8

1

2

3

4

5

7

6

8

11

A

1

Then, create a logical drive
within the spanned array (1).
The data is striped across this
logical drive, creating blocks.
Notice that none of these
blocks are redundant. This is
because the logical drive (1)
is RAID level-0 in a RAID
level-x0 implementation (see
the following table).

AA B C

1

1

2

3

4

5

7

6

8

1

2

3

4

5

7

6

8

1

2

3

4

5

7

6

8

1

2

3

4

5

7

6

8

1

2

3

4

5

7

6

8

1

2

3

4

5

7

6

8

11

A

1

1

2 3

54

7

10

8

11

6

9

12
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RAID level means the sub-logical drive is and the spanned array logical
drive is

00 RAID level-0 RAID level-0
10 RAID level-1 RAID level-0
1E0 RAID level-1E RAID level-0
50 RAID level-5 RAID level-0

With RAID level-10, 1E0, and 50, if one of the physical drives fails in a sub-logical
drive, the ServeRAID controller switches read and write requests to the remaining
functional drives in the sub-logical drive. With RAID level-00, a physical drive failure
within the sub-logical drive results in loss of data.

Selecting a RAID level and performance tuning
When selecting a RAID level for your system, consider the following:

RAID level Data
Redundancy

Hard Disk Drive
Capacity Utilization

Read
Performance

Write
Performance

Built-in Spare
Drive

RAID level-0 No 100% Excellent Excellent No

RAID level-1 Yes 50% Very good Very good No

RAID level-1E Yes 50% Very good Very good No

RAID level-5 Yes 67% to 94% Excellent Good No

RAID level-5E Yes 50% to 88% Excellent Good Yes

RAID level-00 No 100% Excellent Excellent No

RAID level-10 Yes 50% Very good Very good No

RAID level-1E0 Yes 50% Very good Very good No

RAID level-50 Yes 67% to 94% Excellent Good No

Drive state descriptions
This section provides descriptions of the physical and logical drive states.

Physical drive state descriptions
The following table provides descriptions of the valid physical drive states.

Drive State Meaning

Defunct A physical drive in the online, hot-spare, or rebuild state has become
defunct. It does not respond to commands, which means that the
ServeRAID controller cannot communicate properly with the drive.

If a physical drive has become defunct, refer to “Rebuilding a defunct
drive” on page 136.

Hot spare A hot-spare drive is a physical drive that is defined for automatic use
when a similar drive fails.

Online The drive is online. It is functioning properly and is part of an array.

Rebuilding The drive is being rebuilt.

For more information on rebuilding a drive, refer to “Rebuilding a defunct
drive” on page 136.

1. Disk utilization, read, and write performance depend on the number of drives in the array. Generally, the more drives in the array,
the better your performance.
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Drive State Meaning

Ready The ServeRAID controller recognizes a ready drive as being available for
definition.

Standby Hot
Spare

A standby hot spare is a hot-spare drive that the ServeRAID controller
has spun down. If an online drive becomes defunct and no suitable
hot-spare drive is available, a standby hot-spare drive of the appropriate
size automatically spins up, and enters the rebuild state.

Logical drive state descriptions
The following table provides descriptions of the valid logical drive states.

Drive State Meaning

Blocked During a rebuild operation, the ServeRAID controller sets the state of any
RAID level-0 logical drives associated with a failed array to the blocked
state; then, it reconstructs the data that was stored in RAID level-1, RAID
level-1E, RAID level-5 and RAID level-5E logical drives.

After the rebuild operation completes, you can unblock the RAID level-0
logical drives, and access them once again. However, the logical drive
might contain damaged data. You must either re-create, reinstall, or
restore the data from the most recent backup disk or tape to the RAID
level-0 logical drive.

Critical Migrating A logical drive in the critical state that is undergoing a logical drive
migration (LDM).

Critical System The ServeRAID controller uses this reserved state during a logical drive
migration (LDM) when the logical drive is in the critical state.

Critical A RAID level-1, RAID level-1E, RAID level-5, or RAID level-5E logical
drive that contains a defunct physical drive is in the critical state. A
critical logical drive is accessible, despite a physical drive failure.

Attention: If the state of the logical drive is critical, refer to “Rebuilding
a defunct drive” on page 136.

Migrating The logical drive is undergoing a logical drive migration; that is, a change
in RAID levels, a change in logical drive size, an increase in free space,
or a RAID level-5E compression or decompression.

Offline The logical drive is offline and not accessible. This state occurs when
one of the following is true.

v One or more physical drives in a RAID level-0 logical drive are
defunct.

v Two or more physical drives in a RAID level-1, RAID level-1E, or RAID
level-5 logical drive are defunct.

v Three or more drives in a RAID level-5E logical drive are defunct.

If any of these are true, refer to “Rebuilding a defunct drive” on page 136.

Okay The logical drive is okay. It is in a good, functional state.

System The ServeRAID controller uses this reserved state during logical drive
migration (LDM).
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Chapter 2. Installing and configuring ServeRAID controllers

The following are the steps in the ServeRAID installation process:

Step 1. Install and cable the ServeRAID controller

Step 2. Update BIOS and firmware

Step 3. Configure the ServeRAID controller

Step 4. Install ServeRAID device drivers while installing the operating system

Step 5. Install the ServeRAID Manager program

Step 6. Start the ServeRAID Manager program

The ServeRAID installation process is now complete.

Obtaining ServeRAID updates
IBM periodically makes updated versions of the ServeRAID firmware, device
drivers, and utility programs available from the IBM Support page on the World
Wide Web. In addition to the updated device drivers and utility programs, there is a
command-line program available from the World Wide Web.

Note: If you need to update any ServeRAID software, you must update all
ServeRAID software at the same time to ensure compatibility with all of the
levels of the software. This includes:
v BIOS/firmware
v Device drivers
v ServeRAID Manager program
v Command-line programs.

You can download the most current versions of the ServeRAID device
drivers and utility programs or a copy of the IBM ServeRAID Command-Line
Programs diskette from the World Wide Web (see “Downloadable files from
the World Wide Web” on page 14).

Refer to the README file on your diskette or CD for installation instructions.

If you do not have access to the World Wide Web, contact your place of
purchase, your IBM reseller, or your IBM marketing representative for
replacement CDs or diskettes.

The IBM ServeRAID Support CD contains the following:

v ServeRAID Manager program. Use this program to configure arrays and logical
drives using ServeRAID controllers. This program is available in the following
directory:
d:/PROGRAMS/operatingsystem/MANAGER

where d is the CD-ROM drive and operatingsystem is the specific operating
system you are using in the ServeRAID installation.

v Device drivers. These files are available in the following directory:
d:/PROGRAMS/operatingsystem/DRIVER

where d is the CD-ROM drive and operatingsystem is the specific operating
system you are using in the ServeRAID installation.
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v Command-line programs. These command-line programs are available in the
following directory:
d:/PROGRAMS/operatingsystem/CMDLINE

where d is the CD-ROM drive and operatingsystem is the specific operating
system you are using in the ServeRAID installation.

v ServeRAID files needed to install Microsoft Cluster Service (MSCS) when using
Microsoft® Windows® NT® or Windows 2000 and an IBM ServeRAID-4H Ultra160
SCSI controller. These files are available in the following directory:
d:/PROGRAMS/WINNT/CLUSTER

where d is the CD-ROM drive.

The IBM ServeRAID Device Drivers diskette contains the following:
v Device drivers for Microsoft Windows NT, Windows 2000, IBM OS/2

®

, Novell
NetWare, and Red Hat Linux 6.1

v DOS CD-ROM drive device drivers

The IBM ServeRAID Device Drivers for SCO Operating Systems - UnixWare HBA
and OpenServer BTLD diskette contains the following:
v Device drivers for SCO OpenServer 5.0.5
v Device drivers for SCO UnixWare 7.1

Downloadable files from the World Wide Web
You can download new and updated files for the IBM ServeRAID and Clustering
products from the IBM Support Web site:

http://www.ibm.com/pc/support/

To access ServeRAID and Clustering support, follow these steps:

1. Click Servers on the IBM Support page. The IBM Netfinity and PC Server
Support page appears.

2. Select ServeRAID or Clustering from the Family list box. The ServeRAID or
Clustering Support page appears.

3. On this page, you can select from the following categories in the left margin:

Downloadable files
Download the latest versions of Clustering software, the ServeRAID
Manager program, BIOS/firmware, device driver updates, and other
important information.

Hints and tips
Obtain useful information for the IBM Clustering and for ServeRAID
products and troubleshooting potential problems.

Online publications
Download the installation and user’s guides, references, redbooks, and
other IBM publications.

You can also review information on parts, products, and software.
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Step 1: Installing and cabling a ServeRAID controller
This section provides installation and cabling instructions for the ServeRAID-4H
controller as well as basic information about the standard features of this controller.

If you are using a ServeRAID controller on an IBM Netfinity or PC Server system
board, you will not need the information in this section. Continue with “Step 2:
Updating BIOS and firmware code” on page 21.

Controller features
Standard features of the ServeRAID controller are as follows.

Feature ServeRAID-4H

Arrays (max.) 8

Battery-backup cache Yes

Cache memory 128 MB

Hard disk drives (max.) 60

Logical drives (max.) 8

Microprocessor 266 MHz

SCSI channels 4

SCSI transfer speed (max.) 160 MB per sec.

Supported RAID levels 0, 1, 5, Enhanced-1 (1E), and Enhanced-5 (5E), 00,
10, 1E0, 50

System PCI data bus 64 bit at 33 MHz

Connector locations
This section provides illustrations of the SCSI channel connectors and cable
connectors for the ServeRAID-4H controller.

The light-emitting diodes (LEDs) on the controllers indicate activity on the SCSI
channels and provide diagnostic information for trained service technicians.

ServeRAID-4H controller
The ServeRAID-4H controller has four independent SCSI channel connectors:
Channel 1, Channel 2, Channel 3, and Channel 4. Each of these SCSI channels
supports up to 15 physical devices.

Note: The battery-backup cache protects the data being stored in the ServeRAID
cache memory during a power outage or failure when using the write-back
mode.
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You can attach internal SCSI devices to the Channel 1 and Channel 2 connectors.
You can attach external SCSI devices to the Channel 1, Channel 2, Channel 3, and
Channel 4 connectors.

CAUTION:
The ServeRAID-4H controller uses a lithium battery.

Statement 2:

CAUTION:

When replacing the lithium battery, use only IBM Part Number 38L3386 or an
equivalent type battery recommended by the manufacturer. If your system has
a module containing a lithium battery, replace it only with the same module
type made by the same manufacturer. The battery contains lithium and can
explode if not properly used, handled, or disposed of.

Do not:

v Throw or immerse into water.

v Heat to more than 100 C (212 F)

v Repair or disassemble

Dispose of the battery as required by local ordinances or regulations.

Internal Channel 2

Internal Channel 1

Battery-backup cache

External Channel 1

External Channel 2

External Channel 3

External Channel 4

Figure 1. ServeRAID-4H controller
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Using a ServeRAID controller in a server with Hot-plug PCI features
Some IBM Netfinity servers support Hot-plug (Active) PCI features. You can use
these features to install or remove PCI controllers without turning off the server. The
ServeRAID-4H controller supports Hot-plug PCI functions on Windows NT 4.0,
Windows 2000, and NetWare. The following table summarizes which operating
systems support these features:

Feature Windows NT
4.0

Windows 2000 NetWare 4.x NetWare 5.x

Hot add Yes Yes No Yes

Hot remove No Yes Yes Yes

Hot replace Yes No No No

You can use the hot-add feature to expand capacity in a server by adding a
controller. Use the hot-remove feature to remove a controller from a running server.
If a controller fails, use the hot-replace feature to replace a controller with an
identical controller.

Using Windows NT 4.0 with Hot-plug PCI features
To use Hot-plug PCI with Windows NT 4.0 and a ServeRAID-4H controller, you
must install the IBM Netfinity Hot Plug for Windows NT 4.0 Package, version 4.1 or
later. This package is available from the IBM Support Web site; select downloadable
files for the IBM Netfinity server you are using. See “Downloadable files from the
World Wide Web” on page 14 for additional information.

Note: Be sure to read the instructions and restrictions for this software program.

Also, when installing the ServeRAID Manager program, you must choose to install
the IBM ServeRAID Hot Replace Wizard.

To perform a hot-replace operation, start the IBM ServeRAID Hot Replace Wizard.
You can start this program from within either the IBM Netfinity Hot Plug for Windows
NT 4.0 program or the ServeRAID Manager program. You can use the ServeRAID
Manager program to start the wizard either on the server with the failed controller,
or across the network from a remote installation of the ServeRAID Manager.

Note: It is useful to start the IBM ServeRAID Hot Replace Wizard from a remote
installation when the server with the failed controller does not have a
monitor.

Attention: Do not attempt a hot-replace operation on Windows 2000 or NetWare
by hot- removing a failed controller; then, hot-adding a new controller. Loss of data
can occur. If a controller fails on these operating systems, you must shut down the
server to replace the controller.

Installing the ServeRAID controller
During the installation, you might need a small, flat-blade screwdriver and the
documentation that comes with your server.

To install the ServeRAID-4H controller:

1. Review “Safety Information” on page vii and the Safety Information book
provided with your Netfinity server.
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Note: Some IBM Netfinity servers support Hot-plug PCI features, which allow
you to install or remove PCI controllers without turning off the server. If
your Netfinity model provides Hot-plug PCI support and you are using
Windows NT, Windows 2000, or NetWare 5.x, you do not need to turn
off your server to install this controller. This operation is referred to as a
hot-add operation. Review the following information before performing
this operation on a ServeRAID-4H and your server:

v Information that is provided with your server to determine if your
model supports these features.

v Documentation that is provided with your operating system for using
these features.

v Refer to “Using a ServeRAID controller in a server with Hot-plug PCI
features” on page 17.

v If you intend to perform a hot-add operation using Windows NT 4.0,
use the documentation that is provided with the IBM Netfinity Hot
Plug for Windows NT 4.0 package.

2. If your server model does not support Hot-plug PCI, turn off the server and
disconnect all power cords and cables from the server.

3. Remove the server cover and locate an empty PCI expansion slot for the
controller. Choose a slot that is farthest from other installed components, such
as the microprocessor. If necessary, see your server documentation for more
detailed information about the expansion slots.

Note: For Netfinity 3000 servers, the ServeRAID controllers are supported
only when installed in PCI slot 3. Do not install these controllers in PCI
slots 1 or 2. Before you can install a ServeRAID controller in a Netfinity
3000, you must first remove the standard SCSI controller that comes in
PCI slot 3. You can install and use the standard SCSI controller in PCI
slots 1 or 2, but devices attached to the standard SCSI controller will no
longer provide startup (boot) support.

4. Remove the expansion-slot cover, if applicable.

5. Touch the static-protective package containing the controller to an unpainted
metal expansion-slot cover on the server. This drains any static electricity from
the package and from your body.

6. Remove the controller from the static-protective package, holding the controller
by the edges. Do not touch any exposed components on the controller.

7. Insert the controller in the PCI expansion slot. Press the controller firmly into
the slot so that it is fully seated.
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8. Secure the controller by either tightening the expansion-slot screw on the top
of the controller or closing the latch, depending on your server.

9. Connect the SCSI cables to the controller. If you intend to attach external
devices only, go to step 13 on page 20. Otherwise, continue with step 10

10. Connect one end of a 68-pin ANSI standard cable (separately purchased or
already in your server) to the internal channel connector on the ServeRAID
controller.

Note: See “Connector locations” on page 15 for the channel connector
locations.

2. ANSI stands for American National Standards Institute.

Figure 2. Inserting a ServeRAID-4H controller into the PCI expansion slot
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11. Connect the other end of the SCSI cable to the Active PCI backplane or to a
SCSI device in the server. (See your server documentation or the system label
inside the server cover for the location of the SCSI connector on the
backplane.)

Note: When the ServeRAID controller and a SCSI CD-ROM drive are
connected to the same SCSI bus (cable), you must enable the
ServeRAID startable (boot) CD feature before the controller can start
from a CD. See “Setting the Bootable CD-ROM feature” on page 109 for
more information.

12. If you have physical drives to install, install them now. See your server
documentation for drive installation instructions.

Notes:

a. The ServeRAID controllers use SCSI ID 7.

b. (NetWare only) Removable-media devices (such as a CD-ROM drive)
connected to the same ServeRAID controller must each have unique SCSI
IDs, even when they are connected to different channels. For example, if
you have a CD-ROM drive on Channel 1 set to SCSI ID 6, you must not
have another CD-ROM drive on Channel 2 or Channel 3 of the same
ServeRAID controller set to SCSI ID 6.

13. Install the server cover.

14. If you disconnected the cables and power cords in step 2 on page 18,
reconnect the cables and cords. See your server documentation if you need
detailed instructions.

15. If you want to attach an external SCSI device to the ServeRAID controller,
continue with “Connecting external devices” on page 21. Otherwise, go to
“Step 2: Updating BIOS and firmware code” on page 21.

Figure 3. Connecting a ServeRAID-4H controller internal channel connector
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Connecting external devices

Note: The ServeRAID-4H controller does not support configurations that use both
the internal and external connectors on the same channel concurrently. For
example, you cannot use both external Channel 1 and internal Channel 1.

To attach SCSI devices to an external channel connector on the ServeRAID
controller:

1. Connect one end of a 68-pin very high density connector interface (VHDCI)
SCSI cable to an external channel connector on the ServeRAID controller.

Note: See “Connector locations” on page 15 for the channel connector
locations.

2. Connect the other end of the SCSI cable to the external SCSI device.

3. Continue with “Step 2: Updating BIOS and firmware code”.

Step 2: Updating BIOS and firmware code
Before configuring the ServeRAID controller, you must have the latest BIOS and
firmware code installed on your server.

1. Insert the IBM ServeRAID Support CD into the server CD-ROM drive.

2. Turn on the server. The FlashMan program automatically starts.

FlashMan is an easy to use program that simplifies the updating of BIOS and
firmware code on ServeRAID controllers. FlashMan automatically scans and
identifies each ServeRAID controller in your system. After scanning completes
and if an update is required, a report screen opens with the following
information:
v Controller types found
v Controller slot number, if known
v Firmware version
v BIOS version
v Update status. If a controller has outdated BIOS or firmware, FlashMan

marks the controller as a candidate for update.

Figure 4. Connecting a ServeRAID-4H controller external channel connector
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If the BIOS and firmware code do not require updating, FlashMan automatically
exits and the ServeRAID Manager program opens. Continue with “Step 3:
Configuring ServeRAID controllers”.

If the BIOS and firmware code require updating, FlashMan asks if you want to
update. You decide whether to update your controllers, but you must update all
the controllers or none (that is, you cannot selectively update).

3. Click Update. FlashMan displays a progress indicator as it updates the
controllers. If FlashMan detects an error, it displays the error message and
saves the error message to a file on the disk.

If you do not want to update your ServeRAID controllers, click Cancel.

4. When all updates are complete, scroll through the Features window. This
window reports the changes that FlashMan applied to your ServeRAID
controllers.

5. Leaving the IBM ServeRAID Support CD in the CD-ROM drive, shut down and
restart the server.

Note: If you update the ServeRAID BIOS/firmware code after the initial
configuration, you must clear the ServeRAID logs. You can do this with the
ServeRAID Manager installed on your server:

1. Start the ServeRAID Manager.

2. In the Main Tree, click the Local system icon.

3. Click Actions → Clear all controller event logs.

4. Click Yes to confirm the action.

If you do not use the ServeRAID Manager installed on your server, you can
use the IPSSEND utility program for your operating system. Type the
following at a command prompt:

ipssend eraseevent n soft
ipssend eraseevent n hard
ipssend eraseevent n device

where n is the number of ServeRAID controllers installed in the server (1 -
7). For example, if n is 1, the ServeRAID logs for the first (or only)
ServeRAID controller are cleared.

Step 3: Configuring ServeRAID controllers
This section provides information about starting and using the ServeRAID Manager
program. You can use the ServeRAID Manager program to configure your
ServeRAID controllers, view the ServeRAID configuration and associated devices,
create arrays and logical drives, delete an array, dynamically increase the
logical-drive size, change RAID levels, and much more.

The information in this section is an overview of the ServeRAID Manager program
and its capabilities. For instructions on specific processes using the ServeRAID
Manager program, refer to the ServeRAID Manager online help.

Using the ServeRAID Manager program
When you start the ServeRAID Manager program from the startable IBM
ServeRAID Support CD, you can configure your ServeRAID controller before you
install your operating system. In startable-CD mode, you can also change specific
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ServeRAID controller settings after you have configured the ServeRAID controller
and installed the operating system. Refer to “Using Information mode” on page 33
for additional information.

The ServeRAID Manager program runs in two modes: Configuration mode and
Information mode.

In Configuration mode, you can create disk arrays, create logical drives, and define
your hot-spare drives. When this mode is active, a limited set of functions is
available from the menu and tool bars. See “Using Configuration mode” on page 25
for more information.

In Information mode, you can view and modify the existing device and configuration
information for your ServeRAID subsystem. When this mode is active, you can use
the functions available from the menu and tool bars to customize settings for your
ServeRAID controllers. See “Using Information mode” on page 33 for more
information.

To start the ServeRAID Manager program, do the following:

1. Insert the IBM ServeRAID Support CD (or the CD that contains the ServeRAID
Manager program that came with your system) into the CD-ROM drive; then,
turn on the server.

One of the following windows will open:

v If the ServeRAID Manager program detects unconfigured ServeRAID
controllers, the program starts in Configuration mode and a window similar to
the following opens.
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Follow the instructions in the right panel to create logical drives on your
ServeRAID controller. If you do not want to configure your ServeRAID
controller, click Cancel. This will switch the program from Configuration mode
to Information mode.

v If the ServeRAID Manager program detects that all ServeRAID controllers in
the server are configured, the program starts in Information mode and a
window similar to the following opens.

Figure 5. Configuration mode window

24 IBM
®

Netfinity
®

User’s Reference: ServeRAID™-4H Ultra160 SCSI Controller



Click on the tool bar to switch from Information mode to Configuration
mode.

2. Continue with one of the following:
v “Using Configuration mode”.
v “Using Information mode” on page 33.

Using Configuration mode
You can use Configuration mode to create up to eight independent disk arrays for
each ServeRAID controller. Configuration mode provides two configuration options
Express configuration and Custom configuration (see Figure 5 on page 24). You can
also use Custom configuration to create spanned arrays and configure the logical
drive to RAID level-x0. For more information about RAID level-x0, refer to
“Understanding RAID level-x0” on page 8.

Figure 6. Information mode window
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Attention: The new controller stripe-unit size is set at the factory to 8 KB. If you
need to change this setting, you must change the stripe-unit size before you store
data in the logical drives. After you store data in the logical drives, you cannot
change the stripe-unit size without destroying data in the logical drives. To change
the stripe-unit size, do the following:
1. In the Main Tree, click the new controller.
2. Click Actions → Change stripe-unit size.
3. Click the new stripe-unit size for your installation on the menu.

Using Express configuration: To use Express configuration:

Note: If the Express configuration mode or Custom configuration mode radio

buttons do not display on the right panel, click on the tool bar.

1. In the Main Tree, click the ServeRAID controller that you want to configure.

2. If it is not already selected, click the Express configuration radio button.

3. Click Next. The Configuration summary window opens.

4. Review the information that displays in Configuration summary window.

Figure 7. Configuration summary window

26 IBM
®

Netfinity
®

User’s Reference: ServeRAID™-4H Ultra160 SCSI Controller



Notes:

a. Some operating systems have size limitations for logical drives. Before you
save the configuration, verify that the size of the logical drive is appropriate
for your operating system. See your operating-system documentation for
more detailed information.

b. To change the configuration, click Modify arrays or Modify logical drives.

5. Click Apply to accept and save the configuration. The configuration is saved in
the ServeRAID controller and in the physical drives.

6. If you have multiple controllers, for each controller repeat steps 1 on page 26
through step 5.

7. When you have completed configuration, you can change to Information mode
and change controller settings. See “Using Information mode” on page 33 for
more information. If you do not want to change any settings, exit the ServeRAID
Manager program and remove the CD from the CD-ROM drive.

8. Restart the server.

9. Continue with “Step 4: Installing device drivers” on page 33 to install the
ServeRAID device driver while installing your operating system.

Note: If you are configuring your startup (boot) ServeRAID controller, you must
install the device driver while installing the operating system.

Using Custom configuration: To use Custom configuration:

Note: If the Express configuration mode or Custom configuration mode radio

buttons do not display on the right panel, click on the tool bar.

1. In the Main Tree, click the ServeRAID controller that you want to configure.

2. Click the Custom configuration radio button.

3. Click Next. The Create arrays window opens:
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4. Using the right mouse button, click the drive or SCSI channel icons in the Main
Tree to select the drives that you want to add to your arrays, delete from your
arrays, or define as hot-spare drives; then, select a choice from the pop-up list.

If you want to create a spanned array, click the Span Arrays box.

5. After you select the ready drives for your arrays and define your hot-spare
drives, click Next. If you are not creating spanned arrays, the Create logical
drives window opens. Continue with step 8 on page 30.

If you are creating spanned arrays, the Create spanned arrays window opens.

Figure 8. Create arrays window
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6. Using the right mouse button, click the array icons in the Main Tree to select
the arrays that you want to add or delete to your spanned arrays; then, select
a choice from the pop-up list.

7. After you select the arrays for your spanned arrays, click Next. The Create
logical drives window opens.

Figure 9. Create spanned arrays window
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8. When creating your logical drives, you might change your mind about the
arrays you created. If so, you can:

v Remove a specific drive from a newly defined array or delete an entire
newly defined array. To do this, click Back; then, using the right mouse
button, click the specific drive or Array icon in the Main Panel on the right.
Select Remove from new array or Delete new array.

v Remove a specific hot-spare drive or all newly defined hot-spare drives. To
do this, click Back; then, using the right mouse button, click the Hot-spare
drive icon in the Main Panel on the right, and then select Remove new
hot-spare drive or Remove all new hot-spare drives.

9. Select a RAID level for the logical drive from the RAID pull-down menu in the
Main Panel. (Refer to “Supported RAID levels” on page 2.)

10. If you do not want to use the maximum size for the logical drive, move the
sliding bar in the Main Panel from right to left to allot data and parity space for
the logical drive, or type in the size in the data field.

Notes:

a. You can define from one to eight logical drives.

Figure 10. Create logical drives window
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b. Some operating systems have size limitations for logical drives. Before you
save the configuration, verify that the size of the logical drive is appropriate
for your operating system. See your operating-system documentation for
more detailed information.

c. Typically, the first logical drive defined on the first ServeRAID controller
found by system BIOS during startup will be your startup (boot) drive.

11. If free space is available and you want to define another logical drive, click
Add in the Main Panel.

12. Repeat steps 9 on page 30 through 11 on page 31 for each logical drive that
you want to define in this array; then, continue with step 13.

13. If you are defining multiple arrays, click the next New array tree node; then,
repeat steps 9 on page 30 through 12. When you are finished, go to step 14.

14. Click Next. The Configuration summary window opens.

15. Review the information that displays in the Configuration summary window.

Figure 11. Adding another logical drive
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Note: To change the configuration, click Modify arrays or Modify logical
drives.

16. Click Apply to accept and save the configuration. The configuration is saved in
the ServeRAID controller and on the physical drives.

17. If you have multiple controllers, for each controller repeat steps 1 on page 27
through step 16.

18. When you have completed configuration, you can change to Information mode
and change controller settings. See “Using Information mode” on page 33 for
more information. If you do not want to change any settings, exit the
ServeRAID Manager program and remove the CD from the CD-ROM drive.

19. Restart the server.

20. Continue with “Step 4: Installing device drivers” on page 33 to install the
ServeRAID device driver while installing your operating system.

Note: If you are configuring your startup (boot) ServeRAID controller, you
must install the device driver while installing the operating system.

Figure 12. Configuration summary window
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Using Information mode
You can use Information mode to view the configuration information of ServeRAID
controllers, arrays, logical drives, hot-spare drives, and physical drives that make up
your ServeRAID subsystem (see Figure 6 on page 25). You also can use this mode
to change some of the ServeRAID controller settings. These settings include:
v Write-cache mode

Note: (NetWare 5.0 only) If you are preparing to install Novell NetWare 5.0 from
the startable Novell NetWare 5.0 CD, set the write-cache mode only to
write-through mode.

v Controller and partner names
v SCSI initiator IDs
v Merge group numbers
v Read-ahead cache mode
v Stripe-unit size
v Unattended mode
v BIOS compatibility mapping
v Rebuild rate
v SCSI transfer speed

Click an item in the Main Tree and select the Actions menu to display available
actions for that item.

Viewing the device and configuration information: To view the current settings:

1. Click the plus (+) box next to the object in the Main Tree to expand that portion
of the tree.

2. Click the icon for the server, ServeRAID controller, array, logical drive, hot-spare
drive, or physical drive to view its current settings.

Detailed information about the selected device will display in the Main Panel on the
right.

Step 4: Installing device drivers
This section contains information about the device drivers available for the
ServeRAID controllers. These device drivers are provided with the IBM ServeRAID
controllers on the following:
v IBM ServeRAID Support CD
v IBM ServeRAID Device Drivers diskette
v IBM ServeRAID Device Drivers for SCO Operating Systems - UnixWare HBA and

OpenServer BTLD diskette

If you are installing files for an IBM ServeRAID controller that comes as a standard
feature on your IBM Netfinity or PC Server system board, use the installation
instructions and CDs provided with your server to install these files.

This section provides instructions for installing the device drivers for Windows NT,
Windows 2000, NetWare, Linux, OS/2, OpenServer, and UnixWare.
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Installing device drivers while installing the operating system
This section provides instructions for installing the device drivers while installing the
operating system.

When using: Go to:
Windows 2000 “Installing device drivers for Windows 2000”.
Windows NT “Installing device drivers for Windows NT 4.0”.
NetWare “Installing device drivers for NetWare” on page 35.
Linux “Installing device drivers for Red Hat Linux 6.1(or later)” on page 35.
OS/2 “Installing device drivers for OS/2” on page 36.
OpenServer “Installing device drivers for OpenServer” on page 38.
UnixWare “Installing device drivers for UnixWare” on page 39.

Installing device drivers for Windows 2000
You must install the ServeRAID device driver on the Windows 2000 CD while
installing Windows 2000. The Windows 2000 installation program does not allow
you to upgrade a device driver that ships on the Windows 2000 CD. After installing
Windows 2000, you must update the ServeRAID device driver to the latest version,
which is on the IBM ServeRAID Support CD and the IBM ServeRAID Device
Drivers diskette. Refer to “Installing device drivers after installing Windows 2000” on
page 42.

Installing device drivers for Windows NT 4.0
To install the ServeRAID device driver while installing Windows NT 4.0:

1. Insert one of the following:
v The Windows NT startup (boot) diskette into the diskette drive
v The startable Windows NT CD into the CD-ROM drive;

then, restart the server.

Note: If you are installing on an IBM Netfinity server that supports Hot-plug PCI
under Windows NT 4.0, select the IBM ServeRAID Hot Replace Wizard
to enable the hot-replace operation.

2. When the message
Setup is inspecting your computer's hardware
configuration...

appears, press the F6 key.

3. After loading some files, Windows displays a screen where you can manually
specify a controller. When this screen appears, press the S key to specify
additional devices.

4. When prompted in the next window, select Other from the list.

5. When prompted to insert the Manufacturer-supplied hardware support disk,
insert the IBM ServeRAID Device Drivers diskette into the diskette drive; then,
press Enter.

6. If you are installing Windows NT 4.0, select IBM ServeRAID Controller (NT
4.0); then, press Enter. A message similar to the following will appear:
Setup is loading files (IBM ServeRAID Controller (NT 4.0))...

7. When prompted, press Enter to continue.

8. Use the instructions provided in the Windows NT manual to complete the
normal installation process.

9. After you complete the installation, be sure to install the latest Service Pack.
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Installing device drivers for NetWare
To install the ServeRAID device driver while installing NetWare 4.x or 5.x:

1. Use the instructions provided in the NetWare manual to begin the installation.

2. When the Choose the Server Drivers - Disk Driver prompt appears during
the install process, insert the IBM ServeRAID Device Drivers diskette.

3. Click Select additional or modify selected Disk/LAN drivers.

4. If IPSRAID appears, select Deselect a selected driver.

5. Click Select an additional driver; then, press the Ins (Insert) key to add an
unlisted new device driver.

6. Press F3 to specify a path; then,

v For NetWare 4.x, type:
a:\netware4

where a is the diskette drive letter.

v For NetWare 5.x, type:
a:\netware5

where a is the diskette drive letter.

7. Click IPSRAID.HAM from the list of device drivers that appears in the window;
then, press Enter.

Note: The IPSRAID.HAM and support files will be copied to the system volume.

8. Click OK to overwrite the existing files.

9. Follow the instructions in the NetWare manual to complete the installation.

Installing device drivers for Red Hat Linux 6.1(or later)
This section provides instructions for installing the ServeRAID device driver (version
1.0) from diskette. Before you can install the device drivers, you must create the
Red Hat device driver diskette (see “Creating the Red Hat Linux device driver
diskette” on page 35).

1. Insert the Red Hat 6.1 Installation CD into the CD-ROM drive.

2. Turn on or restart the server.

3. At the command prompt, type:
linux dd

and any other options for your installation; then, press Enter.

4. Follow the prompts to complete the installation.

Creating the Red Hat Linux device driver diskette: This section provides
instructions for creating the Red Hat device driver diskette on the following
operating systems: Windows 95, Windows 98, Windows NT 4.0, Windows 2000,
OS/2, and Linux.

Creating the diskette on Windows 95, Windows 98, Windows NT 4.0, or Windows
2000: To create the Red Hat Linux device driver diskette on Windows 95,
Windows 98, Windows NT 4.0, or Windows 2000, do the following:

1. Insert the IBM ServeRAID Support CD into the CD-ROM drive.

2. At a DOS prompt, type the following:
d:\tools\dsk4w32 images\redhatdd.img a:
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where d is the drive letter of the CD-ROM drive and a is the drive letter of the
diskette drive.

3. Press Enter.

4. Remove the IBM ServeRAID Support CD from the CD-ROM drive.

Creating the diskette on OS/2 Warp®: To create the Red Hat Linux device driver
diskette on OS/2 Warp, do the following:

1. Insert the IBM ServeRAID Support CD into the CD-ROM drive.

2. At a DOS prompt, type the following:
d:\tools\dsk4wrp images\redhatdd.img a:

where d is the drive letter of the CD-ROM drive and a is the drive letter of the
diskette drive.

3. Press Enter.

4. Remove the IBM ServeRAID Support CD from the CD-ROM drive.

Creating the diskette on Linux: To create the Red Hat Linux device driver diskette
on Linux, do the following:

1. Insert the IBM ServeRAID Support CD into the CD-ROM drive.

2. Type:
mount -t iso9660 /dev/cdromdevicefile /mnt

where cdromdevicefile is the specific device file for the CD-ROM block device.
Typically this is /dev/cdrom.

3. Type: dd if=/mnt/images/redhatdd.img
of=/dev/diskettedevicefile bs=32k

where diskettedevicefile is the specific device file for the diskette block device.
Typically this is /dev/fd0.

4. Unmount the CD-ROM:
umount /mnt

5. Remove the IBM ServeRAID Support CD from the CD-ROM drive.

Installing device drivers for OS/2
You can use the following instructions to install the ServeRAID device driver files
while installing OS/2 Warp Server.

Note: When starting the OS/2 Diskette 1 in Drive A after the logo screen appears
and the Please Wait messages, you might receive the following message:
* Initializing Raid SCSI Subsystem.
* Unable to allocate IRQ resources.
* RMCreate Device Adapter failure.
* RMCreate Device (disk) failure.
* RMCreate Device (disk) failure.
* RMCreate Device (disk) failure.
* RMCreate Device (disk) failure.

If you receive these messages, disregard them during installation. The
installation will complete successfully. After the installation completes, install
an updated RESOURCE.SYS file that is available from the OS/2 Device
Driver Pak On-Line Web site at the following address:

http://service.software.ibm.com/os2ddpak/index.htm
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At this Web site, follow these steps to obtain the updated RESOURCE.SYS
file:

1. Scroll down to the bottom and click Yes, I agree. Show the Device
Category list.

2. Scroll down and select OS/2 Component Updates from the list.

3. Select OS/2 Base Device Driver Updates.

4. Select RESOURCE.SYS update; pre-requisite for updated IBM RAID
Driver.

5. Follow the instructions at the Web site for installing the RESOURCE.SYS
update after you have installed OS/2.

To install the ServeRAID files while installing OS/2:

1. Make a copy of the OS/2 Warp Diskette 1 and label it Copy of OS/2 Diskette
1.

2. Copy the IPSRAID.ADD file from the OS2 directory on the IBM ServeRAID
Device Drivers diskette to the Copy of OS/2 Diskette 1.

If there is not enough space, delete files not needed in your installation (such
as proprietary CD-ROM or SCSI device drivers). Make sure you remove all
entries referring to any device drivers you delete from the CONFIG.SYS file.

Important

If you have more than one or SCSI adapter in your system, make sure that the BASEDEV
statement for the adapter or controller controlling the startup (boot) device appears first in
the CONFIG.SYS file before the BASEDEV statements for other or SCSI adapters.

3. Edit the CONFIG.SYS file on the Copy of OS/2 Diskette 1 to add the following
lines:
BASEDEV=IPSRAID.ADD
SET COPYFROMFLOPPY=1

4. Install OS/2, but when you are prompted to insert Diskette 1, use the updated
Copy of OS/2 Diskette 1.

5. After you complete the OS/2 installation, insert the IBM ServeRAID Device
Drivers diskette.

6. From an OS/2 window, type:
a:

where a is the drive letter for the diskette drive that contains the ServeRAID
diskette.

7. Press Enter; then, type:
ddinstal

8. Press Enter. The OS/2 Device Driver Installation window opens.

9. In the Source field type a: (where a is the letter of the diskette drive where the
IBM ServeRAID Device Drivers diskette is located). In the Destination field,
type the full path where you want the device driver files to be copied.

10. Click Install. The program copies the IPSRAID.ADD ServeRAID device driver
to the OS/2 subdirectory on your hard disk.

11. Edit the CONFIG.SYS file and verify that there is only one copy of the line
BASEDEV=IPSRAID.ADD.
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Notes:

a. If you have more than one ServeRAID or SCSI adapter in your system,
make sure that the BASEDEV statement for the adapter or controller
controlling the startup (boot) device appears first in the CONFIG.SYS file
before the BASEDEV statements for other ServeRAID or SCSI adapters.

b. After you install any service packs, check the path for the IPSRAID.ADD
device driver and verify that the correct device driver is installed.

12. Restart the server.

Installing device drivers for OpenServer
Before you begin the installation, review the following information:

v You must install logical drives as Bus Number 0 when using the MKDEV
program, regardless of the channel that the physical drives are on.

v You must install a nondisk device, such as a CD-ROM or tape drive, as Bus
Number 1, 2, 3, or 4 relative to the channel to which it is attached. Internal
Channel 1 is Bus Number 1, internal Channel 2 is Bus Number 2, external
Channel 1 is Bus Number 1, external Channel 2 is Bus Number 2, external
Channel 3 is Bus Number 3, and external Channel 4 is Bus Number 4.

To configure the default nondisk devices during the initial installation:

1. Redefine the default tape drive in the initial boot string. For example, to install
the boot-time loadable driver IPSRAID BTLD and redefine the tape drive, go to
the BOOT prompt and type:
link Stp=ips(0, 1, 2, 0)

The numbers in parentheses represent the host adapter number, the bus
number, the SCSI ID, and the LUN respectively.

2. When prompted for the location of the installation CD, change the bus number
and SCSI ID, as required.

Adding IPSRAID BTLD at startup time: To install the ServeRAID device driver
for OpenServer 5.x.5:

1. At the BOOT prompt, type:
link

2. Press Enter; then, when prompted for the name of the package, type:
ipsraid

3. Press Enter.

4. After the kernel loads but before it runs, the link program prompts you to insert
the IBM ServeRAID Device Drivers for SCO Operating Systems - UnixWare
HBA and OpenServer BTLD diskette.

While the installation program copies the files, one or both of the following
messages might appear:

v Extracting BTLD distribution for ipsraid... /etc/uadmin
getdev b ips: No such device (error 19)

v dynamic linker: dlvr_audit: Cannot open /dev/zero for file
/lib/libprot.so.1

You can ignore the first message; if the second message appears, however, you
must press Enter when prompted to continue the installation.

5. Keep the IBM ServeRAID Device Drivers for SCO Operating Systems -
UnixWare HBA and OpenServer BTLD diskette available. You will need it to
configure the device driver into the link kit.
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For additional information about adding a boot-time loadable driver at boot time,
refer to “Using Boot-Time Loadable Drivers” in the SCO OpenServer Handbook.

Installing device drivers for UnixWare
The instructions that you use for installing the ServeRAID files when using
UnixWare depend on the number of IDE and SCSI disk-storage adapters and
controllers installed in the system. If all of the direct-access-storage devices (DASD)
in the system are attached to a single disk-storage adapter or controller (such as
the ServeRAID controller), you can skip the instructions in this section and go
directly to “Installing the files while installing UnixWare” on page 41.

Attaching devices to multiple disk-storage adapters or controllers: If you are
attaching devices to multiple disk-storage adapters or controllers (including IDE and
SCSI controllers integrated on the system board), use the following instructions. If
you are not using multiple disk-storage adapters and controllers go to “Installing the
files while installing UnixWare” on page 41.

v If you are installing UnixWare on a drive attached to a ServeRAID controller,
follow the instructions in “Installing UnixWare on a ServeRAID drive”.

v If you are installing UnixWare on a drive attached to a non-ServeRAID adapter or
controller and you intend to store only data on the drives attached to your
ServeRAID controllers, follow the instructions in “Installing UnixWare on a
non-ServeRAID drive” on page 40.

Installing UnixWare on a ServeRAID drive: Use the following instructions if you are
using multiple disk-storage adapters or controllers and you are installing UnixWare
on a drive attached to a ServeRAID controller. If you not using multiple disk-storage
adapters and controllers, go to “Installing the files while installing UnixWare” on
page 41.

1. Install all ServeRAID controllers that you intend to use in your system.

2. Using the ServeRAID Manager program, create all of your arrays and define
all of your logical drives.

3. Make a list of all of the ServeRAID controllers, including the order and slot
number, installed in the system. To do this:

a. Turn on the server.

b. If the ServeRAID Mini-Configuration prompt appears, press Ctrl+I. When a
system contains more than one ServeRAID controller, a selection window
appears.

c. The menu lists the ServeRAID controllers in order. Select the first
ServeRAID controller from the menu.

d. Select Advanced Functions from the Main Menu.

e. Select View Controller and PCI Information from the Advanced Functions
menu.

f. Record the slot number for the ServeRAID controller; then, press Esc three
times to return to the controller-selection window.

g. Repeat step 3c through step 3f until you record the slot number for each
ServeRAID controller that appears on the selection screen.

4. Turn off the system; then, remove all ServeRAID controllers except the first one
on your list.

Note: If one of the ServeRAID controllers that you need to remove is on the
system board, you must do one of the following:
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v If the CD-ROM drive that you are using to install your operating
system is attached to the integrated ServeRAID controller, disconnect
or remove all disk drives attached to the integrated controller.

v If only disk drives are attached to the integrated controller, disconnect
the SCSI cable from the ServeRAID connector on the system board.
See the label inside the server cover for the location of the ServeRAID
connector.

5. Remove all other non-ServeRAID IDE and SCSI disk-storage adapters or
controllers.

Note: If one of the disk-storage controllers that you need to remove is on the
system board, you must do one of the following:

v If the CD-ROM drive that you are using to install your operating
system is attached to the integrated disk-storage controller, disconnect
or remove all disk drives attached to the integrated controller.

v If only disk drives are attached to the integrated controller, disconnect
the cable for the integrated controller from the IDE or SCSI connector
on the system board. See the label inside the server cover for the
location of the IDE or SCSI controller connector.

6. Follow the instructions in “Installing the files while installing UnixWare” on
page 41; then, return here and continue with step 7.

7. Turn off the system.

8. Install any non-ServeRAID disk-storage adapters or controllers in the server;
then, attach the drives to the disk-storage adapters and controllers.

9. Install the second ServeRAID controller from the list you created in step 3f on
page 39; then, attach the drives to the ServeRAID controller.

10. Turn on the system and allow UnixWare to detect the new disk-storage
adapters and controllers.

11. Turn off the system.

12. Repeat steps 9 on page 40 through 11 on page 40 until all ServeRAID
adapters, ServeRAID controllers, and drives are installed.

13. You can now partition and format the logical drives attached to the additional
ServeRAID adapters and controllers. See the information provided with
UnixWare for more instructions.

Installing UnixWare on a non-ServeRAID drive: Use the instructions in this section
if you are using multiple disk-storage adapters or controllers, you are installing
UnixWare on a drive attached to a non-ServeRAID adapter or controller, and you
intend to store only data on the drives attached to your ServeRAID adapters and
controllers.

1. Install all ServeRAID controllers that you intend to use in your system.

2. Using the ServeRAID Manager program, create all of your arrays and define
all of your logical drives.

3. Make a list of all of the ServeRAID controllers, including the order and slot
numbers, installed in the system. To do this:

a. Turn on the server.

b. When the ServeRAID Mini-Configuration prompt appears, press Ctrl+I.
When a system contains more than one ServeRAID controller, a selection
screen appears.

c. The menu lists the ServeRAID controllers in order. Select the first
ServeRAID controller from the menu.
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d. Select Advanced Functions from the Main Menu.

e. Select View Controller and PCI Information from the Advanced Functions
menu.

f. Record the slot number for the ServeRAID controller; then, press Esc three
times to return to the controller-selection screen.

g. Repeat step 3c on page 40 through step 3f until you record the slot number
for each ServeRAID controller that appears on the selection screen.

4. Turn off the system; then, remove all ServeRAID, IDE, and SCSI disk-storage
adapters and controllers except the one attached to the drive where you intend
to install UnixWare.

Note: If one of the disk-storage or ServeRAID controllers that you need to
remove is on the system board, do one of the following:

v If the CD-ROM drive that you are using to install your operating
system is attached to the integrated controller, disconnect or remove
all disk drives attached to the integrated controller.

v If only disk drives are attached to the integrated controller, disconnect
the SCSI or IDE cable for the integrated controller from the connector
on the system board. See the label inside the server cover for the
location of the SCSI and IDE cable connectors.

5. Follow the instructions in “Installing the files while installing UnixWare”; then,
return here and continue with step 6.

6. Turn off the system.

7. Install any non-ServeRAID disk-storage adapters or controllers in the server;
then, attach the drives to the disk-storage adapters and controllers.

8. Install the first ServeRAID controller from the list you created in step 3f; then,
attach the drives to the ServeRAID controller.

9. Turn on the system and allow UnixWare to detect the new disk-storage adapters
and controllers.

10. Turn off the system.

11. Repeat steps 8 on page 41 through 10 on page 41 until all ServeRAID
adapters, ServeRAID controllers, and drives are installed.

12. You can now partition and format the logical drives attached to the ServeRAID
adapters and controllers. See the information provided with UnixWare for more
instructions.

Installing the files while installing UnixWare: To install the ServeRAID files
while installing UnixWare 7.1:

1. Use the instructions provided with UnixWare to begin the installation.

2. When a message appears asking if you want to install any HBA diskettes, insert
the IBM ServeRAID Device Drivers for SCO Operating Systems - UnixWare
HBA and OpenServer BTLD diskette; then, select Install HBA diskette.

3. Use the instructions provided in the UnixWare manual to complete the normal
installation process.
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Installing or updating device drivers after installing the operating
system

This section provides instructions for installing the device drivers after you have
installed the operating system. You can also use these instructions to update a
device driver.

When using: Go to:
Windows 2000 “Installing device drivers after installing Windows 2000”
Windows NT “Installing device drivers after installing Windows NT 4.0” on page 43.
NetWare “Installing device drivers after installing NetWare 4.x or 5.x” on page 43.
Linux “Updating device drivers for Red Hat Linux 6.1 (or later)” on page 44.
OS/2 “Installing device drivers after installing OS/2” on page 46.
OpenServer “Adding IPSRAID BTLD after installing OpenServer” on page 47.
UnixWare “Installing device drivers after installing UnixWare” on page 47.

Installing device drivers after installing Windows 2000
To install the ServeRAID device driver after installing Windows 2000:

1. Insert the IBM ServeRAID Support CD into the CD-ROM drive.

2. From the Start Menu, click Programs → Administrative Tools → Computer
Management. The Computer Management windows opens.

3. In the left tree, click System Tools; then, click Device Manager.

4. In the right tree, click the SCSI adapters and RAID controllers to display all the
controllers in the server.

5. Using the right-mouse button, click the first ServeRAID controller in the tree;
then, click Properties. The Properties windows opens.

6. Click the Driver tab; then, click Upgrade. The Update Device Driver Wizard
opens.

7. Click Next.

8. Verify that Search for a suitable driver for my device (recommended) is
checked; then, click Next.

9. Uncheck Floppy disk drives, CD-ROM drives, and Microsoft Windows
Update.

10. Verify that Specify a location is checked; then, click Next.

11. In the Copy manufacturer’s files from field, type:

v If you are installing from diskette, type:
a:\win2k

where a is the diskette drive letter.

v If you are installing from CD, type:
z:\programs\winnt\driver\win2k

where z is the CD-ROM drive letter.

12. Click OK.

13. Click Next; then, click Finish.

14. Click Close.

15. After the device driver installs, remove the diskette or the CD from drive and
restart the server.
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Installing device drivers after installing Windows NT 4.0
To install the ServeRAID device driver after installing Windows NT 4.0:

1. Insert the IBM ServeRAID Device Drivers diskette into the diskette drive or
insert the IBM ServeRAID Support CD into the CD-ROM drive.

2. From the Start Menu, click Settings; then, click Control Panel.

3. Select SCSI Adapter; then, click the Drivers tab.

4. Click Add; then, click Have Disk.

5. In the Copy manufacturer’s files from field:

v If you are installing from diskette, type:
a:\nt4_0

where a is the diskette drive letter.

v If you are installing from CD, type:
z:\programs\winnt\driver\nt4_0

where z is the CD-ROM drive letter.

6. Click OK; then in the next dialog box, click OK again.

7. After the device driver installs, remove the diskette or the CD from the drive and
restart the server.

Installing device drivers after installing NetWare 4.x or 5.x

Note: If the device driver and operating system is already installed, do the following
before starting this procedure:

1. Type:
Unload IPSRAID

2. Press Enter; then, go to step 1 on page 43 in the following instructions.

To install the files after installing NetWare 4.x or 5.x, do the following:

1. From the system console, start the NetWare installation utility program:

v For NetWare 4.x, type:
load install

v For NetWare 5.x, type:
load nwconfig

2. Press Enter.

3. Insert the IBM ServeRAID Device Drivers diskette into the diskette drive or
insert the IBM ServeRAID Support CD into the CD-ROM drive.

4. Click Driver options from the Installation Options list.

5. Click Configure disk and storage from the Driver Options window.

6. Select Select an additional driver from the Additional Drivers Actions window.

7. When the next window opens, press the Ins key to install an unlisted driver.

8. When the next window opens, press the F3 key to specify a different path.

9. In the Specify a directory path field:

v For NetWare 4.x: If you are installing from diskette, type:
a:\netware4

where a is the diskette drive letter.

v For NetWare 4.x: If you are installing from CD-ROM, type:
d:\programs\netware\driver\netware4
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where d is the CD-ROM drive letter.

v For NetWare 5.x: If you are installing from diskette, type:
a:\netware5

where a is the diskette drive letter.

v For NetWare 5.x: If you are installing from CD-ROM, type:
d:\programs\netware\driver\netware5

where d is the CD-ROM drive letter.

10. When prompted to select a device driver to install, select IPSRAID.HAM.

11. Click Yes when prompted to copy the IPSRAID.HAM driver.

12. When the prompt appears to specify the server boot path, type:
c:\nwserver

Notes:

a. This instruction assumes that you installed NetWare in its default directory.
If you did not install NetWare in the NWSERVER directory on drive C,
modify step 12 on page 44 accordingly.

b. If any of the files you are installing already exist on the server, NetWare will
prompt you to save the older files. Although it is not necessary to save the
older files, it might be useful to do so.

13. After the installation program copies all files, you can edit parameters (such as
the ServeRAID slot number) from the Driver IPSRAID Parameter Actions
window.

14. After you edit the parameters, click Save Parameters and load driver to load
the ServeRAID device driver.

Note: If the device driver is not installed already and the operating system is
installed, an error message stating that the device driver failed to load
should appear after you complete the previous step. If that happens, do
the following:

a. Press Esc to exit from the installation screens.

b. Shut down the server.

c. Restart the server by typing the following at the system prompt:
server

d. The server automatically loads and installs the device driver.

15. Press Esc to exit from the installation screens.

Note: If you want NetWare to load the ServeRAID device driver automatically
during startup, you must add the appropriate LOAD command (for example,
load ipsraid.ham slot=1) to the NetWare startup command file (usually
C:\NWSERVER\STARTUP.NCF).

Updating device drivers for Red Hat Linux 6.1 (or later)
This section provides instructions for updating the ServeRAID device drivers from
CD-ROM, diskette, and the World Wide Web. You can update the device drivers if
Linux is already installed or when updating previous device drivers.

Updating device drivers after installing Linux: Before proceeding, you must
already have installed Red Hat 6.1 Linux distribution on your server. This set of
instructions assumes the following:

v You already have a Red Hat 6.1 Linux operating system installed.
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v You want to add a ServeRAID controller to your server.

Updating device drivers from CD-ROM: To update device drivers from CD-ROM
after installing Linux, do the following:

1. Insert the IBM ServeRAID Support CD into the CD-ROM drive.

2. Type:
mount -t iso9660 /dev/cdromdevicefile /mnt

where cdromdevicefile is the specific device file for the CD-ROM block device.
Typically this is /dev/cdrom.

3. To unpack the device driver, type:
tar -zxvf /mnt/programs/linux/driver/ips-400.tgz -C /tmp

4. To apply the patch, type:
cd /usr/src
patch -p0 < /tmp/kernel-2.2.13-4.00-patch

5. Unmount the CD-ROM:
umount /mnt

6. Reconfigure and recompile your kernel.

Note: See the Linux Kernel-HOWTO for more information on configuring and
recompiling your kernel.

Updating device drivers from diskette: To update device drivers from diskette after
installing Linux, do the following:

1. Insert the IBM ServeRAID Device Drivers diskette into the diskette drive.

2. Type:
mount -t msdos -o conv=auto /dev/diskettedevicefile /mnt

where diskettedevicefile is the specific device file for the diskette block device.
Typically this is /dev/fd0.

3. To unpack the device driver, type:
tar -zxvf /mnt/linux/ips-400.tgz -C /tmp

4. To apply the patch, type:
cd /usr/src
patch -p0 < /tmp/kernel-2.2.13-4.00-patch

5. Unmount the diskette drive:
umount /mnt

6. Reconfigure and recompile your kernel.

Note: See the Linux Kernel-HOWTO for more information on configuring and
recompiling your kernel.

Updating device drivers from the World Wide Web: To update device drivers
downloaded from the World Wide Web after installing Linux, do the following:

1. Download the file ips-400.tgz that is available from the IBM Developer Web
site at the following address:

http://www.developer.ibm.com/welcome/netfinity/serveraid.html

2. To unpack the device driver, type:
tar -zxvf ips-400.tgz -C /tmp

3. To apply the patch, type:
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cd /usr/src
patch -p0 < /tmp/kernel-2.2.13-4.00-patch

4. Reconfigure and recompile your kernel.

Note: See the Linux Kernel-HOWTO for more information on configuring and
recompiling your kernel.

Installing device drivers after installing OS/2
You can use the following instructions to install the ServeRAID device driver files
after installing OS/2 Warp Server.

To install the ServeRAID files after installing OS/2:

1. After you complete the OS/2 installation, insert the IBM ServeRAID Device
Drivers diskette.

2. From an OS/2 window, type:
a:

where a is the letter for the diskette drive that contains the ServeRAID diskette.

3. Press Enter; then, type:
ddinstal

4. Press Enter. The OS/2 Device Driver Installation window opens and prompts
you for the source and destination drives. The source directory shows where to
insert the IBM ServeRAID Device Drivers diskette. The destination directory
shows where the program will copy the device driver files.

5. Click Install.

v The program copies the following ServeRAID device driver statement to your
CONFIG.SYS file: BASEDEV=IPSRAID.ADD

v The program copies the IPSRAID.ADD ServeRAID device driver to the OS/2
subdirectory on your hard disk.

6. Edit the CONFIG.SYS file and verify that there is only one copy of the line
BASEDEV=IPSRAID.ADD.

Notes:

a. If you have more than one ServeRAID or SCSI adapter in your server, make
sure that the BASEDEV statement for the adapter or controller controlling
the startup (boot) device appears first in the CONFIG.SYS file before the
BASEDEV statements for other ServeRAID or SCSI adapters.

b. After you install any service packs, check the path for the IPSRAID.ADD
device driver and verify that the correct device driver is installed.

7. Restart the server.

Note: When booting OS/2 after installing the new ServeRAID device driver, you
might receive the following messages:
* Initializing Raid SCSI Subsystem.
* Unable to allocate IRQ resources.
* RMCreate Device Adapter failure.
* RMCreate Device (disk) failure.
* RMCreate Device (disk) failure.
* RMCreate Device (disk) failure.
* RMCreate Device (disk) failure.

If you receive these messages, install an updated RESOURCE.SYS file
that is available from the OS/2 Device Driver Pak On-Line Web site at
the following address:
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http://service.software.ibm.com/os2ddpak/index.htm

At this Web site, follow these steps to obtain the updated
RESOURCE.SYS file:

v Scroll down to the bottom and click Yes, I agree. Show the Device
Category list.

v Scroll down and click OS/2 Component Updates from the list.

v Click OS/2 Base Device Driver Updates.

v Click RESOURCE.SYS update; pre-requisite for updated IBM RAID
Driver.

v Follow the instructions at the Web site for installing the
RESOURCE.SYS update after you have installed OS/2.

Adding IPSRAID BTLD after installing OpenServer
1. Start the server in system maintenance mode, and log in as ROOT.

2. Type:
installpkg

3. Press Enter; then, select the diskette drive in which you will insert your
installation diskette.

4. When prompted, insert the IBM ServeRAID Device Drivers for SCO Operating
Systems - UnixWare HBA and OpenServer BTLD diskette.

5. When prompted for the name of the package, type:
ipsraid

6. Press Enter; then, relink the kernel (as described in “Relinking the kernel” in
the SCO OpenServer Handbook) by typing the following command:
cd /etc/conf/cf.d

7. Press Enter; then type:
./link_unix

8. Press Enter.

9. After the kernel rebuilds, the following message appears:

The UNIX kernel has been rebuilt.
Do you want this kernel to boot by default?

To continue, type y

The system backs up the old kernel by moving /unix to /unix.old.

10. When the system asks for the kernel environment to be rebuilt, type y

The system will respond with a message.

11. Remove the IBM ServeRAID Device Drivers for SCO Operating Systems -
UnixWare HBA and OpenServer BTLD diskette from the diskette drive.

12. Shut down the server; then, restart the server.

Installing device drivers after installing UnixWare
Use the following instructions to install the ServeRAID files after you install
UnixWare, or use these instructions to update a previously installed ServeRAID file
with a newer version. You can use the UnixWare Pkgadd or the UnixWare
SCOAdmin utility program to install the files.

Installing an HBA diskette file using Pkgadd:

1. Insert the IBM ServeRAID Device Drivers for SCO Operating Systems -
UnixWare HBA and OpenServer BTLD diskette into the diskette drive.

2. Type:
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pkgadd –d /dev/dsk/f0t

3. Press Enter.

4. When the message Insert diskette into Floppy Drive 1 appears, press
Enter.

5. When the message Installation of IBM ServeRAID SCSI IHV HBA (ips)
was successful appears, type:
q

6. Press Enter.

7. After the device driver is installed, shut down and restart the server.

Installing an HBA diskette file using SCOAdmin:

1. Insert the IBM ServeRAID Device Drivers for SCO Operating Systems -
UnixWare HBA and OpenServer BTLD diskette into the diskette drive.

2. Start the SCOAdmin utility program by typing SCOADMIN at the system prompt.

3. Click Software_Management.

4. Click Application Installer.

5. Click the Install From tab.

6. Click Disk_A.

7. Click Update View if nothing appears in the window.

8. When the icon labeled ips appears in the window, click Install.

9. After the device driver is installed, remove the diskette from the diskette drive;
then, shut down and restart the server.

Step 5: Installing the ServeRAID Manager program and other utilities
The ServeRAID Manager program provides a graphical interface that you can use
to monitor ServeRAID configuration changes being performed on your server while
your server is fully operational. You can create an array, delete an array, create a
logical drive, change the RAID level, dynamically increase the logical drive size,
rebuild an array, configure your ServeRAID controllers in a failover environment,
configure a cluster, and perform other ServeRAID configuration functions.
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Installing the ServeRAID Manager program
This section provides instructions for installing the ServeRAID Manager program.

When using: Go to:
Windows 2000 “Installing on Windows 2000, Windows NT 4.0, Windows 98, or Windows

95” on page 50.
Windows NT 4.0 “Installing on Windows 2000, Windows NT 4.0, Windows 98, or Windows

95” on page 50.
Windows 98 “Installing on Windows 2000, Windows NT 4.0, Windows 98, or Windows

95” on page 50.
Windows 95 “Installing on Windows 2000, Windows NT 4.0, Windows 98, or Windows

95” on page 50.
NetWare “Installing on NetWare” on page 50.
Linux “Installing on Red Hat Linux 6.1 (or later)” on page 51.
OS/2 “Installing on OS/2” on page 51.
OpenServer “Installing on OpenServer” on page 52.
UnixWare “Installing on UnixWare” on page 52.

To use the ServeRAID Manager program, see the ServeRAID Manager online help.

Figure 13. ServeRAID Manager installed on a server
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Installing on Windows 2000, Windows NT 4.0, Windows 98, or
Windows 95

Note: This version of the ServeRAID Manager program supports up to 12
ServeRAID controllers when using Microsoft NT 4.0 or Windows 2000.

To install the ServeRAID Manager program for Windows NT 4.0 or Windows 2000,
do the following:

1. Insert the IBM ServeRAID Support CD into the CD-ROM drive.

2. The installation program starts. Follow the instructions on the screen to install
the program.

Note: If you are installing on an IBM Netfinity server that supports Hot-plug PCI
under Windows NT 4.0, select the IBM ServeRAID Hot Replace Wizard
to enable the hot-replace operation.

Installing on NetWare
Notes:

1. To install the NetWare version of the ServeRAID Manager program, you must
install from a Microsoft Windows client that is connected to the NetWare system.

2. ServeRAID does not support NetWare versions older than 4.2.

3. ServeRAID Manager supports only NetWare 5.x and later. Use the command
line utilities IPSSEND and IPSMON for NetWare 4.x.

4. This version of the ServeRAID Manager program supports up to 8 ServeRAID
controllers when using NetWare.

Important

To install the ServeRAID Manager program, you must have a network drive mapped to the
root directory of the SYS partition.

Before you install the ServeRAID Manager program, be sure you have the following
installed on your NetWare 5.x system:

v Install the latest Support Pack before installing the Novell JVM for NetWare. Download
the latest Support Pack from the following address:

http://support.novell.com/misc/patlst.htm#nw

v Use the Novell Java Virtual Machine version 1.1.7 or later. Versions older than 1.1.7 are
not compatible with the ServeRAID Manager program. To check your JVM version, load
Java and type at the NetWare command prompt:

JAVA -VERSION

Download the latest JVM from the following address:

http://developer.novell.com/ndk/download.htm

To install the ServeRAID Manager program for Novell NetWare, do the following:

1. On a Microsoft Windows client that is connected to the NetWare system, map a
network drive to the root directory of your NetWare SYS partition.

2. Insert the IBM ServeRAID Support CD into the CD-ROM drive of the Windows
client. The installation program starts.

3. When prompted, choose the NetWare 5.x operating system.

4. When prompted for the installation directory, provide only the drive letter to the
NetWare SYS partition that you mapped in step 3.
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5. Follow the instructions on the screen to install the program.

Installing on Red Hat Linux 6.1 (or later)
Notes:

1. The ServeRAID Manager program comes with the IBM Java Runtime
Environment (JRE).

2. This version of the ServeRAID Manager program supports up to 8 ServeRAID
controllers when using Linux.

To install the ServeRAID Manager program for Red Hat Linux 6.1 (or later), do the
following.

1. Insert the IBM ServeRAID Support CD into the CD-ROM drive.

2. Some operating systems will automount the CD. For those that do not, type:
mount -r /dev/cdromdevicefile /mountpoint

where mountpoint is the mount point to use (typically /mnt), and cdromdevicefile
is the specific device file for the CD-ROM block device (typically /dev/cdrom).

3. Press Enter; then, type:
rpm --install /mnt/programs/linux/manager/RaidMan-4.00-1.386.rpm

where mnt is the mount point of the device file used in step 2.

4. Press Enter.

5. When the installation is complete, type:
umount /mnt

where mnt is the mount point of the device file used in step 2.

Note: For operating systems that automount the CD, you must first close the
window displaying the files on the CD.

6. Press Enter. You can now remove the CD from the CD-ROM drive.

Installing on OS/2

Note: This version of the ServeRAID Manager program supports up to 8
ServeRAID controllers when using OS/2.

To install the ServeRAID Manager program for OS/2, do the following:

1. Insert the IBM ServeRAID Support CD into the CD-ROM drive.

2. Open an OS/2 command window.

3. Type the following:
d:

where d is the CD-ROM drive letter.

4. Press Enter; then, type:
cd \programs\os2\manager

5. Press Enter; then, type:
install

6. Press Enter.

7. The installation program starts. Follow the instructions on the screen to install
the program. On the final installation panel, be sure to specify the location
where you want to install the ServeRAID Manager program.
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Installing on OpenServer

Note: This version of the ServeRAID Manager program supports up to 8
ServeRAID controllers when using OpenServer.

To install or remove the ServeRAID Manager package, you must have root
privileges.

Note: If ServeRAID Manager is installed on your system, you must remove this
version before upgrading. All customization files (such as Managed system
tree nodes, Notification list) are saved and used in the upgrade.

To remove the ServeRAID Manager program from OpenServer, type the
following command:
pkgrm RaidMan

To install the ServeRAID Manager program for OpenServer, do the following.

Note: The ServeRAID Manager requires that you install the SCO OpenServer JDK
(or JRE). You can download the JDK and JRE from the SCO Web site:

http://www.sco.com/java/

1. Insert the IBM ServeRAID Support CD into the CD-ROM drive.

2. Mount the CD-ROM by typing:
cd /

Then, press Enter.
mkdir cdrom

Then, press Enter.
mount -r -f HS,lower /dev/cd0 /cdrom

Then, press Enter.

3. Then, type (all on the same line):
pkgadd -a /cdrom/programs/openserv/manager/RaidMan.adm -d
/cdrom/programs/openserv/manager/RaidMan.ds

4. Press Enter.

5. When the installation is complete, type:
umount /cdrom

6. Press Enter. You can now remove the CD from the CD-ROM drive.

Installing on UnixWare
Notes:

1. To use the ServeRAID Manager program with UnixWare, you must have either
the Java Runtime Environment (JRE) or the Java Development Kit (JDK)
installed on your server.

2. To install or remove the ServeRAID Manager package you must have root
privileges.

3. If the ServeRAID Manager program is already installed on your server, you must
remove this version before upgrading. All customization files (such as Managed
system tree nodes, Notification list) are saved and used in the upgrade. To
remove the ServeRAID Manager program from UnixWare, type the following
command:
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pkgrm RaidMan

4. This version of the ServeRAID Manager program supports up to 8 ServeRAID
controllers when using UnixWare.

To install the ServeRAID Manager program for UnixWare, do the following:

1. Insert the IBM ServeRAID Support CD into the CD-ROM drive.

2. Type the following:
mount -r -F cdfs /dev/cdrom/cdromdevicefile /mnt

where cdromdevicefile is the specific device file for the CD-ROM block device.
Look in the /dev/cdrom directory to determine what cdromdevicefile is on your
server, for example, c0b0t010.

3. Press Enter; then type:
pkgadd -d /mnt/programs/unixware/manager/RaidMan.ds

4. Press Enter.

5. When the installation is complete, type:
umount /mnt

6. Press Enter. You can now remove the CD from the CD-ROM drive.

Installing the IPSSEND and IPSMON command-line programs
IPSSEND and IPSMON are advanced command-line programs that you can use to
manage your ServeRAID controllers. These utility programs are provided on the
IBM ServeRAID Command-Line Programs diskette and the IBM ServeRAID Support
CD.

Note: IPSSEND for OS/2 is on the IBM ServeRAID Support CD only.

You can use the IPSSEND program to view the configuration of a ServeRAID
controller, initialize logical drives, synchronize logical drives. For Windows NT and
Windows 2000 you can also use FlashCopy and configuration cloning for server roll
out.

You can use the IPSSEND program with the following operating systems:
v Microsoft Windows NT
v Microsoft Windows 2000
v Novell NetWare 4.x and 5.x
v IBM OS/2 Warp Server
v Red Hat Linux 6.1 or later
v SCO OpenServer 5.0.5
v SCO UnixWare 7.1 or later.

You can use the IPSMON program with Novell NetWare 4.x and 5.x. You can use
the IPSMON program to monitor a ServeRAID controller for defunct drives,
Predictive Failure Analysis® (PFA) warnings, Rebuild operations, FlashCopy
operations, synchronizations, logical-drive migrations, and RAID level-5E
compressions. This program can log a message to the monitor, to a file, or to both
the monitor and a file whenever activities occur.

Note: Refer to “Using the IPSSEND command-line program” on page 110 for
information about using the IPSSEND program.
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Installing IPSSEND for Windows 2000, Windows NT 4.0, NetWare,
or OS/2
To install these programs for Windows NT, Windows 2000, NetWare, or OS/2:

1. Start the server.

2. After the operating system starts, insert the IBM ServeRAID Support CD into the
CD-ROM drive.

3. If you are using NetWare, go to step 5 If you are using Windows NT, Windows
2000 or OS/2, create an IPSADM directory on your hard disk. To do this, go to
the operating system command prompt and type:
md c:\ipsadm

where c is the drive letter of the drive where Windows NT, Windows 2000, or
OS/2 is installed.

4. Press Enter.

5. Copy the IPSSEND.EXE file to your hard disk drive by typing one of the
following at the command prompt:

v For Windows NT, type:
copy z:\programs\winnt\cmdline\nt4_0\ipssend.exe c:\ipsadm

v For Windows 2000, type:
copy z:\programs\winnt\cmdline\win2k\ipssend.exe c:\ipsadm

v For NetWare, from a DOS prompt type:
copy z:\programs\netware\cmdline\ipssend.nlm c:\nwserver

v For OS/2, type:
copy z:\programs\os2\cmdline\ipssend.exe c:\ipsadm

Notes:

a. Where z is the drive letter for the CD-ROM drive that contains the IBM
ServeRAID Support CD and c is the drive letter where Windows NT,
Windows 2000, NetWare, or OS/2 is installed.

b. These instructions assume that you installed NetWare in the NWSERVER
directory.

6. Press Enter. Remove the CD from the CD-ROM drive.

Installing IPSSEND for Linux
To install these programs for Red Hat Linux 6.1 (or later):

1. Start the server.

2. After the operating system starts, insert the IBM ServeRAID Support CD into the
CD-ROM drive.

3. Mount the CD by typing the following at the console:
mount -t iso9660 -o ro /dev/cd0 /mnt

Notes:

a. where /dev/cd0 is the specific device file for the CD-ROM block device. If
you have more than one CD-ROM, you must replace /dev/cd0 with the
specific name of the CD-ROM you want to use.

b. If you currently have another device mounted on /mnt, you must create a
new directory and substitute its name for /mnt in these instructions.

4. Press Enter; then, type:
cp /mnt/programs/linux/cmdline/ipssend /usr/bin

5. Press Enter; then, type:
chmod 700 /usr/bin/ipssend
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6. Press Enter; then, unmount the CD-ROM by typing the following:
umount /mnt

7. Press Enter. Remove the CD from the CD-ROM drive.

Installing IPSSEND for OpenServer
To install these programs for OpenServer 5.0.5:

1. Start the server.

2. After the operating system starts, insert the IBM ServeRAID Support CD into the
CD-ROM drive.

3. Mount the CD by typing the following at the console:
mount -f ISO9660 -o ro,lower /dev/cd0 /mnt

Notes:

a. where /dev/cd0 is the specific device file for the CD-ROM block device. If
you have more than one CD-ROM, you must replace /dev/cd0 with the
specific name of the CD-ROM you want to use.

b. If you currently have another device mounted on /mnt, you must create a
new directory and substitute its name for /mnt in these instructions.

4. Press Enter; then, type:
cp /mnt/programs/openserv/cmdline/ipssend /usr/bin

5. Press Enter; then, type:
chmod 700 /usr/bin/ipssend

6. Press Enter; then, unmount the CD-ROM by typing the following:
umount /mnt

7. Press Enter. Remove the CD from the CD-ROM drive.

Installing IPSSEND for UnixWare
To install these programs for UnixWare 7.1:

1. Start the server.

2. After the operating system starts, insert the IBM ServeRAID Support CD into the
CD-ROM drive.

3. Mount the CD by typing the following at the console:
mount -F cdfs -r /dev/cdrom/cdromdevicefile /mnt

Notes:

a. where cdromdevicefile is the specific device file for the CD-ROM block
device. Look in the /dev/cdrom directory to determine what cdromdevicefile
is on your server, for example, c0b0t010.

b. If you currently have another device mounted on /mnt, you must create a
new directory and substitute its name for /mnt in these instructions.

4. Press Enter; then, type:
cp /mnt/programs/unixware/cmdline/ipssend /usr/bin

5. Press Enter; then, type:
chmod 700 /usr/bin/ipssend

6. Press Enter; then, unmount the CD-ROM by typing the following:
umount /mnt

7. Press Enter. Remove the CD from the CD-ROM drive.

Chapter 2. Installing and configuring ServeRAID controllers 55



Installing IPSMON for NetWare
To install the IPSMON program for NetWare:

1. Start the server.

2. After the operating system starts, insert the IBM ServeRAID Support CD into the
CD-ROM drive.

3. Copy the IPSMON.EXE file to your hard disk drive by typing on the DOS
command prompt:
copy z:\programs\netware\cmdline\ipsmon.nlm c:\nwserver

where z is the drive letter for the CD-ROM drive and c is the drive letter of the
drive where NetWare is installed.

Note: These instructions assume that you installed NetWare in the
NWSERVER directory.

4. Press Enter. Remove the CD from the CD-ROM drive.

Step 6: Starting the ServeRAID Manager program
After you have configured your ServeRAID controller, installed the device drivers,
installed the operating system, and installed the ServeRAID Manager program on
your system, you can administer and monitor your ServeRAID controllers, as well
as modify the ServeRAID controller configuration.

Starting the ServeRAID Manager program in Windows 2000 and
Windows NT

To start the ServeRAID Manager program in Windows NT and Windows 2000:

1. Click Start in the lower-left corner of the screen.

2. Click Programs→ ServeRAID Manager→ ServeRAID Manager. The Control
panel window opens. The program starts in Information mode and a window
similar to the following opens.
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Starting the ServeRAID Manager program in NetWare
To start the ServeRAID Manager program in NetWare:

1. From the NetWare console, type:
LOAD RAIDMAN

2. Press Enter.

The program starts in Information mode and a window similar to the previous
window opens.

Starting the ServeRAID Manager program in OS/2
To start the ServeRAID Manager program in OS/2:

1. Change to the directory where you installed the ServeRAID Manager program
by typing the following:
cd \RaidMan

2. Press Enter.

Figure 14. Information mode window
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3. Type the following:
RaidMan

4. Press Enter.

The program starts in Information mode and a window similar to the previous
window opens.

Starting the ServeRAID Manager program in OpenServer, UnixWare,
and Linux

Use these procedures to start the ServeRAID Manager program in OpenServer,
UnixWare, and Linux. You can start the ServeRAID Manager program either as a
graphical user interface or as an agent.

Notes:

1. Because these programs share the TCP/IP port number, do not start the
ServeRAID Manager graphical user interface and ServeRAID Manager agent at
the same time.

2. Ensure that you have superuser privileges before starting these procedures.

Starting the ServeRAID Manager graphical user interface
The ServeRAID Manager graphical user interface starts an easy-to-use interface for
managing and configuring ServeRAID controllers. Use the ServeRAID Manager
graphical user interface to configure and setup the ServeRAID Manager Notification
list and Security list. To start the ServeRAID Manager graphical user interface:h

1. Change to the directory where you installed the ServeRAID Manager program
by typing:

For Openserver cd /opt/RaidMan
For UnixWare cd /opt/RaidMan
For Linux cd /usr/RaidMan

2. Press Enter.

3. Type the following:
sh RaidMan.sh

4. Press Enter.

The program starts in Information mode and a window similar to the previous
window opens.

Starting the ServeRAID Manager agent
The ServeRAID Manager agent is a monitoring agent for ServeRAID controllers that
uses less memory than the ServeRAID Manager graphical user interface. None of
the managing actions or the configuration actions are available.

Note: If the system administrator chose during installation to start the agent as a
background service, the agent is already running. To determine if the agent
is running, type:
ps -aef | grep RaidAgnt | grep -v grep

If you receive output from this command, the agent is running.

To start the ServeRAID Manager agent:

1. Change to the directory where you installed the ServeRAID Manager program
by typing:
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cd /opt/RaidMan

2. Press Enter.

3. Type the following:
sh RaidAgnt.sh

4. Press Enter.
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Chapter 3. Configuring two ServeRAID controllers in a failover
environment (Windows NT 4.0 and Windows 2000 only)

You can configure two ServeRAID controllers in a failover environment when using
Windows NT 4.0 or Windows 2000. The latest version of the ServeRAID device
drivers includes fault tolerant technology. With fault tolerance, you can pair two
controllers and connect them to the same enclosure in order to provide access to
the disk, even after a controller fails.

Hardware requirements

Important
To perform fault tolerance, you must use only matched pairs of controllers. The controllers
must be identical, including the level of BIOS and firmware on the controllers.

You can use the following pairs for fault tolerance:
v Two ServeRAID-4H
v Two ServeRAID-3HB
v Two ServeRAID-3H
v Two ServeRAID-3L
v Two ServeRAID-II

Note: If your system has a ServeRAID controller built-in on the system board, you
cannot use the built-in controller in the fault-tolerant pair.

In order to perform fault tolerance with ServeRAID controllers, you must use one of
the following enclosures:

v IBM PC Server Enterprise Expansion Enclosure (3518), using IBM SCSI-2
Fast/Wide Enhanced Repeater Adapter

v IBM Netfinity Rack Drawer Enclosure (3519), using IBM SCSI-2 Fast/ Wide
Enhanced Repeater Adapter

v IBM Netfinity EXP10 Rack Storage Enclosure, using Netfinity EXP10 3m External
Auto-Sensing Cable

v IBM Netfinity EXP15 Rack Enclosure

v IBM Netfinity EXP200 Rack Enclosure.

Installation guidelines and restrictions

Important
If any of the following restrictions and guidelines are not met, failover is disabled for the
controller pair and an error explaining the problem is logged in the system event log. To
verify that the configuration is OK, start the ServeRAID Manager program on the Windows
NT or Windows 2000 server. The Main Tree of the ServeRAID Manager displays controller
pairs that are configured for failover correctly.

In order to perform fault tolerance with ServeRAID, you must adhere to the
following guidelines and restrictions.

v The stripe-unit size and firmware level must be the same on both controllers.

v A fault-tolerant pair cannot be part of a Microsoft Cluster Service shared cluster.

v All logical drives on the controller must be configured as write through.
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Note: If you have the battery backup option, it will be disabled when you create
a fault-tolerant pair. The write-cache mode will automatically be changed
from write-back mode to write-through mode.

v The controllers must be configured in an active-passive mode, where all logical
drives are defined on only one controller of the pair.

Note: If both controllers have logical drives configured, the controllers will not be
configured as a fault-tolerant pair.

v Do not create hot-spare drives when creating a fault-tolerant pair. Hot-spare
drives are not supported in a failover environment except within a logical drive
with a RAID level-5E.

v A fault-tolerant pair must not contain any ready physical drives. All physical drives
must be configured in arrays.

v All logical drives must have unique shared merge-group numbers.

v When using multiple fault-tolerant pairs in a system, each set of controllers must
have a unique set of controller names and partner names.

v You cannot hot-add a backup controller to a system.

v You cannot disable an on-board ServeRAID controller, even if the controller is not
used.

Preparing the controllers

Note: The cables to the drives must not be attached when you start the server.

1. Insert the IBM ServeRAID Support CD (or the configuration CD that was
included with your server) into the CD-ROM drive; then, turn on the server.
The ServeRAID Manager program starts.

Note: If the ServeRAID Manager program opens in Configuration mode, a
window similar to the following opens. Click Cancel to go to Information
mode and continue to the next step.
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2. In the Main Tree, click the first ServeRAID controller that you want to
configure.

Important
The ServeRAID controller should be initialized only one time, when the controller is first
installed. Initializing the controller removes all configuration information from NVRAM. This
information includes the SCSI IDs, the Controller host ID and the Cluster partner host ID,
and the array information. This point is especially important if the Windows NT or Windows
2000 system startup drive is attached to the IBM ServeRAID controller. If the initialization
occurs after the startup drive array has been created, the array information will be removed
and the system will no longer start in Windows NT or Windows 2000.

If you already have logical drives defined that you want to keep, go to step 6 on page 64.
The steps before step 6 on page 64 will cause loss of data by deleting all logical drives
already defined.

3. Click Actions → Restore to factory default settings.

4. If a confirmation window opens, click Yes. When the operation is complete, a
message displays at the bottom of the window indicating the restore to factory
default settings was successful.

Figure 15. Configuration mode window
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5. Repeat step 2 on page 63 through step 4 on page 63 for the second
ServeRAID controller.

6. In the Main Tree, click the first ServeRAID controller that you want to
configure.

7. Click on the tool bar. The Configure controller for clustering window
opens.

8. Fill in the following information.

Notes:

a. The controller name and partner name are case sensitive.

b. If your configuration will contain multiple ServeRAID controllers pairs, each
controller name must be unique.

Controller name
Enter a name to identify the first controller, for example, Controller A.

Partner name
Enter a name that you will use to identify the second controller, for
example, Controller B.

SCSI initiator IDs
The system presets these IDs to 7. Set each ID to 6 for shared
channels.

Note: The ServeRAID Manager program does not permit you to enter
numbers other than 6 and 7.

9. Click OK.

10. In the Main Tree, click the second ServeRAID controller that you want to
configure.

11. Click on the tool bar. The Configure controller for clustering window
opens.

Figure 16. Configure controller for clustering window
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12. Fill in the following information.

Notes:

a. The controller name and partner name are case sensitive.

b. If your configuration will contain multiple ServeRAID controllers pairs, each
controller name must be unique.

Controller name
This is the same name as the partner name in step 8 on page 64. For
example, Controller B.

Partner name
This is the same name as the controller name in step 8 on page 64.
For example, Controller A.

SCSI initiator IDs
The system presets these IDs to 7. When configuring the second
controller, do not change these values.

Note: The ServeRAID Manager program does not permit you to enter
numbers other than 6 and 7.

13. Click OK.

Connecting the expansion enclosures
After you configure the controllers, you must connect the expansion enclosures to
the ServeRAID controllers.

1. Connect the expansion enclosure to each of the ServeRAID controllers.

Important
When connecting the cables, you must connect the same channel connectors on both
ServeRAID controllers to the same expansion enclosure. For example, if you connect the
cable from Channel 1 on the first ServeRAID controller to the first expansion enclosure,
then you must connect the cable from Channel 1 on the second ServeRAID controller to the
first expansion enclosure.

2. Restart the server with the IBM ServeRAID Support CD (or the configuration CD
that came with your server) in the CD-ROM drive.

Figure 17. Configure controller for clustering window
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Configuring ServeRAID arrays and logical drives
To configure arrays and a logical drive, do the following.

Note: You can create only one logical drive for each array in a failover
environment.

1.

Click on the tool bar. The Configuration mode window opens (see
Figure 15 on page 63).

2. In the Main Tree, click the first ServeRAID controller that you want to
configure.

3. Click the Custom configuration radio button.

4. Click Next. The Create arrays window opens.

5. Using the right mouse button, click the ready drive or SCSI channel icons in
the Main Tree to select the drives that you want to add to your arrays or delete
from your arrays; then, select a choice from the pop-up list.

Notes:

a. You must use all the ready drives when creating your arrays (that is, all
ready drives in the Main Tree must be online).

b. Hot-spare drives are not supported in a failover environment except within
a logical drive with a RAID level-5E.

6. After you select the ready drives for your arrays, click Next. The Create logical
drives window opens.

Note: If you change your mind, you can remove a specific drive from a newly
defined array or delete an entire newly defined array. To do this:

a. Click Back.

b. Using the right mouse button, click the specific drive or Array icon in
the Main Panel on the right.

c. Click Remove from new array or Delete new array.

7. Select a RAID level for each of the logical drives from the RAID pull-down menu
in the Main Panel.

Note: If you have four or more ready drives in an array, the recommended
RAID level is RAID level-5E.

8. Create only one logical drive for each array.

Note: Typically, the first logical drive defined on the first ServeRAID controller
found by system BIOS during startup will be your startup (boot) drive.

9. If you have created multiple arrays in step 5 on page 66, click on another array
in the Main Tree and go back to step 7 on page 66 to configure it. After
configuring all of your arrays, continue with step 10 on page 66.

10. Click Next. The Configuration summary window opens.

11. Review the information that displays on the Configuration summary window.
Click Apply to accept and save the configuration.

Note: To change the configuration, click Modify arrays or Modify logical
drives.
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12. Click Yes to continue working with your ServeRAID configuration. After
creating the arrays and logical drives, you must assign merge group numbers
to the shared logical drives.

13. In the Main Tree, click the ServeRAID controller that contains the logical
drives.

14. Click on the tool bar. The Configure controller for clustering window
opens.

15. Click the Shared check boxes for all the logical drives.

16. Do not change the merge group number from the default provided.

17. Record the controller name, partner name, and merge group numbers and
store them in a safe place. You will need this information to recover the
configuration if the ServeRAID controller should fail.

Note: You can save this information to a file by using the ServeRAID Manager
program:

a. In the Main Tree, click the server.

b. Click Actions → Save printable configuration.

18. Click OK.

19. To exit the ServeRAID Manager program, click File → Exit.

Completing the failover environment installation
To complete the installation of the failover environment, install the appropriate
ServeRAID device drivers while installing Windows NT or Windows 2000. Refer to
the following:

v The documentation that came with the Windows NT or Windows 2000 software.

v “Step 4: Installing device drivers” on page 33.

Figure 18. Configure controller for clustering window
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When you start the ServeRAID Manager installed on the server, the ServeRAID
Manager Main Tree displays a successful failover controller pairing, similar to the
following window.

Before testing your failover environment, allow the auto-synchronization process to
complete. If you test failover on a physical drive during the auto-synchronization
process, failover succeeds, but the drive is blocked. Then, you must use the
ServeRAID Manager to unblock the drive. To verify that auto-synchronization is
complete, check the progress indicator that displays in the status bar of the
ServeRAID Manager window.

For troubleshooting in a failover environment, refer to “Solving problems in a
failover environment” on page 138.

Figure 19. Information mode window showing a failover controller pairing
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Chapter 4. Introduction to IBM ServeRAID Cluster Solution

A cluster is a type of parallel or distributed system that consists of interconnected
computers that are used as a single, unified computing resource. In other words, a
group of computers linked together in such a way that they share and manage a set
of resources that can support a number of users at the same time.

This high-availability clustering solution is based on a two-server cluster, where both
servers can access the same storage devices, but only one server at a time
controls the storage devices shared by both servers. If one of the two running
server fails, the surviving server automatically assumes control of the shared
resources managed by the failed server while still controlling its own resources at
the same time. The failed server can then be repaired offline without the loss of
time or work efficiency because the shared data and applications earlier managed
by the failed server are still online to the clients.

When the failed server is operational again, it can be placed back into the cluster;
the resources are reallocated between the two servers and the cluster resumes
normal operations.

A controller is a device that coordinates and controls the operation of one or more
input and output devices, such as workstations, and synchronizes the operation of
such devices with the operation of a system as a whole.

IBM ServeRAID Cluster Solution, as discussed in this book, uses the IBM
ServeRAID-4H Ultra160 SCSI controller. IBM ServeRAID Cluster Solution also uses
IBM expansion enclosures, such as the following:
v IBM Enterprise Expansion Enclosure (Model 3518)
v IBM PC Server 3519 Rack Expansion Enclosure
v IBM Netfinity EXP15 Rack Expansion Enclosure
v IBM Netfinity EXP10 Rack Expansion Enclosure
v IBM Netfinity EXP200 Rack Expansion Enclosure
v IBM Netfinity EXP300 Rack Expansion Enclosure

You can install IBM ServeRAID Cluster Solution by using one of the following
software applications:

v Microsoft Cluster Service, which is part of Windows NT Server Enterprise Edition

v Microsoft Cluster Service using Windows 2000, which is part of Windows 2000
Advanced Server Edition or Windows 2000 Datacenter Server Edition

v Vinca High Availability for Novell IntranetWare, which is part of the IBM Netfinity
Cluster Pack by Vinca

v Novell High Availability Server 1.0

The following figures show an example of a simple high-availability clustering
solution. The first figure shows a high-level view of a cluster; the second figure
shows a more detailed view of a cluster.
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Note A: Server A
v Shared Channel 1 - SCSI ID 6
v Non-shared Channel 2 - SCSI ID 6
v Non-shared Channel 3 - SCSI ID 7

Note B: Server B
v Shared Channel 1 - SCSI ID 7
v Non-shared Channel 2 - SCSI ID 7

Server A Server B

Clients

SCSI Bus

Expansion Enclosure

Public Network

Crossover
Cable

(Heartbeat)

Figure 20. A high-level view of a cluster
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Figure 21. A detailed view of a cluster
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The solution you use for your installation depends on your own specific
requirements. For more information about requirements and types of installations,
refer to the IBM Shared Disk Clustering Hardware Reference. You can obtain this
publication from the IBM Support Web site. See “Downloadable files from the World
Wide Web” on page 14 for additional information.
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Chapter 5. Preparing to install or change a cluster solution

Note: If you are going to upgrade an existing high-availability cluster solution and
are already familiar with the concepts of a cluster, go to “Chapter 6. Updating
the ServeRAID BIOS, firmware, and software code” on page 77. If you are
setting up your first high-availability cluster solution, continue reading this
section.

Before you begin installing and setting up a high-availability cluster solution, it is
important to familiarize yourself with the following terms and definitions that are
used in this manual, as well as some considerations concerning the ServeRAID
controller.

Note: The following terms and definitions are for the Microsoft Cluster Service
using Windows NT or Windows 2000. For similar terms and definitions for
the Novell IntranetWare Cluster Solution using Novell NetWare, refer to the
Vinca High Availability for NetWare manual.

Terms and definitions
The following terms are used in this manual:

Failover is the process of relocating the cluster resources from a failed server to
the surviving server. The resource-monitor program responsible for the resource
detects the failure. If a resource failure occurs, the resource-monitor program
notifies the Cluster Service, which triggers the actions that are defined in the
failover policy for that resource. A failover can occur automatically, such as when an
application or a server fails, or it can occur manually, such as when a system
administrator moves all applications onto one server and then brings the other
server down for scheduled maintenance. Failover generally consists of three
components:
v Failure detection
v Resource relocation
v Application restart.

Failback is a special case of failover and is the process of moving back some or all
groups of resources to the preferred owner after a failover has occurred. The
preferred owner is the server in the cluster on which you prefer each group of
resources to run. If the preferred owner fails, its resources are transferred to the
other server. When the preferred owner is repaired and comes back online, and
allow failback is enabled in the Microsoft Cluster Administration program, the
resources are automatically transferred back to that server.

Resource Group is dependent resources that can be grouped together. Some
resources need other resources to run successfully and are known as resource
dependencies. When one resource is listed as a dependency for another resource,
the two resources must be placed in the same group. If all resources are ultimately
dependent on one resource (for example, one physical disk resource), all resources
must be in the same group. Therefore, all resources in a cluster might need to be in
the same group.

Also, any cluster operation performed on a group is performed on all resources that
are in that group. For example, if a resource must be moved from Server A to
Server B, all resources that are in the same group as the resource will be moved
also.
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ServeRAID considerations
It is important to understand the following ServeRAID considerations before you set
up your high-availability cluster solution.

Note: The following ServeRAID considerations are for the Microsoft Cluster
Solution using Windows NT and Windows 2000. For similar considerations
for the Novell IntranetWare Cluster Solution, refer to the Vinca High
Availability for NetWare manual.

Hardware considerations
v The SCSI-2 Fast/Wide Enhanced Repeater Card is required for configurations

using the IBM Enterprise Expansion Enclosure (Model 3518) or the IBM Model
3519 Rack Expansion Enclosure. The previous version of the SCSI-2 Fast/Wide
Repeater is not supported in these configurations. For information on the latest
version of the SCSI Fast/Wide Enhanced Repeater Card, contact your IBM
reseller or marketing representative.

v Do not connect nondisk devices, such as CD-ROM drives, to shared channels.
These devices will be accessible to both servers, and conflicts might arise.

v You must cable the SCSI channels in a controller pair so that the controllers
share the same channels.

v You must connect all disks that will be shared to the shared channels. This
includes hot-spare drives, as well as data drives.

v All shared physical drives must be part of a logical drive or defined as a hot
spare to one or the other servers. You must remove all other physical drives from
the shared disk enclosure to ensure proper operation.

Controller considerations
v Each ServeRAID controller must have a unique controller name assigned.

v Do not attempt to change the controller name on both ServeRAID controllers in a
pair at the same time. Doing so can cause a problem, such as a server lock-up.

v Each ServeRAID controller, and controller pair, must have a different SCSI
initiator ID assigned to the shared channels. For example, set one server, Server
A, to ID 6, and set the other server, Server B, to ID 7. The setup instructions
describe this in more detail.

v You must set the stripe-unit size of each ServeRAID controller in a pair to the
same value (8 KB, 16 KB, 32 KB, or 64 KB).

v You cannot share hot-spare drives between controllers in a cluster pairing. If you
want hot-spare protection, each ServeRAID controller must have a hot-spare
drive defined. You must connect hot-spare drives only to shared channels. This is
in case the hot-spare drive replaces a failed shared drive. Both servers must be
able to access the drive in case a failover occurs after the shared drive fails.

v Physical drives that are configured by one controller in the pair must appear as
ready drives to the other controller in the pair. Be sure to verify this consideration
when you add drives. Restart both servers, or scan for new devices using the
ServeRAID Manager program on both servers, to make sure the added physical
drives appear as ready drives on both servers before creating logical drives.

Array or logical drive considerations
v The ServeRAID controller does not allow the failover of RAID level-5 logical

drives that are in a critical state; that is, a drive in a RAID level-5 array that has
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failed. For this reason, do not use RAID level-5 for the quorum drive. You must
configure the quorum drive as a RAID level-1 logical drive.

Note: Define hot-spare drives in your array to minimize the time that logical
drives remain in critical state.

v Every logical drive that is shared by the two servers must have its cache policy
set to write-through mode to ensure that data integrity is maintained. Logical
drives that are not shared between the two servers can be configured for
write-back mode for improved performance.

v Create only one logical drive for each array.

v You must assign merge group numbers in the range 1– 8 to each logical drive
that will be shared. Merge group numbers must be unique for each shared logical
drive in the cluster. You must assign merge group numbers 206 or 207 to the
non-shared logical drives.

v If you are starting (booting) the operating system from a shared controller, define
the first logical drive as the startup drive and assign a merge group number for a
non-shared drive, for example, 206 for Server A.

v The total number of logical drives per controller must be eight or less before or
after a failover. If you exceed this number, a failover will not complete.

v Logical drives that are currently undergoing Logical Drive Migration (LDM)
operations will not failover. However, all other logical drives will failover if
necessary.

v If a failover occurs while a critical RAID level-1 logical drive is rebuilding to a
spare disk, the Rebuild operation automatically starts a few seconds after the
failover is completed.

v The cluster support software will initiate a synchronization of RAID level-1 and
RAID level-5 logical drives immediately after a failover. If a drive fails before this
synchronization is complete, logical drive access is placed in the blocked state
and is no longer accessible.

v When a logical drive spans across multiple SCSI channels and a failure within
the drive subsystem occurs that is unique to a channel (for example, a
disconnected cable), the entire physical array will be identified as failed even
though access from the surviving server can occur. Therefore, you might want to
consider, if you have small arrays, not spanning across multiple channels.

Use the Validate cluster feature in the ServeRAID Manager program to verify your
cluster is properly configured.

Note: If you must initialize your cluster configuration from the controller, you must
manually reset the following settings because backup configurations do not
save these settings:
v SCSI initiator IDs
v Host name
v Partner name.
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Chapter 6. Updating the ServeRAID BIOS, firmware, and
software code

Before beginning the cluster installation, be sure to read “ServeRAID
considerations” on page 74.

Use the following CD and diskette (version 4.0 or later), together as a set, with the
IBM ServeRAID Cluster Solution:
v IBM ServeRAID Support CD
v IBM ServeRAID Device Drivers diskette

Note: If you are using the latest version of the IBM ServeRAID Support CD, the
BIOS/firmware code is automatically verified when you start the server with
the CD in the CD-ROM drive. If the BIOS/firmware code needs updating, you
will be prompted to do so.

When you update any RAID software, you must update all RAID software at the
same time to ensure compatibility with all of the levels of the software. This
includes:
v BIOS/firmware
v Device drivers
v ServeRAID Manager
v IBM ServeRAID Cluster Solution software

Ensure that the ServeRAID controllers have the latest IBM ServeRAID software
installed; you must have version 4.0, or later, as a minimum. You can obtain this
software from the IBM Support Web site. See “Downloadable files from the World
Wide Web” on page 14 for additional information. If you are using Microsoft Cluster
Service, be sure that you use a version of the ServeRAID software that has been
certified by Microsoft for Windows NT and Windows 2000 compatibility, as noted on
the IBM Support Web site.

For instructions on how to determine the versions of the software on your
ServeRAID controller, refer to the documentation that was included with your server
or your controller.

Note: If you are using Windows 2000, check the Windows 2000 Hardware
Compatibility List (HCL) included on the Windows 2000 Advanced Server CD
or the IBM Server Proven List on the IBM Support Web site to determine if
your server devices are supported by the Windows 2000 operating system. If
not, contact the device manufacturer to receive a device driver for Windows
2000.

© Copyright IBM Corp. 2000 77



78 IBM
®

Netfinity
®

User’s Reference: ServeRAID™-4H Ultra160 SCSI Controller



Chapter 7. Configuring ServeRAID controllers for clustering

To install the IBM ServeRAID Cluster Solution, you must first install the BIOS and
firmware. Refer to “Chapter 6. Updating the ServeRAID BIOS, firmware, and
software code” on page 77. Then, you must configure the ServeRAID controller,
define logical drives, and set up merge group numbers for your servers.

v If you are installing the IBM ServeRAID Cluster Solution using Microsoft Cluster
Service, refer to “Configuring the controller for Microsoft Cluster Service using
Windows NT 4.0 or Windows 2000”.

v If you are installing the IBM ServeRAID Cluster Solution using Vinca and Novell
IntranetWare, refer to “Configuring the controller for Vinca High Availability for
Novell IntranetWare or Novell High Availability Server”.

Configuring the controller for Microsoft Cluster Service using
Windows NT 4.0 or Windows 2000

If you are installing the IBM ServeRAID Cluster Solution by using Microsoft Cluster
Service on Windows NT 4.0 or Windows 2000, follow these steps:

1. If necessary, perform any operating system shutdown procedure on both
servers that you are going to use in the cluster.

2. Turn off both servers.

3. If you have not done so, connect any shared external drive enclosures to both
servers; then, turn on the enclosures.

4. Follow the procedure “Configuring a controller for clustering” on page 80 for
each shared controller in Server A.

5. Continue with the procedure “Configuring ServeRAID arrays and a logical drive”
on page 82 for Server A.

6. Follow the procedure “Configuring a controller for clustering” on page 80 for
each shared controller in Server B.

7. Remove the IBM ServeRAID Support CD from the CD-ROM drive.

8. Restart Server A and Server B.

9. If you are installing the IBM ServeRAID Cluster Solution using Microsoft Cluster
Service using Windows NT 4.0, continue to “Chapter 8. Installing the Microsoft
Cluster Service software on Windows NT 4.0” on page 85.

If you are installing the IBM ServeRAID Cluster Solution using Microsoft Cluster
Service using Windows 2000, continue to “Chapter 9. Installing the Microsoft
Cluster Service software on Windows 2000” on page 93.

Note: After you have completed installing the IBM ServeRAID Cluster Solution, use
the Validate cluster feature in the ServeRAID Manager program to verify the
cluster configuration. See “Validating a cluster” on page 103 for more
information.

Configuring the controller for Vinca High Availability for Novell
IntranetWare or Novell High Availability Server

If you are installing the IBM ServeRAID Cluster Solution by using Vinca High
Availability for Novell IntranetWare or Novell High Availability Server, following these
steps:
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1. If necessary, perform any operating system shutdown procedure on both
servers that you are going to use in the cluster.

2. Turn off both servers.

3. If you have not done so, connect any shared external drive enclosures to both
servers; then, turn on the enclosures.

4. Follow the procedure “Configuring a controller for clustering” for each shared
controller in Server A.

5. Continue with the procedure “Configuring ServeRAID arrays and a logical
drive” on page 82 for Server A.

Note: In a typical Novell environment, create the logical drives on the server
that will maintain primary ownership. For example, create one RAID
level-5 logical drive on Server A and one RAID level-5 logical drive on
Server B.

6. Follow the procedure “Configuring a controller for clustering” for each shared
controller in Server B.

7. Continue with the procedure “Configuring ServeRAID arrays and a logical
drive” on page 82 for Server B.

Note: If you define an online drive or hot-spare drive for Server A, you cannot
use that drive when creating arrays or hot-spare drives on Server B.

8. Restart Server A and Server B.

9. Install Novell NetWare on your servers. For installation information, refer to the
documentation that comes with your Novell NetWare software package.

10. Install the Vinca IntranetWare software on your servers. For installation
information, refer to the documentation that comes with Vinca High Availability
for NetWare and IBM ServeRAID II SCSI Controller.

Configuring a controller for clustering
To configure a controller, do the following.

Note: For complete information on using the ServeRAID Manager program, refer to
the ServeRAID Manager online help.

1. Insert the IBM ServeRAID Support CD (or the configuration CD that was
included with your server) into the CD-ROM drive; then, turn on the server. The
ServeRAID Manager program starts.

Note: If the ServeRAID Manager program opens in Configuration mode, a
window similar to the following opens. Click Cancel to go to Information
mode and continue to the next step.
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2. In the Main Tree, click the ServeRAID controller that you want to configure.

Important
The ServeRAID controller should be initialized only one time, when the controller is first
installed. Initializing the controller removes all configuration information from NVRAM. This
information includes the SCSI IDs, the Controller host ID and the Cluster partner host ID,
and the array information. This point is especially important if the Windows NT or Windows
2000 system startup drive is attached to the IBM ServeRAID controller. If the initialization
occurs after the startup drive array has been created, the array information will be removed
and the system will no longer start in Windows NT or Windows 2000.

If you already have logical drives defined that you want to keep, go to step 6 on page 82.
Completing step 1 on page 80 through step 5 will cause loss of data by deleting all logical
drives already defined.

3. Click Actions → Restore to factory default settings.

4. If a confirmation window opens, click Yes. When the operation is complete, a
message displays at the bottom of the window indicating that the restore to
factory default settings was successful.

5. In the Main Tree, click the ServeRAID controller that you are configuring.

Figure 22. Configuration mode window
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6. Click on the tool bar. The Configure for clustering window opens.

7. Fill in the following information.

Notes:

a. The controller name and partner name are case sensitive.

b. If your configuration will contain multiple ServeRAID controllers pairs, each
controller name must be unique.

Controller name
Enter a name to identify the first controller, for example, Server A.

Partner name
Enter a name that you will use to identify the second controller, for
example, Server B.

SCSI initiator IDs
The system presets these IDs to 7. For Server B, do not change these
values. For Server A, set each ID to 6 for shared channels.

Note: The ServeRAID Manager program does not permit you to enter
numbers other than 6 and 7.

8. Click OK. The controller is now configured for clustering.

Configuring ServeRAID arrays and a logical drive

Important

v You must create only one logical drive for each array when defining shared logical
drives for use in a cluster.

v Hot-spare and standby hot-spare drives must be defined only on a shared channel, and
each controller must have its own hot-spare or standby hot-spare drive defined. This
means that you must not define the same hot-spare or standby hot-spare drive on both
controllers in the pair.

To configure arrays and a logical drive, do the following.

1.

Click on the tool bar. The Configuration mode window opens.

Figure 23. Configure for clustering window
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2. In the Main Tree, click the ServeRAID controller that you want to configure.

3. Click the Custom configuration radio button.

4. Click Next. The Create arrays window opens.

5. Using the right mouse button, click the ready drive or SCSI channel icons in
the Main Tree to select the drives that you want to add to your arrays or delete
from your arrays; then, select a choice from the pop-up list.

Notes:

a. You must use all the ready drives when creating your arrays (that is, all
ready drives in the Main Tree must be online).

b. Within the same array, you must have two or more physical drives for
RAID level-1 and three or more physical drives for RAID level-5.

c. For Windows NT and Windows 2000, you must create at least one logical
drive, the quorum drive, as RAID level-1 to store the quorum resource
information. This drive can be used to store programs and data.

d. For improved reliability, do not create arrays that span channels.

e. Hot-spare drives are not shared between controllers in a cluster pairing. If
you want hot-spare protection, each ServeRAID controller must have a
hot-spare drive defined.

f. You must connect hot-spare drives only to shared channels. This is in case
the hot-spare drive replaces a failed shared drive. Both servers must be
able to access the hot-spare drive in case a failover occurs after the shared
drive fails.

6. After you select the ready drives for your arrays, click Next. The Create logical
drives window opens.

Note: If you change your mind, you can remove a specific drive from a newly
defined array or delete an entire newly defined array. To do this:

a. Click Back.

b. Using the right mouse button, click the specific drive or Array icon in
the Main Panel on the right.

c. Click Remove from new array or Delete new array.

7. Select a RAID level for the logical drive from the RAID pull-down menu in the
Main Panel.

Note: If you have four or more ready drives in an array, the recommended
RAID level is RAID level-5E.

8. Click Next. The Configuration summary window opens.

9. Review the information that displays on the Configuration summary window.
Click Apply to accept and save the configuration.

Notes:

a. To change the configuration, click Modify arrays or Modify logical drives.

b. For Windows NT and Windows 2000 clusters, define all shared logical
drives on Server A.

10. Click Yes to continue working with your ServeRAID configuration. After
creating the arrays and logical drives, you must assign merge group numbers
to the shared logical drives.

Note: A merge group number uniquely identifies each logical drive, even when
the logical drive moves between servers.
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11. In the Main Tree, click the ServeRAID controller that contains the logical
drives.

Notes:

a. Valid merge group numbers for non-shared logical drives are 206 and 207.
For example, set all non-shared drives on Server A to merge group number
206 and all non-shared drives on Server B to merge group number 207.

b. The merge group number must be unique for each logical drive that is
shared by the controller pair. For example, if you have a logical drive with a
merge group number 1 on Server A, you cannot assign the same group
number to a logical drive on Server B. Valid merge group numbers for
shared logical drives are in the range 1-8.

12. Click on the tool bar. The Configure for clustering window opens.

13. Click the Shared check boxes for all the logical drives.

14. Do not change the merge group number from the default that is provided.

15. Record the controller name, partner name, and merge group numbers and
store them in a safe place. You will need this information to recover the
configuration if the ServeRAID controller should fail.

Note: You can save this information to a file by using the ServeRAID Manager
program:

a. In the Main Tree, click the server.

b. Click Actions → Save printable configuration.

16. Click OK.

17. To exit the ServeRAID Manager program, click File → Exit.

18. Remove the IBM ServeRAID Support CD from the CD-ROM drive.

19. Shut down the server.

Figure 24. Configure for clustering window
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Chapter 8. Installing the Microsoft Cluster Service software on
Windows NT 4.0

After configuring the ServeRAID controller, defining logical drives, and setting up
merge group numbers, install Microsoft Cluster Service (MSCS) on Windows NT
4.0.

Important
Before beginning the procedure, consider the following:

v Read “ServeRAID considerations” on page 74, which contains important information on
ServeRAID considerations.

v Read “Configuring the controller for Microsoft Cluster Service using Windows NT 4.0 or
Windows 2000” on page 79 for configuring Server A and Server B for the high-availability
cluster solution.

v Ensure that you are using the IBM ServeRAID Device Driver diskette (version 4.0, or
later) during the installation of the Microsoft Windows NT Server Enterprise Edition.

Installing the Microsoft Cluster Service
To install the Microsoft Cluster Service, complete the following procedure:

1. If you do not have Microsoft Windows NT Server Enterprise Edition installed
already, install it with Service Pack 3 (or later) on both servers, but do not
install the Microsoft Cluster Service software. When the system prompts you,
deselect the option to install MSCS; it will be installed later in this procedure.

For information on installing Windows NT Server Enterprise Edition, refer to
documentation that is included with it. When you are finished, return here and
continue with this procedure.

2. Use the ServeRAID Manager program to do the following:

v Scan for new drives.

v Check to see if synchronization of all RAID level-5 logical drives is
completed. If logical drives are currently being synchronized, a progress
indicator appears in the lower right corner of the ServeRAID Manager
program showing the progress of the synchronization.

3. On Server A, run the utility IPSHAHTO.EXE from the IBM ServeRAID Windows
NT Cluster Solutions Diskette or the IBM ServeRAID Support CD.

v If you are using the diskette, type the following command from a Windows
NT command line:
a:\support\ipshahto

where a is the diskette drive letter.

v If you are using the CD, type the following command from a Windows NT
command line:
d:\programs\winnt\cluster\support\ipshahto

where d is the CD-ROM drive letter.

Running the program makes all the shared logical drives available for access
by Server A.

4. Using the Windows NT Disk Administrator, format all shared logical drives as
NTFS (NT File System), assign volume labels, and specify drive letters for
each.
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Notes:

a. It is helpful if part of the volume label that you assign contains the drive
letter that you assigned to the drive, such as DRIVE E.

b. If you want to use the disk in a cluster, create only one partition on the
disk. Make the partition the full size of disk and format the partition to
NTFS.

5. On Server B, run the same utility, IPSHAHTO.EXE, to make all shared logical
drives available for access by Server B.

Note: Use the volume label as a guide to make sure you assign the same
letters on Server B as you assigned on Server A.

6. Using the Windows NT Disk Administrator, assign the same drive letters that
you assigned to each drive on Server A.

7. Run IPSHAHTO.EXE from Server A again, so that control of all shared logical
drives returns to Server A.

8. Install the Microsoft Cluster Service (MSCS) software.

Note: The directory name and path where the MSCS software is installed must
be the same on both servers.

To start the installation, do the following.

Important
You must use the localquorum option when installing the Microsoft Cluster Service (MSCS)
software with ServeRAID controllers.

a. Insert the Windows NT Server Enterprise Edition Component CD into the
CD-ROM drive on Server A, type the following command at the command
line and press Enter.
\MSCS\CLUSTER\I386\SETUP /localquorum

Note: You must type the parameter localquorum in lowercase.

b. Install the Microsoft Cluster Service software following the instructions in the
documentation that is included with the MSCS software.

Server A will restart when the installation is completed.

9. To make Server B join the cluster, do the following.

Note: The directory name and path where the MSCS software is installed must
be the same on both servers.

a. Insert the Windows NT Server Enterprise Edition Component CD into the
CD-ROM drive on Server B. Type the following command (from either a
command line or Add/Remove Programs in the Control panel) and press
Enter:
\MSCS\CLUSTER\I386\SETUP

b. Install the Microsoft Cluster Service software following the instructions in the
documentation that is included with the MSCS software.

Server B will restart when the installation is completed.

10. Make Server A the preferred owner of the cluster group by doing the following:

a. Run the Microsoft Cluster Administrator program that is included with the
MSCS software. Refer to the documentation that is included with the
MSCS software for instructions.

b. Select the Cluster Group.

c. Click File → Properties to display the properties window.
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d. Click Modify next to the Preferred Owner text box.

e. Select Server A and move it to the right side, into the Preferred Owners
panel.

f. Click OK. Server A appears in the Preferred Owner text box.

g. Make sure that the cluster group has failover enabled. For instructions on
how to do this, refer to the documentation that is included with the
Microsoft Cluster Services software.

h. Close the connection to the cluster and open it again to ensure that the
connection is through Server A.

11. Install the IBM ServeRAID Windows NT Cluster Solution program by doing the
following:

a. On Server A, run the utility SETUP.EXE program from the IBM ServeRAID
Windows NT Cluster Solution diskette or IBM ServeRAID Support CD and
follow the instructions that appear on the screen.

v If you are using the diskette, type the following command from a
Windows NT command line:
a:\setup

where a is the diskette drive letter.

v If you are using the CD, type the following command from a Windows
NT command line:
d:\programs\winnt\cluster\setup

where d is the CD-ROM drive letter.

b. When the program has completed, run the SETUP.EXE program on Server
B.

After the utility has been installed on both servers, all shared ServeRAID
groups and disk resources will be automatically created by the IBM
ServeRAID Cluster Solution setup program and then brought online. Server
A is the current owner of these groups.

12. Move the quorum resource from localquorum to a ServeRAID disk resource by
doing the following:

a. On Server A, run the Microsoft Cluster Administrator program and click the
cluster name to select the cluster you are using.

b. Verify that the same server (for example, Server A) owns the ServeRAID
disk resources and the localquorum resource and that the quorum resource
is moved to a RAID level-1 logical drive.

c. Using the right mouse button, click the cluster name to open the cluster.

d. Select Properties; then, select the Quorum tab.

e. In the Quorum Resource field, select a ServeRAID shared disk.

f. Click OK.

Refer to the Microsoft Cluster Solution Administrator’s Guide for more
information.

13. Install Service Pack 4 or later.

Note: If you installed Service Pack 4 or later previously, you must reinstall it
now.

You can now move the shared disk resources manually using the Microsoft Cluster
Administrator program or automatically during failover.
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Creating a ServeRAID disk resource on a Windows NT 4.0 ServeRAID
cluster

You can use a ServeRAID logical disk that has not already been designated as a
cluster resource, or you can create a new array and logical disk on Server A, using
the ServeRAID Manager program. For more information about creating new arrays
and logical drives, refer to “Step 3: Configuring ServeRAID controllers” on page 22.

Note: Be sure to assign a unique shared merge group number to the new shared
logical drive.

Important
Before creating the ServeRAID logical cluster resource, you must assign a permanent
(sticky) drive letter to the shared logical drive on both servers.

When configuring a cluster, you must assign a permanent drive letter because the two
servers must have the same drive letters on each shared logical drive. If you do not assign
permanent drive letters, Windows NT might assign different drive letters on each server. You
must assign a permanent drive letter to ensure Windows NT assigns the same drive letter
to the partition on both servers.

1. On Server A, do the following:

a. Click Start in the lower-left corner of the screen; then, click Programs →
Tools → Administrative Tools → Disk Administrator. The Disk
Administrator window opens.

b. Click the partition that you want to assign a permanent drive letter.

c. Click Tools → Assign Drive Letter. The Assign drive letter window opens.

d. In the Assign drive letter pull-down menu, click the drive letter for the
partition.

e. Click OK. Windows NT permanently assigns the selected drive letter to that
partition, even if you add new partitions or rearrange your controllers.

f. To exit the Disk Administrator, click Partition → Exit.

2. On Server B, do the following:

a. Using the ServeRAID Manager program, scan for new or removed ready
drives.

b. Using the IPSHAHTO.EXE program, move the newly defined logical drive.

c. Using the Windows NT Disk Administrator program, assign the same
permanent (sticky) drive letter as in step 1.

Perform the following operation on the cluster server that currently owns the shared
logical disk drive. The cluster server that owns the logical disk drives is the server
on which you last ran the IPSHAHTO.EXE program.

1. On the server owning the newly created logical drive, run Cluster Administration
program and open a connection to the installed cluster.

2. To create the ServeRAID disk resource in an existing group, ensure that the
cluster server that owns the shared logical disk drive is the owner of that group.
If the cluster server is not the owner of the group, use Move Group to make
this cluster server the owner of the group where you will create the ServeRAID
disk resource. Then, create the ServeRAID disk resource.

3. Bring the new ServeRAID disk group online. If you create a new ServeRAID
group, the cluster server that owns the shared logical disk drive will be the
owner of this group by default.

4. Create a ServeRAID disk resource as part of the new group.
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5. Bring the ServeRAID disk group online.

Deleting and re-creating a ServeRAID logical drive resource
This section describes how to delete and re-create a ServeRAID logical drive
resource without deleting a ServeRAID logical drive.

To delete a resource or resource group:

1. If the resource or resource group is not currently owned by the cluster server
from which you will delete the group, move the resource or resource group to
that cluster server.

Note: The cluster service must be running on both systems.

2. To delete the resource, run the Microsoft Cluster Administration program from
the cluster server that currently owns the resource or resource group.

Note: You can also run the Microsoft Cluster Administration program from a
remote administration system.

Use the normal MSCS procedure for deleting a resource or a group. Refer to
the documentation that is included with the MSCS package for instructions.

To create a resource:

1. If the group that will own the resource you are creating is not currently owned
by the cluster server on which you want to create the resource, move the group
to the cluster server.

2. To create the resource, run the Microsoft Cluster Administration program from
the cluster server that currently owns the resource group.

Create a new ServeRAID logical disk. Refer to “Creating a ServeRAID disk
resource on a Windows NT 4.0 ServeRAID cluster” on page 88.

Uninstalling MSCS on ServeRAID servers

Note: Do not use the uninstallation procedure if you are upgrading MSCS on
ServeRAID servers. To upgrade MSCS on ServeRAID servers, follow the
instructions in “Updating ServeRAID software in an MSCS cluster
environment” on page 90.

To uninstall MSCS on ServeRAID servers, you must perform the following
procedure on all servers in your cluster:

1. Select one of the cluster servers from which to uninstall MSCS.

2. Click Start in the lower-left corner of the screen; then, click Settings → Control
Panel. The Windows NT control panel window opens.

3. Double-click Services. The Services window opens.

4. Select Cluster Service from the list of services; then, click Stop.

5. Click Close to exit the Services window. For more information, refer to the
documentation that is included with the cluster services.

6. In the Windows NT control panel, double-click Add/Remove Programs.

7. Select Microsoft Cluster Service from the list of installed components; then,
click Add/Remove.
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Note: Ignore the warnings regarding the removal of IBM ServeRAID Logical
Disks.

8. Follow the on-screen prompts by clicking OK or Yes.

9. After the uninstallation of MSCS is complete, restart the server when
prompted.

10. After the server has restarted, click Start; then, click Settings → Control
Panel.

11. Double-click Add/Remove Programs.

12. Select IBM ServeRAID Windows NT Cluster Solution from the list of
installed components; then, click Add/Remove.

13. Repeat step 1 on page 89 through step 12 on page 90 for the other server in
the cluster.

Updating ServeRAID software in an MSCS cluster environment

Note: If you are upgrading your ServeRAID software after downloading it from the
IBM Support Web site, perform this procedure. If you are installing your
software using the IBM ServeRAID Support CD, refer to “Chapter 2.
Installing and configuring ServeRAID controllers” on page 13 for instructions.

Important
This upgrade procedure allows the cluster to remain online at all times. To upgrade the
cluster, perform the following steps on one server at a time. When all steps are completed
for Server A and both servers are reported in the Microsoft Cluster Administrator program as
up and all resources are online, repeat the steps for Server B.

Note: Use these instructions on a cluster running Microsoft Cluster Service (MSCS)
Release 1.00 and IBM ServeRAID Cluster Solution.

Step 1: Upgrading the IBM ServeRAID Manager program
To upgrade the ServeRAID Manager program, run the SETUP.EXE program on the
IBM ServeRAID Support CD.

Step 2: Upgrading the IBM ServeRAID Microsoft Windows NT Cluster
Solution

To upgrade the IBM ServeRAID Microsoft Windows NT Cluster Solution, do the
following on each server in the cluster:

1. Start the Microsoft Cluster Administrator program on the server you want to
upgrade and move all resources and groups to the other server (its cluster
partner).

2. Insert the IBM ServeRAID Support CD into the CD-ROM drive; then, type the
following command and press Enter.
d:\programs\winnt\cluster\setup.exe

where d is the CD-ROM drive.

3. Follow the instructions that appear on the screen.
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Step 3: Upgrading the IBM ServeRAID Windows NT device driver
To upgrade the IBM ServeRAID Windows NT device driver on a server in the
cluster, do the following:

1. Insert the IBM ServeRAID Support CD, version 4.0 or later into the CD-ROM
drive.

2. Click Start in the lower-left corner of the screen; then, click Settings → Control
Panel. The Windows NT control panel window opens.

3. Double-click SCSI-Adapters.

4. Click the Drivers tab.

5. Click Add.

6. Click Have Disk.

7. For the path, type:
d:\programs\winnt\driver\nt4_0

where d is the CD-ROM drive.

8. Click OK.

9. Click OK when the IBM ServeRAID controller is highlighted.

10. Shut down and restart the server from the CD.

Step 4: Upgrading the IBM ServeRAID BIOS and firmware
To upgrade the IBM ServeRAID BIOS and firmware on a server in the cluster, do
the following:

1. Start the server from the IBM ServeRAID Support CD, version 4.0 or later, if the
server was not previously started in step 10 on page 91 of the procedure “Step
3: Upgrading the IBM ServeRAID Windows NT device driver”.

2. Flash the BIOS and download the firmware by clicking Update when prompted.
If no update is required, the ServeRAID Manager program starts.

3. When the download is complete, remove the CD from the CD-ROM drive and
press Ctrl+Alt+Del to restart (reboot) the server.

4. Allow the server to rejoin the cluster and when the server is reported in the
Microsoft Cluster Administrator program as “Up” and all resources are online,
the upgrade for this server is complete.

Step 5: Upgrading the software for the other server in the cluster
To upgrade the software for the other server in the cluster, do the following:

1. Ensure that Server A is online in the cluster.

2. For Server B, repeat “Step 1: Upgrading the IBM ServeRAID Manager program”
on page 90 through “Step 4: Upgrading the IBM ServeRAID BIOS and
firmware”.

You have completed the steps necessary for upgrading the IBM ServeRAID Cluster
Solution.
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Chapter 9. Installing the Microsoft Cluster Service software on
Windows 2000

After configuring the ServeRAID controller, defining logical drives, and setting up
merge group numbers, install Microsoft Cluster Service (MSCS) on Windows 2000.

Note: Do not configure Microsoft Cluster Service during the installation of Windows
2000 on any cluster node. You will configure MSCS later.

Important
Before beginning the procedure, consider the following:

v Read “ServeRAID considerations” on page 74, which contains important information on
ServeRAID considerations.

v Read “Configuring the controller for Microsoft Cluster Service using Windows NT 4.0 or
Windows 2000” on page 79 for configuring Server A and Server B for the high-availability
cluster solution.

v Ensure that you are using the IBM ServeRAID Device Drivers diskette (version 4.0; or
later) during the installation of Windows 2000 Advanced Server Edition or Windows 2000
Datacenter Server Edition.

Installing the ServeRAID Manager program
Before installing MSCS, you must install the ServeRAID Manager program:

1. If the server is not running, turn on the server.

2. Log on to Windows 2000.

3. Insert the IBM ServeRAID Support CD (or the configuration CD that was
included with your server) into the CD-ROM drive of Server A. The ServeRAID
Manager setup program starts.

4. Click Next.

5. Click Yes to the Software License Agreement.

6. When prompted to select an operating systems, select Windows 95/98/NT;
then, click Next.

7. When prompted to install Windows NT Service, select Yes; then, click Next.

8. Select the Destination Folder.

9. Click Next.

10. After setup completes copying the files, click Finish.

Installing the Microsoft Cluster Service
To install the Microsoft Cluster Service, complete the following procedure:

1. Use the ServeRAID Manager program to do the following:

v Scan for new drives.

v Check to see if synchronization of all RAID level-5 logical drives is
completed. If logical drives are currently being synchronized, a progress
indicator appears in the lower right corner of the ServeRAID Manager
program showing the progress of the synchronization.

2. On Server A, run the utility IPSHAHTO.EXE from the IBM ServeRAID Windows
NT Cluster Solutions Diskette or the IBM ServeRAID Support CD.

v If you are using the diskette, type the following command from a Windows
2000 command line:
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a:\support\ipshahto

where a is the diskette drive letter.

v If you are using the CD, type the following command from a Windows 2000
command line:
d:\programs\winnt\cluster\support\ipshahto

where d is the CD-ROM drive letter.

Running the program makes all the shared logical drives available for access
by Server A.

3. Click Start → Settings → Control Panel.The Control Panel window opens.

4. Double-click Computer Management. The Computer Management window
opens.

5. On the left side of the window, click to expand the Storage icon; then, click
Disk Management. The Disk Signature and Upgrade Wizard window opens.

6. To assign disk signatures for the shared disks, click Next.

7. Microsoft Cluster Service using Windows 2000 requires you to set shared
logical drives to Basic Disk. To do this, click Cancel in the Upgrade Disks
panel of the window.

8. Format all shared logical drives to NTFS (NT File System), assign volume
labels, and specify drive letters for each.

Notes:

a. It is helpful if part of the volume label that you assign contains the drive
letter that you assigned to the drive, such as DRIVE E.

b. If you want to use the disk in a cluster, create only one partition on the
disk. Make the partition the full size of disk and format the partition to
NTFS.

c. Make sure that all shared logical drives are the type Basic Disk. If they are
marked Dynamic Disk, change them to Basic Disk by doing the following:

1) With the right-mouse button, click the Disk icon at the bottom of the
Disk Management window (see Figure 25 on page 95).

2) Click Revert to Basic Disk.

94 IBM
®

Netfinity
®

User’s Reference: ServeRAID™-4H Ultra160 SCSI Controller



9. On Server B, run the same utility, IPSHAHTO.EXE, to make all shared logical
drives available for access by Server B.

Note: Use the volume label as a guide to make sure you assign the same
letters on Server B as you assigned on Server A.

10. Using the Windows 2000 Disk Management Snap-in Computer Management
program, assign the same drive letters that you assigned to each drive on
Server A.

11. Run IPSHAHTO.EXE from Server A again, so that control of all shared logical
drives returns to Server A.

12. Using the Windows 2000 Disk Management Snap-in Computer Management
program on Server A, verify that the shared logical drives display with the
correct size, volume label, and drive letter.

Note: The drive letters for the shared disks must be the same on each server
in the cluster.

13. If you have not selected the Clustering Service option for Server A and Server
B in the Windows Components window during the Windows 2000 Advanced
Server or Datacenter Server installation, do the following:

a. From the Windows 2000 Advanced Server CD, select Install Add-On
Components.

b. Click the Cluster Service box; then, click Next.

14. After copying some files, the Windows Component Wizard opens the Cluster
Service Configuration Wizard. Click Cancel.

Figure 25. Changing a shared logical drive to Basic Disk
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15. Insert the IBM ServeRAID Windows NT Cluster Solution diskette or IBM
ServeRAID Support CD into the Server A diskette or CD-ROM drive; then, type
the following command and press Enter:

v If you are installing from diskette, type the following command from a
Windows 2000 command line and press Enter:
a:\setup

where a is the diskette drive letter.

v If you are installing from CD, type the following command from a Windows
2000 command line and press Enter:
d:\programs\winnt\cluster\setup

where d is the CD-ROM drive letter.

16. Follow the instructions that appear on the screen. During this process, the
SETUP.EXE program copies ServeRAID cluster files.

17. When prompted, start the IBM ServeRAID Cluster Configuration Wizard
(MSCSCFG.EXE). Doing so starts the Microsoft Cluster Service Configuration
Wizard.

Note: Refer to Microsoft cluster documentation for instructions on configuring
the Microsoft Cluster Service.

18. The Microsoft Cluster Service Configuration Wizard does not prompt you to
select a quorum drive. After the Microsoft Cluster Service Configuration Wizard
completes, the IBM ServeRAID Cluster Configuration Wizard applies
ServeRAID-specific configurations to the cluster. Then, the wizard prompts you
to select a shared ServeRAID logical drive on which to set quorum.

Note: It is recommended that you place the quorum resources on RAID
level-1.

19. Repeat step 13 on page 95 through step 17 on page 96 for Server B. The
cluster installation is complete and the cluster is ready for use.

Creating a ServeRAID disk resource on a Windows 2000 ServeRAID
cluster

You can use a ServeRAID logical disk that has not already been designated as a
cluster resource, or you can create a new array and logical disk on Server A, using
the ServeRAID Manager program. For more information about creating new arrays
and logical drives, refer to “Chapter 2. Installing and configuring ServeRAID
controllers” on page 13.

Note: Be sure to assign a unique shared merge group number to the new shared
logical drive.

Important

Before creating the ServeRAID logical cluster resource, you must assign a permanent
(sticky) drive letter to the shared logical drive on both servers.

When configuring a cluster, you must assign a permanent drive letter because the two
servers must have the same drive letters on each shared logical drive. If you do not assign
permanent drive letters, Windows 2000 might assign different drive letters on each server.
You must assign a permanent drive letter to ensure Windows 2000 assigns the same drive
letter to the partition on both servers.
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1. On Server A, do the following:

a. Using the right-mouse button on the desktop, click My Computer; then, click
Manage. The Computer Management window opens.

b. Double-click Storage.

c. Click Disk Management. The Write Signature and Upgrade Disk Wizard
opens.

d. Using the right-mouse button, click Disk Management → Rescan Disks.

e. On each of the new disks, do the following:

1) Using the right-mouse button, click on a new disk; then, click Write
Signature. The Write Signature Wizard opens. Follow and complete the
wizard.

2) Make sure that all shared logical drives are the type Basic Disk. If they
are marked Dynamic Disk, change them to Basic Disk by doing the
following:

a) With the right-mouse button, click the Disk icon at the bottom of the
Disk Management window.

b) Click Revert to Basic Disk.

3) Create one partition on the disk (the full size of disk), assign a drive
letter, and format the partition to NTFS.

Note: To help recognize the drive on the cluster partner server, assign a
descriptive volume label that includes the drive letter.

2. On Server B, do the following:

a. Using the ServeRAID Manager program, scan for new or removed ready
drives on all ServeRAID controllers.

b. To move the newly defined logical drive to Server B, start the
IPSHAHTO.EXE program by typing:
%systemroot%\cluster\ipshahto.exe

where %systemroot% is expanded by the operating system to the root
directory of the operating system on Server B.

c. To create a new ServeRAID disk resource and group for each newly defined
logical drive on Server B, start the MSCSCFG.EXE program by typing:
%systemroot%\cluster\mscscfg.exe

where %systemroot% is expanded by the operating system to the root
directory of the operating system on Server B.

To create a new ServeRAID disk resource and group for the ServeRAID logical
drive, do the following on the cluster server that currently owns the shared logical
drive.

Note: The cluster server that owns the shared logical drives is the server on which
you last ran the IPSHAHTO.EXE program.

Start the MSCSCFG.EXE program by typing:
%systemroot%\cluster\mscscfg.exe

where %systemroot% is expanded by the operating system to the root directory of
the operating system on the server.
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Deleting and re-creating a ServeRAID logical drive resource
This section describes how to delete and re-create a ServeRAID logical drive
resource without deleting a ServeRAID logical drive.

To delete a resource or resource group:

1. To delete the resource, run the Microsoft Cluster Administration program from
the cluster server that currently owns the ServeRAID resource or resource
group.

Notes:

a. The cluster service must be running on both servers.

b. You can also run the Microsoft Cluster Administration program from a
remote administration system.

2. Use the normal MSCS procedure for deleting a resource or a group. Refer to
the documentation that is included with the MSCS package for instructions.

3. After deleting the ServeRAID resource, shut down and restart the cluster server
from which the resource was deleted.

Note: Restarting one cluster server will not bring down the entire cluster.

To create the new ServeRAID disk resource and group for the ServeRAID logical
drive, start the MSCSCFG.EXE program by typing:
%systemroot%\cluster\mscscfg.exe

where %systemroot% is expanded by the operating system to the root directory of
the operating system on Server B.

Upgrading the IBM ServeRAID Cluster Solution from Microsoft
Windows NT 4.0 to Windows 2000

To upgrade from Windows NT 4.0 with Service Pack 5 (or later) to Windows 2000
Advanced Server, do the following.

Note: Before upgrading from Windows NT 4.0 Enterprise Edition, make sure you
have updated Windows NT 4.0 Enterprise Edition with the latest Service
Pack on both Server A and Server B.

1. On the server you want to upgrade, click Start → Programs → Administrative
Tool → Cluster Administrator.

2. Move all cluster resources and groups to the other cluster node (that is, the
server that is not running the Cluster Administrator program).

3. Insert the IBM ServeRAID Support CD (version 4.0 or later) into the CD-ROM
drive; then, type the following command and press Enter:
d:\programs\winnt\cluster\setup.exe

where d is the CD-ROM drive.

4. When prompted ″You are currently running Windows NT 4.0. Is this upgrade to
″IBM ServeRAID NT Cluster Solution″ being done as procedure to upgrade
cluster to run Windows 2000?″, click Yes.

5. The IBM ServeRAID Windows NT Solution Setup program copies the necessary
Windows 2000 files; then, prompts you to upgrade the server to Windows 2000.
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Note: Completing this step means you can not use this server as a Windows
cluster node anymore.

6. Insert the Microsoft Windows 2000 Advanced Server CD or the Microsoft
Windows 2000 Datacenter Server CD into the CD-ROM drive.

7. Run the Windows 2000 Advanced Server Setup program or the Windows 2000
Datacenter Server Setup program to upgrade this node to Windows 2000. After
successfully upgrading the server, it joins the cluster.

8. Repeat step 1 on page 98 through step 7 on page 99 for the other server in the
cluster.

Uninstalling MSCS on ServeRAID servers
To uninstall MSCS on a ServeRAID server using Windows 2000 Advanced Server,
do the following:

1. On the server you want to remove from the cluster, click Start → Programs →
Administrative Tools → Cluster Administrator.

2. Move all cluster resources and groups to the other cluster server (that is, the
server that is not running the Cluster Administrator program).

3. In the tree view, click the server from which you want to remove MSCS.

4. Using the right-mouse button, click Evict Node.

5. Click Start → Settings → Control Panel.The Control Panel window opens.

6. Double-click Add/Remove Programs. The Add/Remove Programs window
opens.

7. In the left panel of the window, click Add/Remove Windows Components.
The Windows Components Wizard opens.

8. Deselect Cluster Service in the Components list; then, click Next.

9. After uninstalling the Microsoft Cluster Service completes, the Windows
Component Wizard prompts you to restart the server.

10. After the server restarts, click Start → Settings → Control Panel.The Control
Panel window opens.

11. Double-click Add/Remove Programs. The Add/Remove Programs window
opens.

12. Select IBM ServeRAID NT Cluster Solution from the list of installed
components.

13. To uninstall the IBM ServeRAID Windows NT Cluster Solution, click
Change/Remove.
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Chapter 10. Monitoring and updating an IBM ServeRAID
Cluster Solution

You can use the ServeRAID Manager program to check the ownership of a physical
drive on another server or to add or remove a logical drive in the cluster. The
ServeRAID Manager program supports three features for cluster functions:
v Validate cluster
v Configure for clustering
v View shared drives.

Note: Make sure that you installed the ServeRAID Manager program on your
server. If you need to install it, refer to “Installing the ServeRAID Manager
program” on page 49 for instructions.

Checking the ownership of a physical drive
A physical drive that is owned (and configured) on Server B will appear in the ready
or defunct state on Server A. To determine if a ready drive is owned by the other
server, do the following:

1. In the Main Tree, click the controller that contains the ready drives. A window
similar to the following opens.

Figure 26. Information mode window
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2. Click Actions → Clustering actions.

3. Click View shared drives. The View shared drives window opens.

4. Click Enable view shared drives.

5. Select the SCSI channel and SCSI ID of a physical drive on a shared channel.

6. Click OK. Physical drives that are available for use are labeled Ready in the
Main Tree. If the physical drive is not available for use (that is, it is owned by
the other server), the drive is labeled Reserved in the Main Tree.

Important
Hot-spare drives owned by the other server are not labeled Reserved. Be sure you do not
inadvertently use a hot-spare drive in both servers.

Adding logical drives to a cluster
If you want to add logical drives to a cluster, do the following:

1. Install the hard disk drives in the server or shared expansion enclosure. For
installation information, refer to the documentation that is included with the hard
disk drive and the server.

Attention
Physical drives that are configured by one controller in the pair must appear as ready drives
to the other controller in the pair. Be sure to verify this status when you add drives after the
servers are started. Before creating logical drives, restart both servers, or scan for new
drives using the ServeRAID Manager program on both servers, to make sure the added
physical drives appear as ready drives on both servers. For more information, see
“ServeRAID considerations” on page 74.

2. Using the ServeRAID Manager program, configure the physical drives for the
ServeRAID controller. Refer to “Step 3: Configuring ServeRAID controllers” on
page 22 for instructions.

Note: If the drives will be shared, define only one logical drive per array.

3. In the Main Tree, click the controller for the cluster.

4. Click on the tool bar. A window similar to the following opens.
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5. Click Shared or Non-shared for the logical drive you have just defined.

6. Select the merge group number you want to use for the logical drive you just
defined.

7. Click OK.

8. If you are using Windows NT 4.0, continue with “Creating a ServeRAID disk
resource on a Windows NT 4.0 ServeRAID cluster” on page 88.

If you are using Windows 2000, continue with “Creating a ServeRAID disk
resource on a Windows 2000 ServeRAID cluster” on page 96.

Validating a cluster
Use this feature to determine if your cluster is configured correctly.

Note: You must have the ServeRAID Manager program installed on all servers in
the cluster for this feature to work.

To validate a cluster, do the following:

1. In the Main Tree, click a server in the cluster.

2. Click Actions → Validate cluster. A window similar to the following opens.

Figure 27. Configure for clustering window
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The server you selected in step 1 on page 103 is listed in the Node A box.

Note: You cannot change the Node A system in the Cluster validation window.
To select a different system, click Cancel to return to the Main Tree.

3. From the Node B pull-down menu, select your second server.

Note: The Node B system defaults to the first system in the Main Tree other
than the Node A system. If there are no remote systems in the Main
Tree, click Cancel to return to the Main Tree and add a remote system.
You can also type in the Node B name.

4. Click Start. The ServeRAID Manager program scans both systems to verify the
ServeRAID cluster configuration. The progress indicator reports the progress of
the validation.

5. If you want to stop the validation before it completes, click Cancel. Otherwise, if
the ServeRAID Manager program finds problems with the ServeRAID cluster
configuration, it reports the problems in the Problems found message field. If
there are no problems with the ServeRAID cluster configuration, the message
field reports only the cluster pairings found.

6. To view the problem report events in an easy-to-read window, double-click an
event in the Problems found message field.

7. To save the contents of the Problems found message field, click Save. A Save
as window opens. Specify the file name for the message field log and click OK.

8. Click Done to exit the Cluster validation window. If the ServeRAID cluster
configuration has problems, fix the problems; then, use Validate cluster again.

Figure 28. ServeRAID cluster validation window
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Viewing merge group numbers and other cluster information
To view the merge group numbers and other cluster information, do the following:

1. In the Main Tree, click the controller you are using for the cluster.

2. Click on the tool bar. A window similar to the following opens.

Note: In this case, you can view this information only. You cannot change the
information.

Figure 29. Configure controller for clustering window
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Chapter 11. Using utility programs

This chapter provides the information that is needed to start and use the
ServeRAID Mini-Configuration program, and the IPSSEND and IPSMON
command-line programs.

Using the ServeRAID Mini-Configuration program
The ServeRAID Mini-Configuration program provides a quick way to display the
current settings for the ServeRAID controller. You also can use this program to
perform a limited set of the configuration functions without using the IBM
ServeRAID Support CD.

To access the Mini-Configuration program:

1. Turn on the server. If the server already is running, shut down the operating
system and restart the server.

2. When the ServeRAID Mini-Configuration prompt appears, press Ctrl+I.

3. If your server contains more than one ServeRAID controller, a selection screen
will appear. To continue:
a. Use the Up Arrow (↑) or Down Arrow (↓) key to select a controller.
b. Press Enter.

If your server contains only one ServeRAID controller, or after you select a
ServeRAID controller, the Main Menu appears.

Descriptions of the choices available from the Main Menu of the
Mini-Configuration program are as follows:

v View Controller Status shows the current status of the ServeRAID
controller. (See “Viewing the controller status” for more information.)

v View Configuration shows the current configuration information for the
ServeRAID controller. (See “Viewing the configuration” on page 108 for more
information.)

v Advanced Functions is used to initialize the configuration, import
configuration from drives, configure BIOS settings, and view the controller
and PCI information. (See “Using the advanced configuration functions” on
page 108 for more information.)

4. Use the Up Arrow (↑) or Down Arrow (↓) key to highlight your choice; then,
press Enter.

5. Follow the instructions that appear on the screen.

6. Click Exit; then, press Enter.

Viewing the controller status
When you select View Controller Status from the Main Menu, the following
information appears on the screen:

v All physical drives and their states

v Unattended shows the current state of the Unattended mode.

– When this option is set to Off, you can choose the recovery method when a
ServeRAID controller startup error occurs.

– When this option is set to On, the ServeRAID controller chooses the recovery
method when a startup error occurs.

v Read Ahead shows the current state of the read-ahead cache mode.
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v BootCD shows the current state of the Bootable CD-ROM function. (Refer to
“Setting the Bootable CD-ROM feature” on page 109.)

v CompMode shows the current BIOS compatibility mode. On indicates 8 gigabyte
(GB) Extended; Off indicated 2 gigabyte (GB) Limited.

v Clustered shows the current state for clustering.

v BBWC shows the cache size of the battery-backup write cache, if it is installed (8
= 8 MB or 32 = 32 MB) or No if there is a no battery-backup write cache
installed.

v Boot Blk shows the version number of the startable microcode (or firmware)
loaded for the ServeRAID controller.

v Code Blk shows the current version number of the microcode (or firmware)
loaded for the ServeRAID controller.

v Rebuild Rate shows the current speed setting for rebuilds: High, Medium, or
Low.

v Number of Defunct drives shows the current number of defunct physical drives.

v Number of Offline drives shows the current number of offline logical drives.

v Number of Critical drives shows the current number of critical logical drives.

v Config. Updates shows the number of times that the configuration has been
changed since it has been initialized. When you initialize the configuration, the
Config. Update resets to zero.

v Bad Stripe, Locked Stripe, or Blocked Drive identifies the logical drives that
are affected.

– Bad Stripe Drives indicates logical drives that have inaccessible areas.

– Locked Stripe Drives is a reserved field.

– Blocked Drives indicates the logical drives that are blocked. You must
unblock a blocked drive before you can use it. See “Logical drive state
descriptions” on page 11 for more information.

Viewing the configuration
You can select View Configuration from the Main Menu to display the number of
each logical drive, and to display the size, RAID level, state, stripe-unit size, write
policy, read-ahead status, and creation date for each logical drive.

Using the advanced configuration functions
You can select the Advanced Functions to restore the controller configuration to
factory default settings, copy the configuration to the controller from the connected
physical drives, configure BIOS settings, and view the controller and PCI
information.

When you select the Advanced Functions from the Main Menu, the following
choices appear on the screen.

Attention: Be careful when making selections from this menu. If you change the
configuration, you might lose data.

v Restore to Factory Default Settings is used to reset the configuration. When
you reset the configuration, you will not have access to any data stored on the
logical drives attached to the selected ServeRAID controller.

This choice deletes the existing configuration information, sets all functional
physical drives attached to the controller to the ready state, and deletes all
logical drives defined for the controller.
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This choice does not change any of the ServeRAID controller settings (such as
the stripe-unit size, rebuild rate, and so on) from their current values.

v Copy the Configuration from Drives to Controller reads the most common
configuration from the drives in the server and copies it to the ServeRAID
controller.

v Configure BIOS Settings is used to modify the BIOS settings, such as the
Bootable CD-ROM setting, for the ServeRAID controller. (See “Setting the
Bootable CD-ROM feature” for more information.)

Note: The Multiple Controller mode for extra BIOS has two settings: Erase and
Shrink. When this parameter is set to Erase, redundant copies of the
ServeRAID BIOS are erased. When this parameter is set to Shrink, the
redundant copies of the ServeRAID BIOS are removed from memory but
stored in the controller for future use. When multiple ServeRAID
controllers are installed, you need only one active copy of ServeRAID
BIOS. However, to ensure that you have a copy of the ServeRAID BIOS
available if your active copy becomes defective or unavailable, leave the
Multiple Controller parameter set to Shrink.

v View Controller and PCI Information shows the ServeRAID controller hardware
and PCI register information.

v Exit is used to exit from the Mini-Configuration program.

Setting the Bootable CD-ROM feature
When you attach a CD-ROM drive to the ServeRAID controller and set the Bootable
CD-ROM feature to Yes, the ServeRAID controller will attempt to start a CD that
has a startable (bootable) startup partition, if no other controller in the server is
currently using INT13 extensions. Only one controller in the server can support the
INT13 extensions.

To enable the Bootable CD-ROM feature:

1. Select Advanced Functions from the Main Menu of the Mini-Configuration
program.

2. Select Configure BIOS Settings from the Advanced Functions menu.

3. Use the Up Arrow (↑) and Down Arrow (↓) keys to highlight BIOS Support for
Bootable CD-ROM then press Enter to change No to Yes.

4. Ensure that the screen has Yes next to BIOS Support for Reading Partition
Tables. If not, use the Up Arrow (↑) and Down Arrow (↓) keys to highlight BIOS
Support for Reading Partition Tables; then, press Enter to change No to Yes.

Note: You must perform this next step to save the new settings.

5. Highlight Save Configuration to the ServeRAID Controller then, press Enter.
The program displays an Okay message and then returns you to the Main Menu
of the Mini-Configuration program.

6. Press Ctrl+Alt+Del to restart the server.
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Using the IPSSEND command-line program
The IPSSEND command-line program provides a quick way to do the following for
the ServeRAID controller:

v Backup copies of data (see “FlashCopy function (for Windows NT and Windows
2000 only)”)

v Copy ServeRAID controller configurations from one server to another (see
“Server roll-out functions” on page 116)

v Recover from a failed physical drive and rebuild an affected logical drive (see
“Error-recovery functions” on page 118)

v Isolate problems and debug their cause (see “Problem-isolation and debug
functions” on page 119)

v Display or modify a limited set of configuration settings (see “RAID Configuration
functions” on page 122).

Note: If you do not have the IPSSEND program installed, refer to “Installing the
IPSSEND and IPSMON command-line programs” on page 53.

When you run IPSSEND with no parameters, a list of available functions and their
specific parameters appears. The available functions and their parameters are
described in the sections that follow.

To run the IPSSEND program with no parameters:

v If you are using Windows NT 4.0, Windows 2000, or OS/2:
1. Type:

c:\ipsadm\ipssend

where c is the drive letter of the drive where Windows NT 4.0, Windows
2000, or OS/2 is installed.

2. Press Enter.

v If you are using NetWare:

1. From the console, type:
load ipssend

2. Press Enter.

v If you are using Linux, OpenServer, or UnixWare:

1. Type:
/usr/bin/ipssend

2. Press Enter.

v If you are using DOS:

1. Insert the startable IPSSEND diskette into diskette drive A; then type:
a:\ipssend

where a is the drive letter of the diskette drive.

2. Press Enter.

FlashCopy function (for Windows NT and Windows 2000 only)
FlashCopy creates a quick backup copy of data from a source drive to a target
drive at the instant you issue the command. Any changes made to the source drive
after you issue the command are not reflected on the target drive.

You can use the backup copy for tasks such as tape backup and multiserver rollout
(for example, drive cloning). FlashCopy sets up a link between the source and
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target partitions, and then creates a snapshot-like backup of the source data on the
target partition. The target partition is available instantly for read access.

Note: To create the backup copy, the following must be true:
v The size of the target partition must be equal to or larger than that of the

source partition.
v The partition type must be the same on the source and target partitions.

When issuing the FlashCopy function, you must specify either the FlashCopy
backup or FlashCopy nobackup functions to create a backup.

The FlashCopy backup function sets up a link between the source and target
drives. This link creates a backup of the source data on the target drive. After the
link is set up, a background copy operation is immediately initiated to copy all the
data from the source drive to the target drive. After the background copy operation
completes, the link between the source and target drives is dissolved.

The FlashCopy nobackup function also sets up a link between the source and
target drives. Unlike the FlashCopy backup function, after the FlashCopy
nobackup link is set up, no background copy operation immediately takes place.
The background copy operation waits until the data on the source logical drive
changes. When a change to the data on the source drive occurs, the backup of the
source logical drive data gets copied to the target logical drive. Then, the new data
gets written to the source logical drive. This FlashCopy nobackup link exists until
you dissolve the link by issuing a FlashCopy stop.

Note: You have instant read access to the target partition after a FlashCopy
backup or FlashCopy nobackup is issued.

Important
Before using FlashCopy, consider the following:

v Normal I/O functions can be performed on the source partition while the FlashCopy
operation is in progress. If you are performing a FlashCopy backup, do not write to the
target partition until the FlashCopy backup process is complete.

If you are performing a FlashCopy nobackup, do not write to the target partition at all.

v You can have up to four FlashCopy relationships active at a time.

v The source and target drives must be on the same controller.

v There is no limit on source and target partition size.

v When FlashCopy completes, the data on the target partition will be an exact image of the
data on the source partition at the time FlashCopy was issued.

v The target partition must be at least the same size as the source partition. For optimal
space usage, the FlashCopy target partition should be the same size as the source
partition.

v You can use the noprompt option to run some FlashCopy functions without receiving
any interactive prompts.

v Both the source and target drives must be either spanned arrays or non-spanned arrays.

v If the source and target drives are spanned arrays, they must have the same number of
sub-arrays.

v If the source and target drives are part of a spanned array, there can be only one
partition for each logical drive on that spanned array.

The following information shows you how to use the FlashCopy function.
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flashcopy map
Use the flashcopy map function to correlate how the ServeRAID
logical drives map to the operating-system drive partitions.

Supported operating systems: Windows NT, Windows 2000

Command: ipssend flashcopy controller map

where:
v controller is the ServeRAID controller number (1–12)

For example, if you type ipssend flashcopy 2 map, the following
results appear on the screen:

Found 2 IBM ServeRAID Controller(s).

Partition
Number

Partition
Letter

Partition Size Logical
Drive

Array
Letter

Available for
FlashCopy

1 H: 100 1 A No (note 1)

2 I: 100 2 A No (note 1)

3 J: 50 2 A Yes

None None - 3 B No (note 5)

None None - 4 B No (note 5)

Note 1:
This partition is currently in an
active FlashCopy link. See the
table below for details. Use the
STOP command to break this link.
Once the link is broken, you can
reissue the FLASHCOPY BACKUP or
FLASHCOPY NOBACKUP command.

Note 5:
There is no partition defined on
this logical drive.

If a partition is available for FlashCopy, the report states Yes and
there are no notes for that partition. If a partition is not available for
FlashCopy, the report states No with one of the following
explanatory notes:

Note 1
This partition is currently in an active FlashCopy link. See
the table below for details. Use the stop function to break
this link. After the link is broken, you can reissue the
FlashCopy backup or FlashCopy nobackup functions.

Note 2
One or more of the following is true for this partition:
v The partition is the boot partition.
v The partition has open files.
v The partition has a memory-paging file.

You can override these requirements by using the force
option. See the FlashCopy backup and FlashCopy
nobackup functions for more details.
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Note 3
One or more of the following is true for this partition:
v The partition is in the blocked state.
v The partition is not in the okay or critical state.
v The partition is currently synchronizing, rebuilding, or

migrating.

Note 4
FlashCopy can support up to four active links only.

Note 5
There is no partition defined on this logical drive.

flashcopy backup
Use the flashcopy backup function to create a quick snapshot
impression of source partitions on corresponding target partitions.
Once the snapshot is created, the source partitions are ready for
immediate use. When the process completes, each target partition
will contain a copy of its source partition data that existed at the
exact time you issued the flashcopy backup function. A link
between each source partition and target partition will exist until all
the data is copied. Once all the source data is copied to the target
partition (determined by the ipssend getstatus function), the link is
automatically broken, and you can use the flashcopy delete and
flashcopy import functions to move a logical drive to another
server.

You can use the flashcopy map function to determine the partition
numbers and if they are available for the flashcopy backup
process.

Notes:

1. Only one flashcopy backup (involving up to four source and
target partitions) can be active on a controller at a time. If a
flashcopy backup is in progress, you cannot issue another
flashcopy backup or flashcopy nobackup until the previous
flashcopy backup process is completed or until the backup
links are broken. You can use the flashcopy stop function to
break the links between the source and target partitions.

2. For flashcopy backup to function properly, each target partition
must have the same partition type as its source partition.

3. Do not attempt to write to the target partitions until the backup
process is completed.

Supported operating systems: Windows NT, Windows 2000

Command: ipssend flashcopy controller backup [source target]
options

Note: The symbols [ ] above mean that the parameters are
repeatable. The maximum number of repetitions is 4.

where:
v controller is the ServeRAID controller number (1–12)
v source is the source partition number
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Note: Use the flashcopy map function to correlate the
ServeRAID logical drive number to the operating system
drive partition number.

v target is the target partition number

Note: Use the flashcopy map function to correlate the
ServeRAID logical drive number to the operating system
drive partition number.

v options is an optional parameter that includes the following:

– POLL displays the progress of the backup function.

– FORCE creates a flashcopy of a source partition that is the
boot partition, contains open files, or contains a memory
paging file.

Note: Using the FORCE option will not guarantee file
consistency between the source and target partitions.

– NOPROMPT overrides the user prompt.

flashcopy nobackup
Use the flashcopy nobackup function to create a quick snapshot
impression of the source partition data on its target partition. Once
the snapshot is created, the source partitions are ready for
immediate use. Each target partition will contain a snapshot of its
source partition data that existed at the exact time you issued the
command. A link between each source partition and its target
partition will exist until you issue the flashcopy stop function. Once
you issue the flashcopy stop function, each target partition
contents are no longer valid. The flashcopy nobackup function is
useful if you want a snapshot of your data to perform a tape
backup.

You can use the flashcopy map function to determine the partition
numbers and if they are available for the flashcopy nobackup
function process.

Notes:

1. Only one flashcopy nobackup link (involving up to four source
and target partitions) can exist on a ServeRAID controller. If a
flashcopy nobackup function is invoked, you cannot issue
another flashcopy backup or flashcopy nobackup function
until existing nobackup links are broken. You can use the
flashcopy stop function to break the links between the source
and target partitions.

2. For the flashcopy nobackup function to operate properly, each
target partition must have the same partition type as its source
partition.

3. Do not attempt to write to the target partition until the nobackup
link is broken.

Supported operating systems: Windows NT, Windows 2000

Command: ipssend flashcopy controller nobackup [source target]
options

Note: The symbols [ ] above mean that the parameters are
repeatable. The maximum number of repetitions is 4.
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where:
v controller is the ServeRAID controller number (1–12)
v source is the source partition number

Note: Use the flashcopy map function to correlate the
ServeRAID logical drive number to the operating system
drive partition number.

v target is the target partition number

Note: Use the flashcopy map function to correlate the
ServeRAID logical drive number to the operating system
drive partition number.

v options is an optional parameter that includes the following:

– FORCE creates a flashcopy of a source partition that is the
boot partition, contains open files, or contains a memory
paging file.

Note: Using the FORCE option will not guarantee file
consistency between the source and target partitions.

– NOPROMPT overrides the user prompt.

flashcopy stop all
Use the flashcopy stop function to break the link between the
source partitions and target partitions. Once you issue the
flashcopy stop function, the target partition contents are no longer
valid. After you issue the flashcopy stop function, reformat your
target partition.

Supported operating systems: Windows NT, Windows 2000

Command: ipssend flashcopy controller stop all [noprompt]

where:
v controller is the ServeRAID controller number (1–12)
v noprompt is an optional parameter to override the user-prompt.

flashcopy delete
Use the flashcopy delete function to delete an array. This is useful
when you have used the flashcopy backup function and you want
to move the target array to another server. After you delete the
array, you can move the drives to the other server; then, you can
issue the flashcopy import function to add the array to the existing
configuration of the other server.

You can use the ServeRAID Manager program to identify the array
you want to delete. This program can blink the LEDs for the drives
that belong to the specific array.

Important
If your target logical drive is configured with write-back cache enabled, wait 10 minutes after
the flashcopy backup completes before issuing a flashcopy delete function. This ensures
that all data has been moved from the controller cache to the logical drive.

Supported operating systems: Windows NT, Windows 2000

Note: The flashcopy delete function is not available in a cluster
configuration.
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Command: ipssend flashcopy controller delete arrayID
[noprompt]

where:
v controller is the ServeRAID controller number (1–12)
v arrayID is the Array ID (A–H)

Note: If the array is a spanned array, arrayID is the array ID
(1–8).

v noprompt is an optional parameter to override the user-prompt.

flashcopy import
Use the flashcopy import function to merge logical drive
information from new physical drives when they are added to the
server. You can use this function to incorporate a target array after
a flashcopy backup function is completed.

Notes:

1. The stripe-unit size of the logical drives being imported must be
the same as the stripe-unit size of the logical drives on the new
controller.

2. The number of physical drives you add must be equal to the
number of physical drives that were in the original defined
logical drive.

3. The physical drives must be added while the server is powered
on.

4. When a logical drive is imported, all partitions from that logical
drive are also imported automatically. You cannot import a
single partition selectively.

5. You must manually assign drive letters after the import
completes.

Supported operating systems: Windows NT, Windows 2000

Note: The flashcopy import function is not available in a cluster
configuration.

Command: ipssend flashcopy controller import options

where:
v controller is the ServeRAID controller number (1–12)
v options is one of the following:

– ALL to specify all logical drives
– n to specify a valid logical drive number (1–8)

Server roll-out functions
The IPSSEND server roll-out functions include the following:

autosync Use the autosync function to synchronize a new logical drive. Use
this function only on RAID level-5 logical drives. This function starts
a background synchronization so you can use the logical drive
immediately.

Supported operating systems: Windows NT, Windows 2000, OS/2,
NetWare, Linux, OpenServer, UnixWare and DOS

Command: ipssend autosync controller logicaldrive [noprompt]
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where:
v controller is the ServeRAID controller number (1–12)
v logicaldrive is the logical drive number (1–8)
v noprompt is an optional parameter that overrides the user

prompt

backup Use the backup function to save a ServeRAID controller
configuration and BIOS settings to a diskette or to a physical drive.
The ServeRAID controller configuration must be valid.

Supported operating systems: Windows NT, Windows 2000, OS/2,
NetWare, Linux, OpenServer, UnixWare and DOS

Command: ipssend backup controller filename [noprompt]

where:
v controller is the ServeRAID controller number (1–12)
v filename is the path and file name where the configuration is to

be written
v noprompt is an optional parameter that overrides the user

prompt.

copyld Use the copyld function to copy a source logical drive to a target
logical drive. The size of the target logical drive must be greater
than or equal to the size of the source logical drive.

Supported operating system: DOS

Command: ipssend copyld controller source target [noprompt]

where:
v controller is the ServeRAID controller number (1–12)
v source is the source logical drive number
v target is the target logical drive number
v noprompt is an optional parameter that overrides the user

prompt.

init Use the init function to initialize the first 0.5 MB of a logical drive.
This process will erase the partition tables and all data on the disk.

Supported operating systems: Windows NT, Windows 2000, OS/2,
NetWare, Linux, OpenServer, UnixWare, and DOS

Command: ipssend init controller drivenum [noprompt]

where:
v controller is the ServeRAID controller number (1–12)
v drivenum is the logical drive number (1–8)
v noprompt is an optional parameter that overrides the user

prompt.

restore Use the restore function to load a configuration from a file stored
on a diskette or a hard disk. The configuration must be a valid
configuration file from the backup option in IPSSEND. This
operation overwrites the existing configuration information and BIOS
settings stored for the ServeRAID controller.

Supported operating systems: Windows NT, Windows 2000, OS/2,
NetWare, Linux, OpenServer, UnixWare, and DOS

Command: ipssend restore controller filename [noprompt]

where:
v controller is the ServeRAID controller number (1–12)
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v filename is the path and file name where the configuration is to
be written

v noprompt is an optional parameter that overrides the user
prompt.

synch Use the synch function to synchronize the parity information on
redundant logical drives. If the parity information is inconsistent, the
IPSSEND program will repair it automatically.

Supported operating systems: Windows NT, Windows 2000, OS/2,
NetWare, Linux, OpenServer, UnixWare, and DOS

Command: ipssend synch controller drive drivenum

where:
v controller is the ServeRAID controller number (1–12)
v drive indicates the number of logical drives:

– DRIVE is a single logical drive
– GROUP is a Merge Group

v drivenum specifies the scope item:
– If DRIVE, specifies the logical drive number (1–8)
– If GROUP, specifies the Merge Group number

Error-recovery functions
The IPSSEND error-recovery functions include the following:

getstatus Use the getstatus function to display the current logical-drive status
for the most recent rebuild, synchronization, or logical-drive
migration. The status includes such information as the remaining
size of the logical drive, the percentage completed for the function
in process, and information about the most recently completed
logical-drive function.

Supported operating systems: Windows NT, Windows 2000, OS/2,
NetWare, Linux, OpenServer, UnixWare, and DOS

Command: ipssend getstatus controller

where:
controller is the ServeRAID controller number (1–12)

rebuild Use the rebuild function to rebuild a designated disk drive. This
function is valid for disk arrays that contain one or more logical
drives that are in the critical state. Progress is indicated during the
rebuild operation, but you can also use the getstatus function to
obtain progress information about the rebuild.

Supported operating systems: Windows NT, Windows 2000, OS/2,
NetWare, Linux, OpenServer, UnixWare, and DOS

Command: ipssend rebuild controller dch dsid nch nsid

where:
v controller is the ServeRAID controller number (1–12)
v dch is the channel number for the defunct drive (1–4)
v dsid is the SCSI ID for the defunct drive (0–15)
v nch is the channel number for the new drive (1–4)
v nsid is the SCSI ID for the new drive (0–15)

setstate Use the setstate function to change the state of a physical device
from its current state to a new state.
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Attention: You must be very careful when you use this function.
For example, you might lose data if you reset a defunct device to
online without first performing a rebuild operation.

Supported operating systems: Windows NT, Windows 2000, OS/2,
NetWare, Linux, OpenServer, UnixWare, and DOS

Command: ipssend setstate controller channel sid nstate

where:
v controller is the ServeRAID controller number (1–12)
v channel is the channel number for the drive (1–4)
v sid is the SCSI ID for the drive (0–15)
v nstate is the new state for the drive. Valid states are:

– EMP for Empty
– RDY for Ready
– HSP for Hot spare
– SHS for Standby hot spare
– DDD for Defunct disk drive
– DHS for Defunct hot spare
– RBL for Rebuild
– SBY for Standby
– ONL for Online.

unblock Use the unblock function to gain access to a blocked logical drive.
RAID level-0 logical drives become blocked if they are in an array
that contains RAID level-1 or level-5 logical drives and the array is
being rebuilt. Because the RAID level-0 logical drives cannot be
rebuilt, the data stored on the RAID level-0 logical drives is
damaged and should not be accessed. After you issue the unblock
function, you must re-create or restore the data previously stored
on the RAID level-0 logical drives.

Supported operating systems: Windows NT, Windows 2000, OS/2,
NetWare, Linux, OpenServer, UnixWare, and DOS

Command: ipssend unblock controller drivenum

where:
v controller is the ServeRAID controller number (1–12)
v drivenum is the logical drive number (1–8)

Problem-isolation and debug functions
The IPSSEND problem-isolation and debug functions include the following:

certify Use the certify function to verify the media of a physical drive.
When the program finds a media error, it reassigns the sectors. A
summary of reassignments and PFA errors appears upon
completion of the verification.

Supported operating system: DOS

Command: ipssend certify controller channel sid

where:
v controller is the ServeRAID controller number (1–12)
v channel is the channel number for the device (1, 2, 3, or 4)
v sid is the SCSI ID for the device (0–15)

eraseevent Use the eraseevent function to clear all logged entries in the
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designated event log. See getevent help for information about the
contents of the device event log and the controller soft and hard
event logs.

Supported operating systems: Windows NT, Windows 2000, OS/2,
NetWare, Linux, OpenServer, UnixWare, and DOS

Command: ipssend eraseevent controller options

where:
v controller is the ServeRAID controller number (1–12)
v options is the designated event log:

– DEVICE for the device event log
– SOFT for the ServeRAID controller soft event log
– HARD for the ServeRAID controller hard event log

getbst Use the getbst function to display the number of bad stripes in the
bad stripe table for each logical drive.

Supported operating systems: Windows NT, Windows 2000, OS/2,
NetWare, Linux, OpenServer, Unixware, and DOS

Command: ipssend getbst controller

where:

controller is the ServeRAID controller number (1–12)

format Use the format function to perform a low-level format of a physical
drive.

Attention:

1. When you issue this function, all data on the disk will be lost.

2. After a format function is issued, do not stop it. If a format
process is stopped for any reason, the hard disk that was being
formatted will not respond to any functions except the format
function. Thus, the ServeRAID controller will not be able to
recognize functions anymore. To recover the drive, refer to
“Recovering from an incomplete format of a physical drive” on
page 137.

Supported operating system: DOS

Command: ipssend format controller channel sid

where:
v controller is the ServeRAID controller number (1–12)
v channel is the channel number for the device (1, 2, 3, or 4)
v sid is the SCSI ID for the device (0–15)

getevent Use the getevent function to display information about various
unexpected events. IBM uses the soft and hard event logs for
development and debugging purposes only. The device event log
contains event counters for each attached physical device. These
counters include:

v Parity: An unexpected event occurred while data was being
transferred on the SCSI bus. This usually indicates a problem
with the SCSI cable, connectors, or terminators.

v Soft: A SCSI device detected a check-condition event.
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v Hard: The SCSI controller detected an unexpected event. The
controller is the most likely cause.

v Misc: The ServeRAID controller detected an event that was most
likely caused by the device.

The device event log also provides Predictive Failure Analysis
(PFA) alerts, which indicate that the device has signaled the
ServeRAID controller that it might fail in the near future.

Supported operating systems: Windows NT, Windows 2000, OS/2,
NetWare, Linux, OpenServer, UnixWare, and DOS

Command: ipssend getevent controller options

where:
v controller is the ServeRAID controller number (1–12)
v options is the designated event log:

– DEVICE for the device event log
– SOFT for the ServeRAID controller soft event log
– HARD for the ServeRAID controller hard event log

selftest The selftest function is used to direct a controller or a device to
perform its self-test.

Supported operating systems: DOS

Command: ipssend selftest controller options

where:
v controller is the ServeRAID controller number (1–12)
v options is the designated self-test:

– AD for the ServeRAID controller self-test
– PD channel sid for the device self-test

Note: channel represents the drive channel (1–4), and sid is
the SCSI ID for the device (0–15).

startdely Use the startdely function to set the number of drives in a group to
start up simultaneously and to set the delay in seconds between
the startup of these groups of drives.

Supported operating systems: DOS

Command: ipssend startdely controller options

where:
v controller is the ServeRAID controller number (1–12)
v options is one of the following:

– ? displays the concurrent drive startup count and the delay
time.

– A number (1–16) that specifies the new concurrent drive
startup count.

– A number (1–16) that specifies the new concurrent drive
startup count and a number (3–15) that specifies the startup
delay time, in seconds.
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RAID Configuration functions
The IPSSEND RAID configuration functions include the following:

devinfo Use the devinfo function to retrieve information (such as size and
state) about a specific device.

Supported operating systems: Windows NT, Windows 2000, OS/2,
NetWare, Linux, OpenServer, UnixWare, and DOS

Command: ipssend devinfo controller channel sid

where:
v controller is the ServeRAID controller number (1–12)
v channel is the channel number for the device (1, 2, 3, or 4)
v sid is the SCSI ID for the device (0–15)

drivever Use the drivever function to display the vendor ID, microcode
version, and serial number of a SCSI device. The IPSSEND
program retrieves this information directly from the device.

Supported operating systems: Windows NT, Windows 2000, OS/2,
NetWare, Linux, OpenServer, UnixWare, and DOS

Command: ipssend drivever controller channel sid

where:
v controller is the ServeRAID controller number (1–12)
v channel is the channel number for the device (1, 2, 3, or 4)
v sid is the SCSI ID for the device (0–15)

getconfig Use the getconfig function to display the ServeRAID controller
configuration information. This includes information about the
firmware version; initiator ID and rebuild rate; logical-drive status,
RAID level, and size; and physical device type, SCSI ID, and PFA
error.

Supported operating systems: Windows NT, Windows 2000, OS/2,
NetWare, Linux, OpenServer, UnixWare, and DOS

Command: ipssend getconfig controller options

where:
v controller is the ServeRAID controller number (1–12)
v options is one of the following:

– AD for the controller information
– LD for the logical drive information
– PD for the physical device information
– AL for all information. This is the default option.

hsrebuild Use the hsrebuild function to turn on the ServeRAID controller
hot-swap rebuild feature or display the current status of the
hot-swap rebuild feature.

Supported operating systems: Windows NT, Windows 2000, OS/2,
NetWare, Linux, OpenServer, UnixWare, and DOS

Command: ipssend hsrebuild controller options

where:
v controller is the ServeRAID controller number (1–12)
v options is one of the following:

– ON enables the hot-swap feature
– ? displays the status of the hot-swap rebuild feature.

122 IBM
®

Netfinity
®

User’s Reference: ServeRAID™-4H Ultra160 SCSI Controller



readahead Use the readahead function to enable, disable, or set the adaptive
mode for the read-ahead feature of the ServeRAID controller.

Supported operating systems: Windows NT and DOS

Command: ipssend readahead controller options

where:
v controller is the ServeRAID controller number (1–12)
v options is one of the following:

– ON enables the read-ahead feature
– OFF disables the read-ahead feature
– ADAPTIVE indicates that the controller will determine the best

mode to use at any given time.
– ? displays the current read-ahead feature mode being used.

stripesize Use the stripesize function to set the size of the ServeRAID
controller stripe to 8 KB, 16 KB, 32 KB, or 64 KB.

Supported operating systems: DOS

Command: ipssend stripesize controller options

where:
v controller is the ServeRAID controller number (1–12)
v options is one of the following:

– 8 to set the stripe-unit size to 8 KB
– 16 to set the stripe-unit size to 16 KB
– 32 to set the stripe-unit size to 32 KB
– 64 to set the stripe-unit size to 64 KB
– ? to display the current stripe-unit size being used.

unattended Use the unattended function to enable or disable the unattended
feature of the ServeRAID controllers.

Supported operating systems: Windows NT, Windows 2000, OS/2,
NetWare, Linux, OpenServer, Unixware, and DOS

Command: ipssend unattended controller options

where:
v controller is the ServeRAID controller number (1–12)
v options is one of the following:

– ON to enable the feature
– OFF to disable the feature
– ? to display the current setting of this feature.

Using the IPSMON command-line program (NetWare only)
The IPSMON command-line program provides a quick way to monitor ServeRAID
controllers for specific conditions. The IPSMON program is available for Novell
NetWare only.

To run the IPSMON program:

1. From the console, type:
load ipsmon

2. Press Enter.

When you start IPSMON, it immediately begins polling all ServeRAID controllers for
specific conditions. If a condition being monitored is found, this program logs a
message to the screen, to a file, or to both the screen and a file.
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Note: IPSMON continuously polls the ServeRAID controllers until you type
unload ipsmon at the system console.

Supported operating systems: NetWare

Command: ipsmon options

where:

v options is one of the following optional parameters:
– -F:filename to specify the name of the file in which to record messages. The

default file name is IPSMON.LOG.
– -S to display messages on the standard output (usually the monitor)
– -? to obtain a current list of valid parameters

Note: If you start this program without any command-line parameters, the
IPSMON program will log the messages to the IPSMON.LOG file, and the
messages will not appear on the screen.

During operation, IPSMON logs various messages. Each message contains an alert
code and a location specifier.

v The alert code begins with the message type and number; for example, INF,
WRN, or CRT (followed by the message number).

v The location specifier comes after the alert code:

A followed by the controller number

SID followed by the SCSI ID (if required)

C followed by the channel number (if required)

For example, a message of CRTxxx:A2C3SID04 signifies that a Critical condition
(CRTxxx) was found on Controller 2 (A2), Channel 3 (C3), SCSI ID 4 (SID04).

The IPSMON program can log the following messages, based on the required
condition.

Information Messages:
<Date and Time> INF000:A1C-SID-- no errors detected
<Date and Time> INF001:A1C-SID-- rebuild started
<Date and Time> INF002:A1C-SID-- rebuild completed
<Date and Time> INF003:A1C-SID-- synchronization started
<Date and Time> INF004:A1C-SID-- synchronization completed
<Date and Time> INF005:A1C-SID-- migration started
<Date and Time> INF006:A1C-SID-- migration completed

Warning Messages:
<Date and Time> WRN001:A2C3SID12 PFA Error detected

Critical Messages:
<Date and Time> CRT001:A3C2SID04 dead drive detected
<Date and Time> CRT002:A1C-SID-- not responding to commands
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Chapter 12. Solving ServeRAID problems

This section describes the ServeRAID text and numeric messages that might
appear during startup. This section also includes some basic information about
rebuilding a defunct drive.

In addition to the information provided in this section, you might want to use the
ServeRAID IPSSEND program to help isolate ServeRAID problems. See “Using the
IPSSEND command-line program” on page 110 and “Problem-isolation and debug
functions” on page 119 for information about using the IPSSEND program.

ServeRAID Manager fails to start (Windows NT and Windows 2000
only)

If you start a server with the IBM ServeRAID Support CD in the CD-ROM drive and
the ServeRAID Manager does not start, you must reduce the number of FAT
partitions with assigned drive letters on the server.

For the startable (boot) IBM ServeRAID Support CD to work on a server that has
Windows NT or Windows 2000 installed on it, the server cannot have more than 22
FAT partitions with assigned drive letters.

ServeRAID controller messages
This section lists the ServeRAID messages that might appear during system
startup.

The ServeRAID controllers provide a Device Event Log that collects statistics on the
number and types of events that occur on a selected physical drive. After correcting
a problem with the disk array, clear the log so that you can identify any subsequent
errors quickly. For information about clearing the event log, see “eraseevent” on
page 119.

All physical drives contain unique identifiers, such as the drive serial number and
manufacturer. During configuration, the ServeRAID controller stores this information.

Following are messages associated with the ServeRAID subsystem in alphabetical
order.

Message Explanation Action

A new drive was
installed.

When the ServeRAID controller
detects a new drive that is not part
of the current configuration, the
following message appears:

x new Ready drives found where x
is the number of Ready drives
found.

This is an information message. No action is required.

Auto rearrange. Auto rearrange is enabled or
disabled.

This is an information message. No action is required.

Battery-backup
cache not
responding

BIOS code detected a bad or failed
battery-backup cache.

Press F9 to remove the battery-backup cache from the
configuration, or press F10 to exit without change.
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Message Explanation Action

Battery-backup
cache
replacement

The ServeRAID controller detects
that the battery-backup cache is
defective.

Press F8 if you replaced the battery-backup cache, or press
F10 if you have not replaced the battery-backup cache.

Configured drives
are missing.

When the ServeRAID controller
detects that a previously configured
drive is missing, the following
message appears:

x Online drives not responding
where x is the number of drives not
responding.

Example of a possible message:

Online Drive on Channel 3 SCSI
ID 3 is not responding.

Press one of the following keys:

F2 Detailed description. Press this key for a detailed
description of the problem, such as the example
message above.

F4 Retry. Press this key after correcting a problem. For
example, press F4 after you turn on the external
storage enclosure that contains the physical drive.

F5 Change the configuration and set the drives to
defunct. Press this key to accept the new state that
the ServeRAID controller will assign to the drive.
For example, the ServeRAID controller will assign
the drive a state of defunct or empty.

You can also press F5 when you must remove a
drive. RAID level-1 and RAID level-5 logical drives
are present, and performance in a degraded mode
is acceptable. The ServeRAID controller will assign
the drive a state of defunct, but the server can
complete startup. However, the array will remain in
Critical mode and the potential for data loss will
exist until you replace and rebuild the defunct drive.
To prevent the loss of data, replace and rebuild the
defunct drive in a timely manner.
Note: A physical drive in the defunct state does not
necessarily mean that you need to replace the
drive. Before you replace the drive, ensure that:

1. All cables are connected properly to the
backplane and to the physical drive. Also,
ensure that all cables inside the server are
connected properly.

2. The hot-swap drive trays are seated properly in
the drive bay.

3. If you are certain the physical drive is not
defective, try rebuilding the drive if you have not
already done so. See “Rebuilding a defunct
drive” on page 136 for more information.

After you perform these steps, if the physical drive
does not function properly, replace the drive.

F10 Continue starting without changing the
configuration. Press this key to continue without
change to the configuration.
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Message Explanation Action

Configured drives
are not in the
configured
location.

When the ServeRAID controller
detects that a previously configured
drive is present, but the drive is in
a new location, the following
message appears:

x Online drive has been rearranged
where x is the number of drives
that have been rearranged.

For example:

Examples of possible messages
are:

Online Drive on Channel 3 SCSI
ID 4 moved to Channel 3 SCSI
ID 3
Online Drive on Channel 3 SCSI
ID 3 moved to Channel 3 SCSI
ID 4

Press one of the following keys:

F2 Detailed description. Press this key for a detailed
description of the problem, such as the example
messages above.

F4 Retry. Press this key after correcting a problem. For
example, press F4 after you move the physical drive
to its previously assigned location.

F5 Change the configuration and set the drive to
defunct. Press this key to accept the new state that
the ServeRAID controller will assign to the drive.
For example, the ServeRAID controller will assign
the drive a state of defunct or empty.
Note: A physical drive in the defunct state does not
necessarily mean that you need to replace the
drive. Before you replace the drive, ensure that:

1. All cables are connected properly to the
backplane and to the physical drive. Also,
ensure that all cables inside the server are
connected properly.

2. The hot-swap drive trays are seated properly in
the drive bay.

3. If you have not already attempted to rebuild the
drive, try rebuilding it. See “Rebuilding a defunct
drive” on page 136 for more information.

After you perform these steps, if the physical drive
does not function properly, replace the drive.

F6 Change the configuration and accept the
rearrangement. Press this key to change the
configuration to match the current drive location.

You might remove the hot-swap drives from the
server for security or maintenance reasons. If you
replace the drives but install them in different drive
bays, you can press F6 to accept the new locations,
and the ServeRAID controller will update the
configuration.

F10 Continue startup without changing the configuration.
Press this key to continue without change to the
configuration.

Controller is not
responding to
commands. No
logical drives are
installed.

The ServeRAID controller is not
operational.

Have the system serviced.

Error: Cannot
disable this
controller BIOS.

The ServeRAID controller was
unable to prevent an extra copy of
its BIOS code from being stored on
the server. This condition occurs
when the server contains multiple
ServeRAID controllers.

Have the system serviced.
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Message Explanation Action

Installation
stopped.

The server cannot access the
ServeRAID controller.

This is a follow-on message to a preceding message. Follow
the Action instructions for the preceding message to resolve
the problem.
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Message Explanation Action

New controller
installed in a
configured server
or drives are
imported.

When the ServeRAID controller
detects that the identifiers of the
drives do not match the controller
configuration information, the
following message appears:

x Online drive(s) found with
mismatch configuration

Examples of possible messages:

Configuration mismatch Channel
1 SCSI ID 0 with Host ID
Configuration mismatch Channel
2 SCSI ID 0 with Host ID

Press one of the following keys:

F2 Detailed description. Press this key for a detailed
description of the problem, such as the example
messages above.

F4 Retry. Press this key after correcting the problem.
For example, press F4 after you move the physical
drive to its previously assigned location, or after you
install the original physical drives back in the server.

F5 Change the configuration and set the drive to
defunct. Press this key to accept the new state that
the ServeRAID controller will assign to the drive.
For example, the ServeRAID controller will assign
the drive a state of defunct or empty.
Note: A physical drive in the defunct state does not
necessarily mean that you need to replace the
drive. Before you replace the drive, ensure that:

1. All cables are connected properly to the
backplane or system board, and to the physical
drive. Also, ensure that all cables inside the
server are connected properly.

2. The hot-swap drive trays are seated properly in
the drive bay.

3. If you have not already attempted to rebuild the
drive, try rebuilding it. See “Rebuilding a defunct
drive” on page 136 for more information.

After you perform these steps, if the physical drive
does not function properly, replace the drive.

F7 Import configuration information from drive. Press
this key to restart the server. Press this key to
import the configuration information from the drive
and to update the configuration information for the
ServeRAID controller. This choice is useful when
you replace the ServeRAID controller in an existing
ServeRAID subsystem.

You also might press F7 if you replace a whole set
of drives with drives that were configured in another
server with a ServeRAID controller.
Note: When you install drives in a server that has
no logical drives defined, the F7 choice will not
appear. The ServeRAID controller does not contain
any logical drives in its factory configuration.
Therefore, F7 will not appear. In this case, do the
following:

1. Restart the server and press Ctrl+I to enter the
Mini-Configuration program (see “Using the
ServeRAID Mini-Configuration program” on
page 107).

2. Select Advanced Functions.

3. Select Copy the Configuration from Drives to
the Controller and follow the instructions on the
screen.
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Message Explanation Action

Recoverable
configuration error

The configuration data stored in
NVRAM does not match the
configuration data stored in the
EEPROM.

1. Press Ctrl+I to access the ServeRAID Mini-Configuration
menu. (See “Using the ServeRAID Mini-Configuration
program” on page 107 for instructions.)

2. Select Advanced Functions from the Main Menu.

3. Then, select Copy the Configuration from Drives to
the Controller. (See “Using the advanced configuration
functions” on page 108 for more information.)

Unrecoverable
configuration error

The configuration data stored in
NVRAM does not match the
configuration data stored in the
EEPROM.

1. Press Ctrl+I to access the ServeRAID Mini-Configuration
menu. (See “Using the ServeRAID Mini-Configuration
program” on page 107 for instructions.)

2. Select Advanced Functions from the Main Menu.

3. Then, select Restore to the Factory Default Settings.
(See “Using the advanced configuration functions” on
page 108 for more information.)

Note: Restoring to factory default settings sets all online
drives in array to ready. You must import the configuration
from the drives or diskette. Otherwise, you must create a
new array, install the operating system, and restore data
from backup.

WARNING: n
logical drives are
critical; n logical
drives are offline.

One or more physical drives have
failed.

Replace the defunct drives as soon as possible to prevent
data loss.

Your server has
an error due to a
Blocked Logical
Drive.

One or more logical drives are
blocked. A blocked logical drive
cannot be accessed. See “Logical
drive state descriptions” on page 11
for additional information.

Press F4 to unblock the logical drive, or press F5 to continue
without unblocking.

ServeRAID startup (POST) messages
During power-on self-test (POST), the ServeRAID controller compares the stored
configuration information to the configuration that is actually present. If a
discrepancy exists, one or more status messages appear after POST completes,
but before the operating system loads.

Notes:

1. When the ServeRAID controller requires your input, a list of function keys will
appear below the message.

2. Where the Action information tells you to start the IBM ServeRAID configuration
program, insert the IBM ServeRAID Support CD into the CD-ROM drive; then,
restart the server. The Action column also provides general information about
the message.

3. Where sid or ch appears in these messages, sid is the SCSI ID for the device,
and ch is the channel to which the device is attached.

4. Where m or n appears in these messages, a number will appear in the actual
message.
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ServeRAID ISPR, BCS, and ECS POST error codes
After the ServeRAID POST completes, register information appears on the screen
in hexadecimal format, as follows:

Hardware: ISPR=aaaa BCS=bb ECS=cc

ISPR displays the four-digit Interrupt Status Report Register code, BCS displays the
Basic Configuration Status Register code, and ECS displays the Extended
Configuration Status Register code.

For example:
Controller 1 Slot 5, Status:Not responding properly - Error Code=0B0
Controller 2 Slot 4, Logical Drive=0, Other=0, Firmware=2.88.10, Status=Ok
Controller 3 Slot 3, Logical Drive=0, Other=0, Firmware=3.60.13, Status=Ok
Controller 4 Slot 2, Logical Drive=1, Other=1, Firmware=1.00.09, Status=Ok

If no errors occur:

ISPR (aaaa) = EF10

BCS (bb) = 0F or 09

ECS (cc) = 00

If an error occurs, refer to: “ISPR (Interrupt Status Port Register) codes” for the
ISPR error codes and “Basic and Extended Configuration Status Register Codes”
on page 132 for the BCS and ECS error codes.

ISPR (Interrupt Status Port Register) codes

Code Explanation Action

1xxx to
7xxx

The POST detected an internal error. Have the system serviced.

2601 to
260B

The POST detected an error with the
ServeRAID subsystem.

Have the system serviced.

2610 The POST detected an error with the
ServeRAID controller hardware.

Have the system serviced.

2620 The POST detected that a ServeRAID
configuration or hard disk error
occurred.

Start the IBM ServeRAID Support CD
and view the existing device and
configuration information for your
ServeRAID subsystem. If you cannot
locate and correct the configuration
problem or the failing device, or if the
problem persists, have the system
serviced.

8xxx to
Bxxx

The POST detected an error with the
SCSI interface.

Verify that the SCSI cables are correctly
connected and the SCSI termination is
set properly for each installed SCSI
device.

If you cannot locate and correct the
SCSI problem, or if the problem
persists, have the system serviced.
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Basic and Extended Configuration Status Register Codes

BCS ECS Explanation and possible recovery action

Code
not in
table

Code
not in
table

Explanation:The ServeRAID controller is not functioning properly.

Action:Have the system serviced.

00 01 Explanation:Invalid flash configuration.

Action:Start the IBM ServeRAID Support CD and follow the instructions that appear on the
screen.

If no instructions appear or if the problem persists, have the system serviced.

00 02 Explanation:Invalid NVRAM configuration.

Action:Start the IBM ServeRAID Support CD and follow the instructions that appear on the
screen.

If no instructions appear or if the problem persists, have the system serviced.

00 03 Explanation:Invalid flash and NVRAM configuration.

Action:Start the IBM ServeRAID Support CD and follow the instructions that appear on the
screen.

If no instructions appear or if the problem persists, have the system serviced.

01 08 Explanation:No configuration was found in drives, or Online/Rebuild drives are not responding.

Action:Press F4, F5, F7, or F10.

01 18 Explanation:No configuration was found in drives, or Online/Rebuild and Hot-Spare/Standby
Hot-Spare drives are not responding.

Action:Press F4, F5, F7, or F10.

01 28 Explanation:No configuration was found in drives, or Online/Rebuild and Ready/Standby drives
are not responding.

Action:Press F4, F5, F7, or F10.

01 38 Explanation:No configuration was found in drives, or Online/Rebuild, Hot-Spare/Standby
Hot-Spare, and Ready/Standby drives are not responding.

Action:Press F4, F5, F7, or F10.

01 48 Explanation:No configuration was found in drives, or Online/Rebuild drives are not responding
and unidentified drives were found.

Action:Press F4, F5, F7, or F10.

01 58 Explanation:No configuration was found in drives, or Online/Rebuild and Hot-Spare/Standby
Hot-Spare drives are not responding and unidentified drives were found.

Action:Press F4, F5, F7, or F10.

01 68 Explanation:No configuration was found in drives, or Online/Rebuild and Ready/Standby drives
are not responding and unidentified drives were found.

Action:Press F4, F5, F7, or F10.

01 78 Explanation:No configuration was found in drives, or Online/Rebuild, Hot-Spare/Standby
Hot-Spare, and Ready/Standby drives are not responding and unidentified drives were found.

Action:Press F4, F5, F7, or F10.
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BCS ECS Explanation and possible recovery action

03 88 Explanation:A drive was imported from another system and it has valid configuration, and
Online/Rebuild drives are not responding.

Action:Press F4, F5, F7, or F10.

03 98 Explanation:A drive was imported from another system and it has valid configuration, and
Online/Rebuild and Hot Spare/Standby Hot-Spare drives are not responding.

Action:Press F4, F5, F7, or F10.

03 A8 Explanation:A drive was imported from another system and it has valid configuration, and
Online/Rebuild and Ready/Standby drives are not responding.

Action:Press F4, F5, F7, or F10.

03 B8 Explanation:A drive was imported from another system and it has valid configuration, and
Online/Rebuild, Hot-Spare/Standby Hot-Spare, and Ready/Standby drives are not responding.

Action:Press F4, F5, F7, or F10.

03 C8 Explanation:A drive was imported from another system and it has valid configuration, and
Online/Rebuild drives are not responding and unidentified drives were found.

Action:Press F4, F5, F7, or F10.

03 D8 Explanation:A drive was imported from another system and it has valid configuration, and
Online/Rebuild and Hot-Spare/Standby Hot-Spare drives are not responding and unidentified
drives were found.

Action:Press F4, F5, F7, or F10.

03 E8 Explanation:A drive was imported from another system and it has valid configuration, and
Online/Rebuild and Ready/Standby drives are not responding and unidentified drives were found.

Action:Press F4, F5, F7, or F10.

03 F8 Explanation:A drive was imported from another system and it has valid configuration, and
Online/Rebuild, Hot-Spare/Standby Hot-Spare, and Ready/Standby drives are not responding
and unidentified drives were found.

Action:Press F4, F5, F7, or F10.

07 00 Explanation:The specified drive is not responding:

(Channel: sid) (x : y)

where x is the channel and y is the ID of the drive that is not responding.

Action: Press F4 or F10. When you warm-start the server, if a ″Configuration change error″
displays, select F4. Do not select F10. If you do select F10, contact the IBM Personal Computer
HelpCenter.

To correct the problem:

1. Download and install the latest version of IBM ServeRAID software. See “Obtaining
ServeRAID updates” on page 13 for more information.

2. Replace the failed physical drive.

07 08 Explanation:Online/Rebuild drives are not responding.

Action:Press F4, F5, or F10.

07 0C Explanation:Online/Rebuild drives are not responding, and a drive was found at the incorrect
SCSI ID.

Action:Press F4, F5, F6, or F10.
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BCS ECS Explanation and possible recovery action

07 18 Explanation:Online/Rebuild and Hot-Spare/Standby Hot-Spare drives are not responding.

Action:Press F4, F5, or F10.

07 1C Explanation:Online/Rebuild and Hot Spare/Standby Hot-Spare drives are not responding, and a
drive was found at the incorrect SCSI ID.

Action:Press F4, F5, F6, or F10.

07 28 Explanation:Online/Rebuild and Ready/Standby drives are not responding.

Action:Press F4, F5, or F10.

07 2C Explanation:Online/Rebuild and Ready/Standby drives are not responding, and a drive was
found at the incorrect SCSI ID.

Action:Press F4, F5, F6, or F10.

07 38 Explanation:Online/Rebuild, Ready/Standby, and Hot-Spare/Standby Hot-Spare drives are not
responding.

Action:Press F4, F5, or F10.

07 3C Explanation:Online/Rebuild, Ready/Standby, and Hot-Spare/Standby Hot-Spare drives are not
responding, and a drive was found at the incorrect SCSI ID.

Action:Press F4, F5, F6, or F10.

07 48 Explanation:Online/Rebuild drives are not responding, and unidentified drives were found.

Action:Press F4, F5, or F10.

07 4C Explanation:Online/Rebuild drives are not responding, and a drive was found at the incorrect
SCSI ID, and unidentified drives were found.

Action:Press F4, F5, F6, or F10.

07 58 Explanation:Online/Rebuild and Hot Spare/Standby Hot-Spare drives are not responding, and
unidentified drives were found.

Action:Press F4, F5, or F10.

07 5C Explanation:Online/Rebuild and Hot Spare/Standby Hot-Spare drives are not responding, a
drive was found at the incorrect SCSI ID, and unidentified drives were found.

Action:Press F4, F5, F6, or F10.

07 68 Explanation:Online/Rebuild and Ready/Standby drives are not responding, and unidentified
drives were found.

Action:Press F4, F5, or F10.

07 6C Explanation:Online/Rebuild and Ready/Standby drives are not responding, a drive was found at
the incorrect SCSI ID, and unidentified drives were found.

Action:Press F4, F5, F6, or F10.

07 78 Explanation:Online/Rebuild, Ready/Standby, and Hot-Spare/Standby Hot-Spare drives are not
responding, and unidentified drives were found.

Action:Press F4, F5, or F10.

07 7C Explanation:Online/Rebuild, Ready/Standby, and Hot-Spare/Standby Hot-Spare drives are not
responding, a drive was found at the incorrect SCSI ID, and unidentified drives were found.

Action:Press F4, F5, F6, or F10.
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BCS ECS Explanation and possible recovery action

09 00 Explanation:No error occurred.

Action:No action is required.

09 10 Explanation:Hot-Spare/Standby Hot-Spare drives are not responding.

Action:Press F4, F5, or F10.

09 20 Explanation:Ready/Standby drives are not responding.

Action:Press F4, F5, or F10.

09 30 Explanation:Hot-Spare/Standby Hot-Spare and Ready/Standby drives are not responding.

Action:Press F4, F5, or F10.

0F 00 Explanation:No error occurred.

Action:No action is required.

0F 10 Explanation:Hot-Spare/Standby Hot-Spare drives are not responding.

Action:Press F4, F5, or F10.

0F 20 Explanation:Ready/Standby drives are not responding.

Action:Press F4, F5, or F10.

0F 30 Explanation:Hot-Spare/Standby Hot-Spare and Ready/Standby drives are not responding.

Action:Press F4, F5, or F10.
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Rebuilding a defunct drive
A physical drive is defunct when there is a loss of communication between the
controller and the physical drive. This can be caused by any of the following:

v An improperly connected cable, physical drive, or controller

v Loss of power to a drive

v An improperly assembled SCSI channel in an unsupported configuration

v A defective cable, backplane, physical drive, or controller

v Connecting unsupported SCSI devices (such as tape drives) to the same SCSI
channel used for an array.

In each case, after the communication problem is resolved, a rebuild operation is
required to reconstruct the data for the device in its disk array. The ServeRAID
controllers can reconstruct RAID level-1 and RAID level-5 logical drives, but they
cannot reconstruct data stored in RAID level-0 logical drives because RAID level-0
is not redundant.

To prevent data-integrity problems, the ServeRAID controllers set the RAID level-0
logical drives in the effected array to blocked during the rebuild operation for RAID
level-1 or RAID level-5. After the rebuild operation completes, you can unblock the
RAID level-0 logical drives, and access them once again. Remember, however, that
the RAID level-0 logical drives might contain damaged data.

Note: For logical drives in an IBM ServeRAID Cluster Solution:

v Because shared logical drives can have only one logical drive for each
array, blocking a RAID level-0 logical drive during a Rebuild operation
does not apply to shared logical drives.

v Because non-shared logical drives can have more than one logical drive
for each array, blocking a RAID level-0 logical drive during a Rebuild
operation does apply to non-shared logical drives.

Steps for recovering from defunct drives
If the defunct drives are not part of an array, contact your IBM service
representative.

If the defunct drives are part of an array, do the following:

v If more than one physical drive in an array is defunct, contact your IBM service
representative.

v If a rebuild operation is in progress, wait until the rebuild is complete.

v If a rebuild is not in progress and only one physical drive in the array is defunct,
do the following:

1. Verify the cables, physical drives, and controllers are installed properly.

2. Attempt to rebuild the defunct physical drive by performing a Hot-Swap
Rebuild. Refer to “Rebuilding a hot-swap drive” for instructions.

3. If the Hot-Swap Rebuild fails, contact your IBM service representative.

Rebuilding a hot-swap drive
A Hot-Swap Rebuild refers to a Rebuild operation that is started by the ServeRAID
controller when it detects that a drive that is part of an array and in the defunct
state has been removed and reinserted on the SCSI cable or backplane. The
reinsertion of the physical drive, whether it is the same drive or a new drive, will
trigger the ServeRAID controller to start the rebuild operation. During the rebuild
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operation, the drive being rebuilt is in the rebuild state, and the logical drive remains
critical until the rebuild operation has been successfully completed.

On IBM servers, when a hot-spare drive is available, the Rebuild operation begins
automatically without the need to replace the failed drive. If more than one drive
fails, the Rebuild operation begins rebuilding the first failed drive to the hot-spare
drive. If you do not know which drive failed first, the rebuild operation can corrupt
your data.

To start a Hot-Swap Rebuild, do the following:

1. Reseat the ServeRAID controller and SCSI cables.

2. Without removing the drive completely, gently remove the physical drive from
the server, using the handle of the hot-swap tray. If necessary, refer to the
documentation that comes with your server on removing a physical drive.

3. Wait 20 seconds to allow the physical drive to completely spin down.

Note: When power is removed from a hot-swap drive, the drive immediately
parks the heads, locks the actuator in the “landing zone”, and begins
spinning down. However, the spinning down of the disk might require up
to 20 seconds after power is removed. Do not move the drive while it is
spinning down. Moving the drive while it is spinning down might damage
the drive.

4. If you are certain there is nothing wrong with the physical drive you removed,
gently reinstall the drive into the server. Make sure the drive is completely
installed in the backplane connector.

Note: It is possible to rebuild a defunct physical drive to an online physical
drive that is defective.

Otherwise, replace the physical drive with a new drive that is the same size (or
larger) and continue with the Rebuild operation.

Recovering from an incomplete format of a physical drive
During formatting of a physical drive, if the format process is stopped by a system
reset, system shut down, power outage, or by some other means, the physical drive
becomes inoperable.

To enable the physical drive to communicate with the ServeRAID controller again,
do the following:

1. Note the channel of the ServeRAID controller to which the physical drive is
connected.

2. Note the SCSI ID of the physical drive.

3. Use the ipssend format function to restart the format of the physical drive. The
syntax is: ipssend format controller channel sid

where:
v controller is the ServeRAID controller number (1–12)
v channel is the channel number for the device (1, 2, 3, or 4)
v sid is the SCSI ID for the device (0–15)

After the format is complete, the ServeRAID controller will be able to recognize
the drive again.
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Solving problems in a failover environment
Use these procedures to recover from problems in a failover environment.

Recovering from a failure in a failover environment
In a failover environment, when the ServeRAID device driver is unable to send a
command to the active controller and the active controller does not respond to a
reset command, the device driver attempts to failover to the passive controller.

Note: Loose cables or defective physical drives will not cause a failover to occur.

Replacing a controller of a failover pair in non-hot-plug PCI slot
If a failed controller is not in a hot-plug PCI slot, do the following to replace it:

1. Shut down the server.

2. Replace the failed controller.

Note: Do not attach the SCSI cables to the new controller.

3. Insert the IBM ServeRAID Support CD (or the configuration CD that was
included with your server) into the CD-ROM drive; then, turn on the server.
The ServeRAID Manager program starts.

4. Initialize the new controller. In the Main Tree, click the first ServeRAID
controller that you want to configure.

5. Click Actions → Restore to factory default settings.

6. If a confirmation window opens, click Yes. When the operation is complete, a
message displays at the bottom of the window indicating the restore to factory
default settings was successful.

7. Configure the new controller for failover. Click on the tool bar. The
Configure controller for clustering window opens.

8. Fill in the controller name, partner name, and SCSI initiator IDs that you used
for the controller you are replacing.

9. Click OK.

10. Shut down the server.

Figure 30. Configure controller for clustering window
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11. Connect the expansion enclosure to each of the ServeRAID controllers.

Important

When connecting the cables, you must connect the same channel connectors on both
ServeRAID controllers to the same expansion enclosure. For example, if you connect the
cable from Channel 1 on the first ServeRAID controller to the first expansion enclosure,
then you must connect the cable from Channel 1 on the second ServeRAID controller to the
first expansion enclosure.

12. Remove the IBM ServeRAID Support CD (or the configuration CD that was
included with your server) from the CD-ROM drive; then, turn on the server.

13. Start the ServeRAID Manager that is installed on the server and confirm that
the ServeRAID controllers are in a failover pairing (see Figure 19 on page 68).

Replacing a controller of a failover pair in hot-plug PCI slot
If the failed controller is in a hot-plug slot, refer to the documentation that comes
with the server for instructions for replacing the controller.

Recovering from a power failure during a failover
If a power failure occurs during a failover, it is possible the two controllers in the
active-passive pair might have the following problems:
v Some logical drives are configured on one controller and some logical drives are

configured on the other controller.
v A logical drive does not appear on either controller.

To recover from a power failure, do the following:

1. Run ipssend merge for every merge group number configured on the controller
that you want to be active in the pair.

2. Run ipssend unmerge for every merge group number configured on the
controller that you want to be passive in the pair.

3. Shut down and restart the server. Windows NT and Windows 2000 pairs the
controllers again.

Troubleshooting an IBM ServeRAID Cluster Solution
There is the possibility that one of the servers, one of the ServeRAID controllers, or
one of the hard disk drives in a cluster might fail. This chapter presents procedures
you can take to recover from these potential problems. If you still have problems
after following these procedures, contact your IBM service representative for further
information. Also, you can find hints and tips to help you solve problems on the IBM
Support Web site. See “Downloadable files from the World Wide Web” on page 14
for additional information.
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Recovering from a failed ServeRAID server
When replacing a failed server in a high-availability configuration, you might not
need to replace the ServeRAID controller. However, if you replace your ServeRAID
controller, you must reconfigure the controller after you have installed your new
server.

Important

The following procedure requires specific configuration settings for the ServeRAID
controller. If the server and controller that are being replaced are functional, you can obtain
these settings from the controller. However, if the controller or the server is not functional,
you will need a record of these settings, such as one that was created when the controller
was previously configured. If you are replacing your ServeRAID controller with your server,
you must have correct configuration information to complete this procedure.

Use the following procedure to recover from a failed server:

1. Shut down the failed server.

2. Remove all hard disk drives from the array in the failed server.

As you remove your hard disk drives, be sure to note the bay in which each
drive was installed. If you are replacing your failed server with an identical
server, you can reinstall the drives in an identical configuration and get your
server up and running quickly.

3. If the ServeRAID controller is functional, remove it from the failed server. As you
remove the controller from the failed server, be sure to note the following:
v Which SCSI cables are connected to the SCSI channel connectors on the

controller.
v Which PCI slot has the controller installed.

4. Install the hard disk drives in the new server.

For information on how to install a hard disk drive, see the documentation that
comes with your server. If you are replacing the failed server with an identical
server, install each hard disk drive in the same bay as the one it was removed
from in the failed server.

5. If the ServeRAID controller in the failed server is not functional, or you are not
sure, continue with “Recovering from a failed ServeRAID controller”. Otherwise,
perform the following steps with the functional ServeRAID controller:
a. Install the controller in the new server.
b. Reinstall the cables as they were in the failed server.
c. Start the server.

Recovering from a failed ServeRAID controller
You must have the following configuration information to configure your new
ServeRAID controller:
v SCSI initiator IDs

The SCSI initiator IDs for a non-shared SCSI channel are set to 7 by default. For
shared SCSI channels, the initiator IDs must be 7 or 6 and must be different from
the SCSI initiator IDs for the corresponding SCSI channels of the cluster partner
controller. Therefore, if you can obtain the SCSI initiator IDs for the
corresponding cluster partner system, you know the correct SCSI initiator IDs for
this system. For example, if the cluster partner system-shared SCSI initiator IDs
were set to 7, the controller you are replacing would need to have its SCSI
initiator IDs set to 6.

v Controller and partner name
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You can also determine the proper settings for the controller name and partner
name of the controller being replaced by reading the settings from the cluster
partner system.

v Stripe-unit size

The stripe-unit size must be the same on both controllers in a high-availability
cluster.

v Unattended mode setting

This setting is configured automatically as Enabled when a controller is set up for
clustering.

If the ServeRAID controller you are replacing is functional, you can obtain the
above configuration information by starting your server with the IBM ServeRAID
Support CD in the CD-ROM drive and using the ServeRAID Manager program. For
additional information, refer to the ServeRAID Manager online help.

Note: The configuration information is also available in the printable configuration
file you might have saved when configuring the ServeRAID controllers for
clustering.

If the ServeRAID controller is not functional, you will need to refer to a record of the
settings that was made when the controller was previously configured. If you do not
have a record of the configuration information, refer to “Obtaining the current
configuration information” for information that might help you to assign the proper
values.

Obtaining the current configuration information
To obtain the SCSI initiator IDs, controller name, partner name, and stripe-unit size
from the corresponding cluster partner controller, do the following:

1. Start the cluster partner system with the IBM ServeRAID Support CD in the
CD-ROM drive. The ServeRAID Manager program starts.

2. In the Main Tree, click the cluster partner controller.

3. Click on the tool bar. The Configure controller for clustering window
opens.

Figure 31. Configure controller for clustering window
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4. Note the settings in the fields.

Replacing a ServeRAID controller
Use the following procedure to replace a failed ServeRAID controller in your
high-availability configuration:

1. Shut down the server.

2. Note which SCSI cables are connected to the SCSI channel connectors on the
controller.

3. Note which PCI slot has the controller installed.

4. Remove the failing ServeRAID controller.

For instructions on how to remove and install the ServeRAID controller, see
“Step 1: Installing and cabling a ServeRAID controller” on page 15.

5. Install the new ServeRAID controller. Be sure to install the controller in the
same PCI slot from which you removed the failed ServeRAID controller.

Important
v Do not reconnect the SCSI channel cables to the controller at this time.
v You must ensure that you have the same level of ServeRAID BIOS and firmware on both

controllers in the cluster.

The software is available on the IBM Support Web site. See “Downloadable files from the
World Wide Web” on page 14 for additional information.

6. Start the system with the IBM ServeRAID Support CD (version 4.0, or later) in
the CD-ROM drive. The ServeRAID Manager program starts.

7. In the Main Tree, click the new controller.

8. Click Actions → Restore to factory default settings. The ServeRAID
Manager program initializes the controller configuration.

9. With the new controller still selected in the Main Tree, click on the tool
bar. The Configure controller for clustering window opens.

10. Using the settings that were assigned to the previous ServeRAID controller
(that is, the controller you are replacing), fill in each of the following fields:
v SCSI initiator IDs
v Controller name
v Partner name

11. Click OK. The new controller stripe-unit size setting defaults to 8 KB. If you
need to change this setting to match the partner controller, go to step 12 on
page 143. Otherwise, go to step 15 on page 143.

Figure 32. Configure controller for clustering window
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12. In the Main Tree, click the new controller.

13. Click Actions → Change stripe-unit size.

14. Click the new stripe-unit size for your installation.

15. Shut down and turn off the server.

16. Reconnect the SCSI channel cables to the controller.

Note: Be sure to connect the cables to the correct SCSI channels as noted in
step 2 on page 142.

17. If the ServeRAID controller being replaced attaches to any of the following:
v The server startup disk array
v Other non-shared disk arrays
v Shared arrays which have not failed-over to the other server,

start the system with the IBM ServeRAID Support CD (version 4.0, or later) in
the CD-ROM drive. The ServeRAID Manager program starts.

If the ServeRAID controller being replaced does not attach to any of these
items, go to step 21

18. In the Main Tree, click the new controller.

19. Click Actions → Copy configuration from drives.

20. Click the merge group number for the non-shared logical drives (that is, 206 or
207).

Note: The last number in the merge group number is the shared SCSI initiator
ID. That is, if the merge group number is 206, the SCSI initiator ID is 6.

21. Remove the IBM ServeRAID Support CD from the CD-ROM drive.

22. Restart your server.

Note: If the controller you replaced is the startup controller, the system will
now start the operating system properly.

Recovering from a failover in a Microsoft Cluster Service server
After a failover occurs in a Microsoft Cluster Services server, the red drive lights in
the IBM Netfinity EXP10 or IBM Netfinity EXP15 enclosures might turn on for
physical drives that are online. There is no hardware problem; the lights turn off
within an hour.

Recovering from a failed server in a ServeRAID cluster
Contact IBM technical support for assistance.
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Troubleshooting ServeRAID subsystems in a cluster environment
Following is a series of common problems and solutions that can help you
troubleshoot your IBM ServeRAID Cluster Solution.

Problem Action

The ServeRAID Manager program shows
physical drives in defunct state.

1. Enable the View shared drives feature in the ServeRAID
Manager program. Doing so displays a drive as reserved, instead
of defunct, in the following situations:
v A drive has been moved.
v A drive has failed-over to the other server in the cluster.

Note: It is normal for drives in the above situations to display as
defunct if you have not enabled the View shared drives feature.
In this case, the drives shown in the defunct state are not really
defective.

2. Check RAID level-1 and RAID level-5 arrays to make sure they
are not in critical state. If they are in critical state, replace the
failed drive and perform a rebuild operation.

ServeRAID shared logical drives do not
failover properly.

1. Ensure that the resource type of each ServeRAID controller
shared disk resource is IBM ServeRAID logical disk.

If the resource type is shown as physical drive, the localquorum
option was not specified properly when MSCS was installed.

To correct this problem, you must reinstall the high-availability
cluster solution using Microsoft Windows NT. Refer to “Chapter 2.
Installing and configuring ServeRAID controllers” on page 13 for
instructions.

2. Ensure that shared SCSI buses on the ServeRAID controller pair
are connected in a way that corresponding SCSI channels are
connected. For example, SCSI channel 1 on the controller in the
first cluster server is connected to SCSI channel 1 on the
controller in the second cluster server, channel 2 is connected to
channel 2, and so forth.

3. Ensure that physical SCSI drives that contain logical drives are
all connected to shared SCSI channels.

4. Ensure that there are no more than eight shared logical drives
defined per pair of ServeRAID controllers.

5. Make sure each shared logical drive has a unique merge group
number assigned. Shared merge group numbers must be in the
range 1–8.

6. Make sure each ServeRAID controller has been assigned a
unique controller name and that each ServeRAID controller has
its partner name assigned properly to correspond to the
ServeRAID controller in the other cluster server that is attached
to the shared SCSI buses.

7. Check for loose shared SCSI bus cables.

8. Ensure that SCSI repeater cards in Model 3518 or 3519
expansion enclosures are at the latest revision level. Refer to the
IBM Shared Disk Clustering Hardware Reference for more
information. See “Related publications” on page xii for information
about this publication.

9. Ensure that physical drives that are expected to be moved or to
failover show up as ready or reserved state on the server that is
attempting to take over control of these drives.
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Problem Action

RAID level-5 logical drives cannot be
accessed by the operating system after a
failover.

Use the ServeRAID Manager program to check the state of the
logical drive to ensure that it is not blocked. Using this program,
select the logical drive and look for Blocked state Yes. If the logical
drive is blocked, make sure all physical drives that are part of the
logical drive are in the online state. If all physical drives are not in the
online state, a drive might have failed during one of the following
situations:
v A failover
v A resynchronization process after a failover

Data integrity cannot be guaranteed in this case and the logical drive
has been blocked to prevent the possibility of incorrect data being
read from the logical drive.

Unblock, reinitialize, and synchronize the logical drive and restore the
data from a backup source. Depending on the type of data contained
on the logical drive and the availability of a recent backup copy, you
can do one of the following:
v Unblock the drive and continue normal operation.
v Replace and rebuild one or more defunct drives.

However, if you do not reinitialize, synchronize, and restore the drive,
be aware that some data could be lost or damaged.

If one of the cluster servers fails and the
surviving server takes over the cluster
resources, occasionally one or more of the IP
address resources will stay in the online
pending state for several minutes after moving
over to the surviving server. After this, the
resource will go to the Failed state and the
following error message will be displayed in
the surviving server system log (as viewed
with the Event Viewer).

For example, the Windows NT Event Log
Message:

Date: ??? Event ID: 1069
Time: ??? Source: ClusSvc
User: N/A Type: Error
Computer: ??? Category: (4)

Description:

Cluster resource 'ip address resource
name' failed

Do the following:

1. Using the right mouse button, click the IP resource in the Cluster
Administrator.

2. From the General tab, select Properties.

3. Check the box labeled Run this resource in a separate
Resource Monitor. A message appears stating that the resource
must be restarted for the change to take effect.
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Problem Action

After one of the cluster servers has been shut
down normally and the surviving server takes
over the cluster resources, occasionally one
or more of the IBM ServeRAID logical drive
resources will stay in the online-pending state
for several minutes, after moving over to the
surviving server (when viewed with the
Cluster Administrator). After this, the resource
will go to the Failed state and the following
error message will be displayed in the
surviving server system log (as viewed with
the Event Viewer).

For example, the Windows NT Event Log
Message:

Date: ??? Event ID: 1069
Time: ??? Source: ClusSvc
User: N/A Type: Error
Computer: ??? Category: (4)

Description:

Cluster resource 'IBM ServeRAID Logical
Disk name' failed.

No action is necessary to bring the resource online after the failover.
MSCS will bring this resource online on the surviving server within
about four minutes.

You cannot reinstall the ServeRAID Windows
NT Cluster Solution. If a previous version of
IBM ServeRAID Cluster Solution has been
uninstalled, when attempting to reinstall the
IBM ServeRAID Windows NT Cluster solution,
a message incorrectly appears prompting you
to perform an upgrade.

You must delete the C3E76E53-F841-11D0-BFA1-08005AB8ED05
registry key. To delete the registry key, do the following:

1. From the Start menu, click Run.

2. Type: REGEDIT and click OK. The Registry Editor window opens.

3. Select HKEY_CLASSES_ROOT\CLSID and delete
C3E76E53-F841-11D0-BFA1-08005AB8ED05.

4. Reinstall the ServeRAID Windows NT Cluster Solution. Refer to
“Chapter 7. Configuring ServeRAID controllers for clustering” on
page 79 for instructions.

When running the IPSHAHTO program on a
server, the following error message appears:
Warning: CONFIG_SYNC with 0xA0 command
FAILED on COntroller #

and either of the following occurs:
v One or more hot-spare or standby

hot-spare drives are defined on controller
pairs.

v Ready drives are not part of any logical
drive configuration on a controller pair in a
cluster.

If all shared drive resources moved successfully when you ran the
IPSHAHTO program, it is safe to ignore the error message and no
further action is required.

However, if shared drive resources failed to move when you ran the
IPSHAHTO program, remove all ready drives that are not part of any
logical drive configuration on a controller pair in a cluster.

Array identifiers and logical drive numbers
might change during a failover condition.

By design, the array identifiers and logical drive numbers might
change during a failover condition. Consistency between the merge
group numbers and Windows NT or Windows 2000 permanent
(sticky) drive letters is maintained, while the ordering process during
a failover condition is controlled by the Microsoft Cluster Service
software and the available array identifiers on the surviving server.
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Chapter 13. Getting help, service, and information

If you need help, service, technical assistance, or just want more information about
IBM products, you will find a wide variety of sources available from IBM to assist
you.

For example, IBM maintains pages on the World Wide Web where you can get
information about IBM products and services, find the latest technical information,
and download device drivers and updates. Some of these pages are:

http://www.ibm.com Main IBM home page
http://www.ibm.com/pc IBM Personal Computing
http://www.ibm.com/pc/support IBM Personal Computing Support
http://www.ibm.com/pc/us/ibmpc IBM Commercial Desktop PCs (U.S.)
http://www.ibm.com/pc/us/intellistation IBM IntelliStation Workstations (U.S.)
http://www.ibm.com/pc/us/accessories Options by IBM (U.S.)
http://www.ibm.com/pc/us/netfinity IBM Netfinity Servers (U.S.)
http://www.ibm.com/pc/us/server/sguide IBM ServerGuide (U.S.)
http://www.ibm.com/pc/us/netfinity/
system_management

IBM Systems Management (U.S.)

http://www.ibm.com/software/os/warp-
server

IBM OS/2 Warp Server

http://www.ibm.com/pc/techconnect IBM TechConnect

You can select a country-specific Web site from these pages.

You might also want to visit the Web pages of other companies for information
about other operating systems, software, and accessories. The following are some
other Web sites you might find helpful:

http://www.lotus.com

http://www.tivoli.com

http://www.microsoft.com

http://www.novell.com

http://www.sco.com

http://www.adaptec.com

http://www.apcc.com

http://www.norton.com

Help is also available from bulletin boards and online services, as well as by fax
and telephone. This section provides information about these sources.

Services available and telephone numbers listed are subject to change without
notice.
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Service support
With the original purchase of an IBM hardware product, you have access to
extensive support coverage. During the IBM hardware product warranty period, you
may call the IBM Personal Computer HelpCenter (1-800-772-2227 in the U.S.) for
hardware product assistance covered under the terms of the IBM hardware
warranty. See “Getting help by telephone” on page 150 for HelpCenter telephone
numbers in other countries.

The following services are available during the warranty period:

v Problem determination - Trained personnel are available to assist you with
determining if you have a hardware problem and deciding what action is
necessary to fix the problem.

v IBM hardware repair - If the problem is determined to be caused by IBM
hardware under warranty, trained service personnel are available to provide the
applicable level of service.

v Engineering change management - Occasionally, there might be changes that
are required after a product has been sold. IBM or your reseller, if authorized by
IBM, will make Engineering Changes (ECs) available that apply to your
hardware.

Be sure to retain your proof of purchase to obtain warranty service.

Please have the following information ready when you call:
v Machine Type and Model
v Serial numbers of your IBM hardware products
v Description of the problem
v Exact wording of any error messages
v Hardware and software configuration information

If possible, be at your computer when you call.

The following items are not covered:
v Replacement or use of non-IBM parts or nonwarranted IBM parts

Note: All warranted parts contain a 7-character identification in the format IBM
FRU XXXXXXX.

v Identification of software problem sources
v Configuration of BIOS as part of an installation or upgrade
v Changes, modifications, or upgrades to device drivers
v Installation and maintenance of network operating systems (NOS)
v Installation and maintenance of application programs

Refer to your IBM hardware warranty for a full explanation of IBM’s warranty terms.

Before you call for service
Many computer problems can be solved without outside assistance, by using the
online help or by looking in the online or printed documentation that comes with
your computer or software. Also, be sure to read the information in any README
files that come with your software.

Most computers, operating systems, and application programs come with
documentation that contains troubleshooting procedures and explanations of error
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messages. The documentation that comes with your computer also contains
information about the diagnostic tests you can perform.

If you receive a POST error code when you turn on your computer, refer to the
POST error-message charts in your hardware documentation. If you do not receive
a POST error code, but suspect a hardware problem, refer to the troubleshooting
information in your hardware documentation or run the diagnostic tests.

If you suspect a software problem, consult the documentation (including README
files) for the operating system or application program.

Getting customer support and service
Purchasing an IBM PC hardware product entitles you to standard help and support
during the warranty period. If you need additional support and services, a wide
variety of extended services are available for purchase that address almost any
need.

Using the World Wide Web
On the World Wide Web, the IBM Personal Computing Web site has up-to-date
information about IBM Personal Computer products and support. The address for
the IBM Personal Computing home page is:

http://www.ibm.com/pc

You can find support information for your IBM products, including supported options,
on the IBM Personal Computing Support page at:

http://www.ibm.com/pc/support

If you select Profile from the support page, you can create a customized support
page that is specific to your hardware, complete with Frequently Asked Questions,
Parts Information, Technical Hints and Tips, and Downloadable Files. You will have
the information you need, all in one place. In addition, you can choose to receive
e-mail notifications whenever new information becomes available about your
registered products. You also can access online support forums, which are
community sites monitored by IBM support staff.

For information about specific Personal Computer products, visit the following
pages:

http://www.ibm.com/pc/us/intellistation

http://www.ibm.com/pc/us/ibmpc

http://www.ibm.com/pc/us/netfinity

http://www.ibm.com/pc/us/thinkpad

http://www.ibm.com/pc/us/accessories

http://www.direct.ibm.com/content/home/en_US/aptiva

You can select a country-specific Web site from these pages.

Using electronic support services
If you have a modem, you can get help from several popular services. Online
information services provide assistance through question-and-answer message
areas, live chat rooms, searchable databases, and more.

Chapter 13. Getting help, service, and information 149



Technical information is available on a wide range of topics, such as:
v Hardware setup and configuration
v Preinstalled software
v Windows, OS/2, and DOS
v Networking
v Communications
v Multimedia

In addition, the latest device driver updates are available.

Commercial online services, such as America Online (AOL), contain information
about IBM products. (For AOL, use the keyword IBM.)

Getting information by fax
If you have a touch-tone telephone and access to a fax machine, in the U.S. and
Canada you can receive by fax marketing and technical information on many topics,
including hardware, operating systems, and local area networks (LANs). You can
call the IBM Automated Fax System 24 hours a day, 7 days a week. Follow the
recorded instructions, and the requested information will be sent to your fax
machine.

In the U.S. and Canada, to access the IBM Automated Fax System, call
1-800-426-3395.

Getting help online
Online Housecall is a remote communication tool that allows an IBM
technical-support representative to access your PC by modem. Many problems can
be remotely diagnosed and corrected quickly and easily. In addition to a modem, a
remote-access application program is required. This service is not available for
servers. There might be a charge for this service, depending on the request.

For more information about configuring your PC for Online Housecall:
v In the U.S., call 1-800-772-2227.
v In Canada, call 1-800-565-3344.
v In all other countries, contact your IBM reseller or IBM marketing representative.

Getting help by telephone
During the warranty period, you can get help and information by telephone through
the IBM PC HelpCenter. Expert technical-support representatives are available to
assist you with questions you might have on the following:
v Setting up your computer and IBM monitor
v Installing and setting up IBM options purchased from IBM or an IBM reseller
v 30-day, preinstalled-operating-system support
v Arranging for service (on-site or carry-in)
v Arranging for overnight shipment of customer-replaceable parts

In addition, if you purchased an IBM PC Server or IBM Netfinity Server, you are
eligible for IBM Start Up Support for 90 days after installation. This service provides
assistance for:
v Setting up your network operating system
v Installing and configuring interface cards
v Installing and configuring network adapters

Please have the following information ready when you call:
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v Machine Type and Model
v Serial numbers of your computer, monitor, and other components, or your proof

of purchase
v Description of the problem
v Exact wording of any error messages
v Hardware and software configuration information for your system

If possible, be at your computer when you call.

In the U.S. and Canada, these services are available 24 hours a day, 7 days a
week. In the U.K., these services are available Monday through Friday, from 9:00
a.m. to 6:00 p.m.3

Country Telephone number

Austria Österreich 1-546 585 075

Belgium - Dutch Belgie 02-717-2504

Belgium - French Belgique 02-717-2503

Canada Canada 1-800-565-3344

Denmark Danmark 03-525-6905

Finland Suomi 9-22-931805

France France 01-69-32-40-03

Germany Deutschland 069-6654-9003

Ireland Ireland 01-815-9207

Italy Italia 02-4827-5003

Luxembourg Luxembourg 298-977-5060

Netherlands Nederland 020-504-0531

Norway Norge 2-305-3203

Portugal Portugal 01-791-5147

Spain España 091-662-4270

Sweden Sverige 08-632-0063

Switzerland - German Schweiz 01-212-1810

Switzerland - French Suisse 022-310-0418

Switzerland - Italian Svizzera 091-971-0523

United Kingdom United Kingdom 01475-555555

U.S.A. and Puerto Rico U.S.A. and Puerto Rico 1-800-772-2227

In all other countries, contact your IBM reseller or IBM marketing representative.

Getting help around the world
If you travel with your computer or need to move it to another country, you can
register for International Warranty Service. When you register with the International
Warranty Service Office, you will receive an International Warranty Service
Certificate that is honored virtually worldwide, wherever IBM or IBM resellers sell
and service IBM PC products.

3. Response time will vary depending on the number and complexity of incoming calls.
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For more information or to register for International Warranty Service:
v In the U.S. or Canada, call 1-800-497-7426.
v In Europe, call 44-1475-893638 (Greenock, U.K.).
v In Australia and New Zealand, call 61-2-9354-4171.

In all other countries, contact your IBM reseller or IBM marketing representative.

Purchasing additional services
During and after the warranty period, you can purchase additional services, such as
support for IBM and non-IBM hardware, operating systems, and application
programs; network setup and configuration; upgraded or extended hardware repair
services; and custom installations. Service availability and name might vary by
country.

Enhanced PC support line
Enhanced PC Support is available for desktop and mobile IBM computers that are
not connected to a network. Technical support is provided for IBM computers and
IBM or non-IBM options, operating systems, and application programs on the
Supported Products list.

This service includes technical support for:
v Installing and configuring your out-of-warranty IBM computer
v Installing and configuring non-IBM options in IBM computers
v Using IBM operating systems in IBM and non-IBM computers
v Using application programs and games
v Tuning performance
v Installing device drivers remotely
v Setting up and using multimedia devices
v Identifying system problems
v Interpreting documentation

You can purchase this service on a per-call basis, as a multiple-incident package, or
as an annual contract with a 10-incident limit. For more information about
purchasing Enhanced PC Support, see “Ordering support line services” on
page 153.

900-number operating system and hardware support line
In the U.S., if you prefer to obtain technical support on a pay-as-you-go basis, you
can use the 900-number support line. The 900-number support line provides
support for IBM PC products that are out of the warranty period.

To access this support, call 1-900-555-CLUB (2582). You will be notified of the
charge per minute.

Network and server support line
Network and Server Support is available for simple or complex networks made up
of IBM servers and workstations using major network operating systems. In
addition, many popular non-IBM adapters and network interface cards are
supported.

This service includes all of the features of the Enhanced PC Support Line, plus:
v Installing and configuring client workstations and servers
v Identifying system problems and correcting problems on the client or the server
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v Using IBM and non-IBM network operating systems
v Interpreting documentation

You can purchase this service on a per-call basis, as a multiple-incident package, or
as an annual contract with a 10-incident limit. For more information about
purchasing Network and Server Support, see “Ordering support line services”.

Ordering support line services
Enhanced PC Support Line and Network and Server Support Line services are
available for products on the Supported Products list. To receive a Supported
Products list:

v In the U.S.:
1. Call 1-800-426-3395.
2. Select document number 11683 for Network and Server support.
3. Select document number 11682 for Enhanced PC support.

v In Canada, contact IBM Direct at 1-800-465-7999, or:
1. Call 1-800-465-3299.
2. Select the HelpWare catalog.

v In all other countries, contact your IBM reseller or IBM marketing representative.

For more information or to purchase these services:
v In the U.S., call 1-800-772-2227.
v In Canada, call 1-800-465-7999.
v In all other countries, contact your HelpCenter.

Warranty and repair services
You can upgrade your standard hardware warranty service or extend the service
beyond the warranty period.

Warranty upgrades in the U.S. include:

v Carry-in service to on-site service

If your warranty provides carry-in repair service, you can upgrade to on-site
repair service, either standard or premium. The standard upgrade provides a
trained servicer within the next business day (9 a.m. to 5 p.m., local time,
Monday though Friday). The premium upgrade provides 4-hour average
response, 24 hours a day, 7 days a week.

v On-site service to premium on-site service

If your warranty provides for on-site service, you can upgrade to premium on-site
service (4-hour average on-site response, 24 hours a day, 7 days a week).

You also can extend your warranty. Warranty and Repair Services offers a variety of
post-warranty maintenance options, including ThinkPad EasyServ Maintenance
Agreements. Availability of the services varies by product.

For more information about warranty upgrades and extensions:
v In the U.S., call 1-800-426-4968.
v In Canada, call 1-800-465-7999.
v In all other countries, contact your IBM reseller or IBM marketing representative.
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Ordering publications
Additional publications are available for purchase from IBM. For a list of publications
available in your country:
v In the U.S., Canada, and Puerto Rico, call 1-800-879-2755.
v In other countries, contact your IBM reseller or IBM marketing representative.
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Appendix. Product warranties and notices

This chapter contains warranty and emission notices. It also contains trademarks
and general-information notices.

Warranty Statements
The warranty statements consist of two parts: Part 1 and Part 2. Part 1 varies by
country. Part 2 is the same for all countries. Be sure to read both the Part 1 that
applies to your country and Part 2.

v United States, Puerto Rico, and Canada (Z125-4753-05 11/97)

(“Part 1 - General Terms”)

v Worldwide except Canada, Puerto Rico, Turkey, and United States
(Z125-5697-01 11/97)

(“Part 1 - General Terms” on page 158)

v Worldwide Country-Unique Terms

(“Part 2 - Worldwide Country-Unique Terms” on page 160)

IBM Statement of Limited Warranty for United States, Puerto Rico, and
Canada (Part 1 - General Terms)

This Statement of Limited Warranty includes Part 1 - General Terms and Part 2 -
Country-unique Terms. The terms of Part 2 may replace or modify those of Part
1.The warranties provided by IBM in this Statement of Limited Warranty apply only
to Machines you purchase for your use, and not for resale, from IBM or your
reseller. The term ″Machine″ means an IBM machine, its features, conversions,
upgrades, elements, or accessories, or any combination of them. The term
″Machine″ does not include any software programs, whether pre-loaded with the
Machine, installed subsequently or otherwise. Unless IBM specifies otherwise, the
following warranties apply only in the country where you acquire the Machine.
Nothing in this Statement of Warranty affects any statutory rights of consumers that
cannot be waived or limited by contract. If you have any questions, contact IBM or
your reseller.

Machine - IBM ServeRAID-4H Ultra160 SCSI Controller

Warranty Period* - Three Years

*Contact your place of purchase for warranty service information. Some IBM
Machines are eligible for On-site warranty service depending on the country where
service is performed.

The IBM Warranty for Machines IBM warrants that each Machine 1) is free from
defects in materials and workmanship and 2) conforms to IBM’s Official Published
Specifications. The warranty period for a Machine is a specified, fixed period
commencing on its Date of Installation. The date on your sales receipt is the Date
of Installation, unless IBM or your reseller informs you otherwise.

During the warranty period IBM or your reseller, if approved by IBM to provide
warranty service, will provide repair and exchange service for the Machine, without
charge, under the type of service designated for the Machine and will manage and
install engineering changes that apply to the Machine.
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If a Machine does not function as warranted during the warranty period, and IBM or
your reseller are unable to either 1) make it do so or 2) replace it with one that is at
least functionally equivalent, you may return it to your place of purchase and your
money will be refunded. The replacement may not be new, but will be in good
working order.

Extent of Warranty The warranty does not cover the repair or exchange of a
Machine resulting from misuse, accident, modification, unsuitable physical or
operating environment, improper maintenance by you, or failure caused by a
product for which IBM is not responsible. The warranty is voided by removal or
alteration of Machine or parts identification labels.

THESE WARRANTIES ARE YOUR EXCLUSIVE WARRANTIES AND REPLACE
ALL OTHER WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OR
CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. THESE WARRANTIES GIVE YOU SPECIFIC LEGAL RIGHTS AND
YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM JURISDICTION TO
JURISDICTION. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR
LIMITATION OF EXPRESS OR IMPLIED WARRANTIES, SO THE ABOVE
EXCLUSION OR LIMITATION MAY NOT APPLY TO YOU. IN THAT EVENT, SUCH
WARRANTIES ARE LIMITED IN DURATION TO THE WARRANTY PERIOD. NO
WARRANTIES APPLY AFTER THAT PERIOD.

Items Not Covered by Warranty IBM does not warrant uninterrupted or error-free
operation of a Machine.

Unless specified otherwise, IBM provides non-IBM machines WITHOUT
WARRANTIES OF ANY KIND.

Any technical or other support provided for a Machine under warranty, such as
assistance via telephone with ″how-to″ questions and those regarding Machine
set-up and installation, will be provided WITHOUT WARRANTIES OF ANY KIND.

Warranty Service To obtain warranty service for the Machine, contact your reseller
or IBM. In the United States, call IBM at 1-800-772-2227. In Canada, call IBM at
1-800-565-3344. You may be required to present proof of purchase.

IBM or your reseller provides certain types of repair and exchange service, either at
your location or at a service center, to keep Machines in, or restore them to,
conformance with their Specifications. IBM or your reseller will inform you of the
available types of service for a Machine based on its country of installation. IBM
may repair the failing Machine or exchange it at its discretion.

When warranty service involves the exchange of a Machine or part, the item IBM or
your reseller replaces becomes its property and the replacement becomes yours.
You represent that all removed items are genuine and unaltered. The replacement
may not be new, but will be in good working order and at least functionally
equivalent to the item replaced. The replacement assumes the warranty service
status of the replaced item.

Any feature, conversion, or upgrade IBM or your reseller services must be installed
on a Machine which is 1) for certain Machines, the designated, serial-numbered
Machine and 2) at an engineering-change level compatible with the feature,
conversion, or upgrade. Many features, conversions, or upgrades involve the
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removal of parts and their return to IBM. A part that replaces a removed part will
assume the warranty service status of the removed part.

Before IBM or your reseller exchanges a Machine or part, you agree to remove all
features, parts, options, alterations, and attachments not under warranty service.

You also agree to

1. ensure that the Machine is free of any legal obligations or restrictions that
prevent its exchange;

2. obtain authorization from the owner to have IBM or your reseller service a
Machine that you do not own; and

3. where applicable, before service is provided

a. follow the problem determination, problem analysis, and service request
procedures that IBM or your reseller provides,

b. secure all programs, data, and funds contained in a Machine,

c. provide IBM or your reseller with sufficient, free, and safe access to your
facilities to permit them to fulfill their obligations, and

d. inform IBM or your reseller of changes in a Machine’s location.

IBM is responsible for loss of, or damage to, your Machine while it is 1) in IBM’s
possession or 2) in transit in those cases where IBM is responsible for the
transportation charges.

Neither IBM nor your reseller is responsible for any of your confidential, proprietary
or personal information contained in a Machine which you return to IBM or your
reseller for any reason. You should remove all such information from the Machine
prior to its return.

Production Status Each IBM Machine is manufactured from new parts, or new and
used parts. In some cases, the Machine may not be new and may have been
previously installed. Regardless of the Machine’s production status, IBM’s
appropriate warranty terms apply.

Limitation of Liability Circumstances may arise where, because of a default on
IBM’s part or other liability, you are entitled to recover damages from IBM. In each
such instance, regardless of the basis on which you are entitled to claim damages
from IBM (including fundamental breach, negligence, misrepresentation, or other
contract or tort claim), IBM is liable for no more than

1. damages for bodily injury (including death) and damage to real property and
tangible personal property; and

2. the amount of any other actual direct damages, up to the greater of U.S.
$100,000 (or equivalent in local currency) or the charges (if recurring, 12
months’ charges apply) for the Machine that is the subject of the claim.

This limit also applies to IBM’s suppliers and your reseller. It is the maximum for
which IBM, its suppliers, and your reseller are collectively responsible.

UNDER NO CIRCUMSTANCES IS IBM LIABLE FOR ANY OF THE FOLLOWING:
1) THIRD-PARTY CLAIMS AGAINST YOU FOR DAMAGES (OTHER THAN
THOSE UNDER THE FIRST ITEM LISTED ABOVE); 2) LOSS OF, OR DAMAGE
TO, YOUR RECORDS OR DATA; OR 3) SPECIAL, INCIDENTAL, OR INDIRECT
DAMAGES OR FOR ANY ECONOMIC CONSEQUENTIAL DAMAGES
(INCLUDING LOST PROFITS OR SAVINGS), EVEN IF IBM, ITS SUPPLIERS OR
YOUR RESELLER IS INFORMED OF THEIR POSSIBILITY. SOME
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JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION
OR EXCLUSION MAY NOT APPLY TO YOU.

IBM Statement of Warranty Worldwide except Canada, Puerto Rico,
Turkey, United States (Part 1 – General Terms)

This Statement of Warranty includes Part 1 - General Terms and Part 2 -
Country-unique Terms. The terms of Part 2 may replace or modify those of Part
1. The warranties provided by IBM in this Statement of Warranty apply only to
Machines you purchase for your use, and not for resale, from IBM or your reseller.
The term ″Machine″ means an IBM machine, its features, conversions, upgrades,
elements, or accessories, or any combination of them. The term ″Machine″ does
not include any software programs, whether pre-loaded with the Machine, installed
subsequently or otherwise. Unless IBM specifies otherwise, the following warranties
apply only in the country where you acquire the Machine. Nothing in this Statement
of Warranty affects any statutory rights of consumers that cannot be waived or
limited by contract. If you have any questions, contact IBM or your reseller.

Machine - IBM ServeRAID-4H Ultra160 SCSI Controller

Warranty Period* - Three Years

*Contact your place of purchase for warranty service information. Some IBM
Machines are eligible for On-site warranty service depending on the country where
service is performed.

The IBM Warranty for Machines IBM warrants that each Machine 1) is free from
defects in materials and workmanship and 2) conforms to IBM’s Official Published
Specifications. The warranty period for a Machine is a specified, fixed period
commencing on its Date of Installation. The date on your sales receipt is the Date
of Installation, unless IBM or your reseller informs you otherwise.

During the warranty period IBM or your reseller, if approved by IBM to provide
warranty service, will provide repair and exchange service for the Machine, without
charge, under the type of service designated for the Machine and will manage and
install engineering changes that apply to the Machine.

If a Machine does not function as warranted during the warranty period, and IBM or
your reseller are unable to either 1) make it do so or 2) replace it with one that is at
least functionally equivalent, you may return it to your place of purchase and your
money will be refunded. The replacement may not be new, but will be in good
working order.

Extent of Warranty The warranty does not cover the repair or exchange of a
Machine resulting from misuse, accident, modification, unsuitable physical or
operating environment, improper maintenance by you, or failure caused by a
product for which IBM is not responsible. The warranty is voided by removal or
alteration of Machine or parts identification labels.

THESE WARRANTIES ARE YOUR EXCLUSIVE WARRANTIES AND REPLACE
ALL OTHER WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OR
CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. THESE WARRANTIES GIVE YOU SPECIFIC LEGAL RIGHTS AND
YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM JURISDICTION TO
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JURISDICTION. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR
LIMITATION OF EXPRESS OR IMPLIED WARRANTIES, SO THE ABOVE
EXCLUSION OR LIMITATION MAY NOT APPLY TO YOU. IN THAT EVENT, SUCH
WARRANTIES ARE LIMITED IN DURATION TO THE WARRANTY PERIOD. NO
WARRANTIES APPLY AFTER THAT PERIOD.

Items Not Covered by Warranty IBM does not warrant uninterrupted or error-free
operation of a Machine.

Unless specified otherwise, IBM provides non-IBM machines WITHOUT
WARRANTIES OF ANY KIND.

Any technical or other support provided for a Machine under warranty, such as
assistance via telephone with ″how-to″ questions and those regarding Machine
set-up and installation, will be provided WITHOUT WARRANTIES OF ANY KIND.

Warranty Service To obtain warranty service for the Machine, contact your reseller
or IBM. You may be required to present proof of purchase.

IBM or your reseller provides certain types of repair and exchange service, either at
your location or at a service center, to keep Machines in, or restore them to,
conformance with their Specifications. IBM or your reseller will inform you of the
available types of service for a Machine based on its country of installation. IBM
may repair the failing Machine or exchange it at its discretion.

When warranty service involves the exchange of a Machine or part, the item IBM or
your reseller replaces becomes its property and the replacement becomes yours.
You represent that all removed items are genuine and unaltered. The replacement
may not be new, but will be in good working order and at least functionally
equivalent to the item replaced. The replacement assumes the warranty service
status of the replaced item.

Any feature, conversion, or upgrade IBM or your reseller services must be installed
on a Machine which is 1) for certain Machines, the designated, serial-numbered
Machine and 2) at an engineering-change level compatible with the feature,
conversion, or upgrade. Many features, conversions, or upgrades involve the
removal of parts and their return to IBM. A part that replaces a removed part will
assume the warranty service status of the removed part.

Before IBM or your reseller exchanges a Machine or part, you agree to remove all
features, parts, options, alterations, and attachments not under warranty service.

You also agree to

1. ensure that the Machine is free of any legal obligations or restrictions that
prevent its exchange;

2. obtain authorization from the owner to have IBM or your reseller service a
Machine that you do not own; and

3. where applicable, before service is provided

a. follow the problem determination, problem analysis, and service request
procedures that IBM or your reseller provides,

b. secure all programs, data, and funds contained in a Machine,

c. provide IBM or your reseller with sufficient, free, and safe access to your
facilities to permit them to fulfill their obligations, and

d. inform IBM or your reseller of changes in a Machine’s location.
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IBM is responsible for loss of, or damage to, your Machine while it is 1) in IBM’s
possession or 2) in transit in those cases where IBM is responsible for the
transportation charges.

Neither IBM nor your reseller is responsible for any of your confidential, proprietary
or personal information contained in a Machine which you return to IBM or your
reseller for any reason. You should remove all such information from the Machine
prior to its return.

Production Status Each IBM Machine is manufactured from new parts, or new and
used parts. In some cases, the Machine may not be new and may have been
previously installed. Regardless of the Machine’s production status, IBM’s
appropriate warranty terms apply.

Limitation of Liability Circumstances may arise where, because of a default on
IBM’s part or other liability, you are entitled to recover damages from IBM. In each
such instance, regardless of the basis on which you are entitled to claim damages
from IBM (including fundamental breach, negligence, misrepresentation, or other
contract or tort claim), IBM is liable for no more than

1. damages for bodily injury (including death) and damage to real property and
tangible personal property; and

2. the amount of any other actual direct damages, up to the greater of U.S.
$100,000 (or equivalent in local currency) or the charges (if recurring, 12
months’ charges apply) for the Machine that is the subject of the claim.

This limit also applies to IBM’s suppliers and your reseller. It is the maximum for
which IBM, its suppliers, and your reseller are collectively responsible.

UNDER NO CIRCUMSTANCES IS IBM LIABLE FOR ANY OF THE FOLLOWING:
1) THIRD-PARTY CLAIMS AGAINST YOU FOR DAMAGES (OTHER THAN
THOSE UNDER THE FIRST ITEM LISTED ABOVE); 2) LOSS OF, OR DAMAGE
TO, YOUR RECORDS OR DATA; OR 3) SPECIAL, INCIDENTAL, OR INDIRECT
DAMAGES OR FOR ANY ECONOMIC CONSEQUENTIAL DAMAGES
(INCLUDING LOST PROFITS OR SAVINGS), EVEN IF IBM, ITS SUPPLIERS OR
YOUR RESELLER IS INFORMED OF THEIR POSSIBILITY. SOME
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION
OR EXCLUSION MAY NOT APPLY TO YOU.

Part 2 - Worldwide Country-Unique Terms
ASIA PACIFIC

AUSTRALIA: The IBM Warranty for Machines: The following paragraph is added
to this Section: The warranties specified in this Section are in addition to any rights
you may have under the Trade Practices Act 1974 or other legislation and are only
limited to the extent permitted by the applicable legislation.

Extent of Warranty: The following replaces the first and second sentences of this
Section: The warranty does not cover the repair or exchange of a Machine resulting
from misuse, accident, modification, unsuitable physical or operating environment,
operation in other than the Specified Operating Environment, improper maintenance
by you, or failure caused by a product for which IBM is not responsible.

Limitation of Liability: The following is added to this Section: Where IBM is in
breach of a condition or warranty implied by the Trade Practices Act 1974, IBM’s
liability is limited to the repair or replacement of the goods or the supply of
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equivalent goods. Where that condition or warranty relates to right to sell, quiet
possession or clear title, or the goods are of a kind ordinarily acquired for personal,
domestic or household use or consumption, then none of the limitations in this
paragraph apply.

PEOPLE’S REPUBLIC OF CHINA: Governing Law: The following is added to this
Statement: The laws of the State of New York govern this Statement.

INDIA: Limitation of Liability: The following replaces items 1 and 2 of this Section:

1. liability for bodily injury (including death) or damage to real property and tangible
personal property will be limited to that caused by IBM’s negligence;

2. as to any other actual damage arising in any situation involving nonperformance
by IBM pursuant to, or in any way related to the subject of this Statement of
Warranty, IBM’s liability will be limited to the charge paid by you for the
individual Machine that is the subject of the claim.

NEW ZEALAND: The IBM Warranty for Machines: The following paragraph is
added to this Section: The warranties specified in this Section are in addition to any
rights you may have under the Consumer Guarantees Act 1993 or other legislation
which cannot be excluded or limited. The Consumer Guarantees Act 1993 will not
apply in respect of any goods which IBM provides, if you require the goods for the
purposes of a business as defined in that Act.

Limitation of Liability: The following is added to this Section: Where Machines are
not acquired for the purposes of a business as defined in the Consumer
Guarantees Act 1993, the limitations in this Section are subject to the limitations in
that Act.

EUROPE, MIDDLE EAST, AFRICA (EMEA)

The following terms apply to all EMEA countries.

The terms of this Statement of Warranty apply to Machines purchased from an IBM
reseller. If you purchased this Machine from IBM, the terms and conditions of the
applicable IBM agreement prevail over this warranty statement.

Warranty Service

If you purchased an IBM Machine in Austria, Belgium, Denmark, Estonia, Finland,
France, Germany, Greece, Iceland, Ireland, Italy, Latvia, Lithuania, Luxembourg,
Netherlands, Norway, Portugal, Spain, Sweden, Switzerland or United Kingdom, you
may obtain warranty service for that Machine in any of those countries from either
(1) an IBM reseller approved to perform warranty service or (2) from IBM.

If you purchased an IBM Personal Computer Machine in Albania, Armenia, Belarus,
Bosnia and Herzegovina, Bulgaria, Croatia, Czech Republic, Georgia, Hungary,
Kazakhstan, Kirghizia, Federal Republic of Yugoslavia, Former Yugoslav Republic of
Macedonia (FYROM), Moldova, Poland, Romania, Russia, Slovak Republic,
Slovenia, or Ukraine, you may obtain warranty service for that Machine in any of
those countries from either (1) an IBM reseller approved to perform warranty
service or (2) from IBM.

The applicable laws, Country-unique terms and competent court for this Statement
are those of the country in which the warranty service is being provided. However,
the laws of Austria govern this Statement if the warranty service is provided in
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Albania, Armenia, Belarus, Bosnia and Herzegovina, Bulgaria, Croatia, Czech
Republic, Federal Republic of Yugoslavia, Georgia, Hungary, Kazakhstan, Kirghizia,
Former Yugoslav Republic of Macedonia (FYROM), Moldova, Poland, Romania,
Russia, Slovak Republic, Slovenia, and Ukraine.

The following terms apply to the country specified:

EGYPT: Limitation of Liability: The following replaces item 2 in this Section: 2. as
to any other actual direct damages, IBM’s liability will be limited to the total amount
you paid for the Machine that is the subject of the claim.

Applicability of suppliers and resellers (unchanged).

FRANCE: Limitation of Liability: The following replaces the second sentence of
the first paragraph of this Section: In such instances, regardless of the basis on
which you are entitled to claim damages from IBM, IBM is liable for no more than:
(items 1 and 2 unchanged).

GERMANY: The IBM Warranty for Machines: The following replaces the first
sentence of the first paragraph of this Section: The warranty for an IBM Machine
covers the functionality of the Machine for its normal use and the Machine’s
conformity to its Specifications.

The following paragraphs are added to this Section: The minimum warranty period
for Machines is six months.

In case IBM or your reseller are unable to repair an IBM Machine, you can
alternatively ask for a partial refund as far as justified by the reduced value of the
unrepaired Machine or ask for a cancellation of the respective agreement for such
Machine and get your money refunded.

Extent of Warranty: The second paragraph does not apply.

Warranty Service: The following is added to this Section: During the warranty
period, transportation for delivery of the failing Machine to IBM will be at IBM’s
expense.

Production Status: The following paragraph replaces this Section: Each Machine
is newly manufactured. It may incorporate in addition to new parts, re-used parts as
well.

Limitation of Liability: The following is added to this Section: The limitations and
exclusions specified in the Statement of Warranty will not apply to damages caused
by IBM with fraud or gross negligence and for express warranty.

In item 2, replace ″U.S. $100,000″ with ″1.000.000 DEM.″

The following sentence is added to the end of the first paragraph of item 2: IBM’s
liability under this item is limited to the violation of essential contractual terms in
cases of ordinary negligence.

IRELAND: Extent of Warranty: The following is added to this Section: Except as
expressly provided in these terms and conditions, all statutory conditions, including
all warranties implied, but without prejudice to the generality of the foregoing all
warranties implied by the Sale of Goods Act 1893 or the Sale of Goods and Supply
of Services Act 1980 are hereby excluded.

162 IBM
®

Netfinity
®

User’s Reference: ServeRAID™-4H Ultra160 SCSI Controller



Limitation of Liability: The following replaces items one and two of the first
paragraph of this Section: 1. death or personal injury or physical damage to your
real property solely caused by IBM’s negligence; and 2. the amount of any other
actual direct damages, up to the greater of Irish Pounds 75,000 or 125 percent of
the charges (if recurring, the 12 months’ charges apply) for the Machine that is the
subject of the claim or which otherwise gives rise to the claim.

Applicability of suppliers and resellers (unchanged).

The following paragraph is added at the end of this Section: IBM’s entire liability
and your sole remedy, whether in contract or in tort, in respect of any default shall
be limited to damages.

ITALY: Limitation of Liability: The following replaces the second sentence in the
first paragraph: In each such instance unless otherwise provided by mandatory law,
IBM is liable for no more than: (item 1 unchanged) 2)as to any other actual damage
arising in all situations involving non-performance by IBM pursuant to, or in any way
related to the subject matter of this Statement of Warranty, IBM’s liability, will be
limited to the total amount you paid for the Machine that is the subject of the claim.

Applicability of suppliers and resellers (unchanged).

The following replaces the second paragraph of this Section: Unless otherwise
provided by mandatory law, IBM and your reseller are not liable for any of the
following: (items 1 and 2 unchanged) 3) indirect damages, even if IBM or your
reseller is informed of their possibility.

SOUTH AFRICA, NAMIBIA, BOTSWANA, LESOTHO AND SWAZILAND:
Limitation of Liability: The following is added to this Section: IBM’s entire liability
to you for actual damages arising in all situations involving nonperformance by IBM
in respect of the subject matter of this Statement of Warranty will be limited to the
charge paid by you for the individual Machine that is the subject of your claim from
IBM.

TURKIYE: Production Status: The following replaces this Section: IBM fulfills
customer orders for IBM Machines as newly manufactured in accordance with IBM’s
production standards.

UNITED KINGDOM: Limitation of Liability: The following replaces items 1 and 2
of the first paragraph of this Section: 1. death or personal injury or physical damage
to your real property solely caused by IBM’s negligence; 2. the amount of any other
actual direct damages or loss, up to the greater of Pounds Sterling 150,000 or 125
percent of the charges (if recurring, the 12 months’ charges apply) for the Machine
that is the subject of the claim or which otherwise gives rise to the claim.

The following item is added to this paragraph: 3. breach of IBM’s obligations implied
by Section 12 of the Sale of Goods Act 1979 or Section 2 of the Supply of Goods
and Services Act 1982.

Applicability of suppliers and resellers (unchanged).

The following is added to the end of this Section: IBM’s entire liability and your sole
remedy, whether in contract or in tort, in respect of any default will be limited to
damages.

NORTH AMERICA
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CANADA: Warranty Service: The following is added to this section: To obtain
warranty service from IBM, call 1-800-565-3344.

UNITED STATES OF AMERICA: Warranty Service: The following is added to this
section: To obtain warranty service from IBM, call 1-800-772-2227.

Notices
References in this publication to IBM products, programs, or services do not imply
that IBM intends to make these available in all countries in which IBM operates. Any
reference to an IBM product, program, or service is not intended to state or imply
that only that IBM product, program, or service may be used. Subject to IBM’s valid
intellectual property or other legally protectable rights, any functionally equivalent
product, program, or service may be used instead of the IBM product, program, or
service. The evaluation and verification of operation in conjunction with other
products, except those expressly designated by IBM, are the responsibility of the
user.

IBM may have patents or pending patent applications covering subject matter in this
document. The furnishing of this document does not give you any license to these
patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

This section contains trademarks, electronic emission notices, and other important
information.

Any references in this publication to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for this
IBM product and use of those Web sites is at your own risk.

Edition Notice
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION ″AS IS″ WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
jurisdictions do not allow disclaimer of express or implied warranties in certain
transactions, therefore, this statement may not apply to you.

This publication could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements and/or
changes in the product(s) and/or the program(s) described in this publication at any
time.

This publication was developed for products and services offered in the United
States of America and the United Kingdom. It is possible that this publication may
contain reference to, or information about, IBM products (machines and programs),
programming, or services that are not announced in your country. Such references
or information must not be construed to mean that IBM intends to announce such
IBM products, programming, or services in your country.
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Requests for technical information about IBM products should be made to your IBM
reseller or IBM marketing representative. No part of this publication may be
reproduced or distributed in any form or by any means without prior permission in
writing from the International Business Machines Corporation.

© COPYRIGHT INTERNATIONAL BUSINESS MACHINES CORPORATION, 2000.
All rights reserved.

Note to U.S. Government Users — Documentation related to restricted rights —
Use, duplication or disclosure is subject to restrictions set forth in GSA ADP
Schedule Contract with IBM Corp.

Non-IBM Web sites
Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for this
IBM product and use of those Web sites is at your own risk.

Year 2000 readiness and instructions
This is a Year 2000 Readiness Disclosure.

A product is Year 2000 Ready if the product, when used in accordance with its
associated documentation, is capable of correctly processing, providing and/or
receiving date data within and between the 20th and 21st centuries, provided all
other products (for example, software, hardware, and firmware) used with the
product properly exchange date data with it.

This IBM PC hardware product has been designed to process four-digit date
information correctly within and between the 20th and 21st centuries. If your IBM
computer is on when the century changes, you should turn it off and then back on
again once, or restart the operating system, to ensure that the internal clock resets
itself for the new century.

This IBM PC product cannot prevent errors that might occur if software you use or
exchange data with is not ready for the Year 2000. IBM software that comes with
this product is Year 2000 Ready. However, software from other companies might
come with this IBM PC product. IBM cannot take responsibility for the readiness of
that software. You should contact the software developers directly if you wish to
verify readiness, understand limitations, or look for any software updates.

To learn more about IBM PC products and the Year 2000, visit our Web site at
http://www.ibm.com/pc/year2000. The information and tools there can help you with
your Year 2000 transition plan, especially if you have multiple IBM PCs. IBM
encourages you to check periodically for updated information.

Trademarks
The following terms are trademarks of the IBM Corporation in the United States or
other countries or both:

Alert on LAN OS/2 Warp
Aptiva PC Server
Chipkill PC 300
DB2 Predictive Failure Analysis
EtherJet ServeRAID
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HelpCenter ServerGuide
HelpWare ServerProven
IBM SurePath
IntelliStation TechConnect
Netfinity ThinkPad
Netfinity Advanced System Management Update Connector
Netfinity Manager ValuePoint
OS/2 Wake on LAN

Lotus and Domino are trademarks of Lotus Development Corporation in the United
States, other countries, or both.

Tivoli and NetView are trademarks of Tivoli Systems Inc. in the United States, other
countries, or both.

Intel, MMX, LANDesk, Pentium, Pentium II Xeon, and Pentium III Xeon are
trademarks or registered trademarks of Intel Corporation in the United States, other
countries, or both.

Microsoft, Windows, and Windows NT are trademarks or registered trademarks of
Microsoft Corporation.

UNIX is a registered trademark in the United States and other countries and is
licensed exclusively through The Open Group.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Other company, product, and service names may be trademarks or service marks
of others.

Important notes
Processor speeds indicate the internal clock speed of the microprocessor; other
factors also affect application performance.

When referring to hard disk drive capacity, MB stands for 1 000 000 bytes and GB
stands for 1 000 000 000 bytes. Total user-accessible capacity may vary depending
on operating environments.

Maximum internal hard disk drive capacities assume the replacement of any
standard hard disk drives and population of all hard disk drive bays with the largest
currently supported drives available from IBM.

Unless otherwise stated, IBM makes no representations or warranties with respect
to non-IBM products. Support (if any) for the non-IBM products is provided by the
third party, not IBM.

Some software may differ from its retail version (if available), and may not include
user manuals or all program functionality.
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Electronic emission notices

Federal Communications Commission (FCC) Statement
Federal Communications Commission (FCC) Class A Statement

Note: This equipment has been tested and found to comply with the limits for a
Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference when the
equipment is operated in a commercial environment. This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential area is likely to cause
harmful interference, in which case the user will be required to correct the
interference at his own expense.

Properly shielded and grounded cables and connectors must be used in order to
meet FCC emission limits. IBM is not responsible for any radio or television
interference caused by using other than recommended cables and connectors or by
unauthorized changes or modifications to this equipment. Unauthorized changes or
modifications could void the user’s authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) this device may not cause harmful interference, and (2)
this device must accept any interference received, including interference that may
cause undesired operation.

Industry Canada Class A emission compliance statement
Canadian Department of Communications Compliance Statement

This digital apparatus does not exceed the Class A limits for radio noise emissions
from digital apparatus as set out in the interference-causing equipment standard
entitled Digital Apparatus, ICES-003 of the Department of Communications.

Avis de conformité aux normes du ministère des Communications du Canada

Cet appareil numérique respecte les limites de bruits radioélectriques applicables
aux appareils numériques de Classe A prescrites dans la norme sur le matériel
brouiller : Appareils Numériques, NMB-003 édictée par le ministre des
Communications.

Australia and New Zealand Class A statement
Attention: This is a Class A product. In a domestic environment this product may
cause radio interference in which case the user may be required to take adequate
measures.

United Kingdom telecommunications safety requirement
Notice to Customers

This apparatus is approved under approval number NS/G/1234/J/100003 for indirect
connection to public telecommunication systems in the United Kingdom.
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European community directive conformance statement
This product is in conformity with the protection requirements of EC Council
Directive 89/336/EEC on the approximation of the laws of the Member States
relating to electro-magnetic compatibility.

Attention: This is a Class A product. In a domestic environment this product may
cause radio interference in which case the user may be required to take adequate
measures.

Taiwan electrical emission statement

Japanese Voluntary Control Council for Interference (VCCI) statement
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Index

A
active-passive mode 62
Active PCI 17, 18

see Hot-plug PCI 17
adapter xi

see also controller xi
adaptive read-ahead cache mode 123
Adobe Acrobat Reader xii
array

cluster 82, 83
creating 28

cluster 83
delete 115
failover 62, 66

arrays 1
auto-synchronization

failover 68
autosync (IPSSEND) 116

B
backup (IPSSEND) 113, 117
battery-backup cache 15

failover 62
BCS error codes 131
BIOS

compatibility mode 33
failover 61
FlashMan 21
saving settings 117
updates 13
updating 21

cluster 77
blocked

logical drive 11
physical drive

failover 68
built-in spare drive 7

C
cables

cluster 74
failover 62
SCSI

problems 120
cache memory 15
CDs

IBM ServeRAID Support 13
Microsoft Windows 2000 34
Microsoft Windows 2000 Advanced Server 77
Microsoft Windows 2000 Datacenter Server 99
Microsoft Windows NT Server Enterprise Edition

Component 86
Novell NetWare 5.0 33

certify (IPSSEND) 119
Class A electronic emission notice 167
cluster 69

cluster 69 (continued)
array 82, 83
BIOS

updating 77
cables 74
CD-ROM 74
configuration

initializing 75
controller

initializing 81
name 105, 141
replacing 142

controller name 74
creating

partition 94
ServeRAID disk resource 88, 96

detailed view (illus.) 70
error messages 144
failback 73
failed controller 140
failed server 140, 143
failover 73, 143
firmware

updating 77
high-level view (illus.) 70
hot-spare drive 74
hot-spare physical drive 74, 82, 83

ownership 102
logical drive 82, 83

adding 102
Basic Disk 94, 97
deleting 89, 98
maximum 75
merge group number 83, 84
migration 75
non-shared 75, 136
re-creating 89, 98
rebuilding 75
shared 75, 83, 136

merge group number 75
viewing 105, 141

NVRAM 81
partner name

viewing 105, 141
physical drive

ownership 101
problems 139
quorum drive 74, 83
RAID level-1 83
RAID level-5 83
RAID level-5E 83
SCSI initiator ID 74

viewing 105, 141
shared channel 82, 83
standby hot-spare physical drive 82
stripe-unit size 74
synchronization 75
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cluster 69 (continued)
updating

other server 91
ServeRAID 90, 91

validating 75, 79, 103
write back 75
write through 75

command-line programs 14
configuration

displaying 122
initializing

cluster 75
loading from file 117
saving 67, 84, 117
summary window 26, 31

configuration mode 23
(illus.) 24
custom 27
express 26
using 25

configuration program
see ServeRAID Manager 22

contents
options box 1
package 1

controller xi, 69
configuring 22

cluster 80
Microsoft Cluster Service 79
Novell High Availability Server 79

connector locations 15
failed

cluster 140
failover 61, 62

recovering from power failure 139
replacing in hot-plug PCI slot 139
replacing in non-hot-plug PCI slot 138

features 15
initializing

cluster 81
failover 63

installing 17
NetWare 20

messages 125
monitoring 123
name 33

cluster 74
onboard 62
problems 121
replacing 142
self-test 121
shared

starting 75
startup

device drivers 27, 32
controller name

failover 62
copyId (IPSSEND) 117
critical

logical drive 11
migrating logical drive 11

critical (continued)
system logical drive 11

custom configuration 27

D
data loss 17, 120, 136

RAID level-0 3
RAID level-00 10

debugging 120
defunct drive

recovering 136
defunct physical drive 10
delete (IPSSEND) 115
device

retrieve information 122
microcode version 122
serial number 122
vendor ID 122

device drivers 13, 14
installing 33

after operating system 42
Linux 35
NetWare 35, 43
OpenServer 38, 47
OS/2 36, 46
UnixWare 39, 47
Windows 2000 34, 42
Windows NT 4.0 34, 43
with operating system 34

startup controller 27, 32
updates 13
updating 42

Linux 44
NetWare 43
OpenServer 47
OS/2 46
UnixWare 47
Windows 2000 42
Windows NT 4.0 43

devices
Windows 2000

Hardware Compatibility List 77
IBM Server Proven List 77

devinfo (IPSSEND) 122
diskette

IBM ServeRAID Command-Line Programs 13
IBM ServeRAID Device Drivers 14
IBM ServeRAID Device Drivers for SCO Operating

Systems - UnixWare HBA and OpenServer
BTLD 14

IBM ServeRAID Windows NT Cluster Solutions 85,
93

see also CDs 13
DOS, starting IPSSEND 110
download

see updates 13
drive cloning 110
drive letter

permanent 88, 96
drivever (IPSSEND) 122
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E
ECS error codes 131
electronic emission Class A notice 167
enclosure

cluster 69
failover 61, 65

eraseevent (IPSSEND) 119
error codes

BCS 131
ECS 131
ISPR 131

error messages
cluster 144

example
RAID level-0 2
RAID level-1 4
RAID level-10 9
RAID level-1E 5
RAID level-5 6
RAID level-5E 7
spanned array 9

express configuration 26

F
failback

cluster 73
failover 61

(illus.) 68
active-passive mode 62
array 62, 66
auto-synchronization 68
battery-backup cache 62
BIOS 61
blocked physical drive 68
cables 62
cluster 73, 143
controller 61, 62

initializing 63
replacing in hot-plug PCI slot 139
replacing in non-hot-plug PCI slot 138

controller name 62
enclosure 61, 65
failure 138
fault tolerant 61
firmware 61
hot add 62
hot-spare physical drive 62
logical drive 66
merge group number 62
Microsoft Cluster Service 61
NVRAM 63
partner name 62
ready drive 62
recovering from power failure 139
stripe-unit size 61
write-cache mode 62
write through 61

fault tolerant
see failover 61

FCC Class A notice 167

firmware
failover 61
FlashMan 21
updates 13
updating 21

cluster 77
FlashCopy 110

autosync 116
backup 111, 113, 117
copyId 117
delete 115
import 116
init 117
map 111
nobackup 111, 114
restore 117
stop all 115
synch 118

FlashMan 21
format (IPSSEND) 120, 137

G
getbst (IPSSEND) 120
getconfig (IPSSEND) 122
getevent (IPSSEND) 120
getstatus (IPSSEND) 118

H
high-availability cluster solution 69
hot add 17

failover 62
NetWare 17
Windows 2000 17

Hot-plug PCI 17
hot remove 17

NetWare 17
Windows 2000 17

hot replace 17
ServeRAID Active PCI Hot Replace Wizard 17

hot-spare physical drive 10
cluster 74, 82

ownership 102
creating 28
failover 62

hot-swap drive
rebuilding 136

hot-swap rebuild feature
displaying status 122
turning on 122

hsrebuild (IPSSEND) 122

I
IBM

ServeRAID
Cluster Solution xii, 14
Support CD xii, 13, 14

Support Web site 14
clustering support 14
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IBM (continued)
ServeRAID support 14
using 14

import (IPSSEND) 116
important notes 166
information mode 23

(illus.) 25
using 33

init (IPSSEND) 117
initializing

logical drive 117
installation steps 13
installing

IPSMON
NetWare 56

IPSSEND
Linux 54
NetWare 54
OpenServer 55
OS/2 54
UnixWare 55
Windows 2000 54
Windows NT 4.0 54

IPSMON
installing 53

NetWare 56
starting 123
using 123

IPSSEND
certify 119
devinfo 122
drivever 122
eraseevent 119
FlashCopy 110

autosync 116
backup 111, 113, 117
copyId 117
delete 115
import 116
init 117
map 111
nobackup 111, 114
restore 117
stop all 115
synch 118

format 120, 137
getbst 120
getconfig 122
getevent 120
getstatus 118
hsrebuild 122
installing 53

Linux 54
NetWare 54
OpenServer 55
OS/2 54
UnixWare 55
Windows 2000 54
Windows NT 4.0 54

logs
clearing 22, 119

IPSSEND (continued)
readahead 123
rebuild 118
selftest 121
setstate 118
startdely 121
starting 110
stripesize 123
unattended 123
unblock 119
using 110

ISPR error codes 131

J
Java

Novell 50
SCO 52

L
LEDs 15
Linux

device drivers 35, 44
installing

IPSSEND 54
ServeRAID Manager 51

Red Hat 35
starting

IPSSEND 110
ServeRAID Manager 58
ServeRAID Manager agent 58

logical drive 1
adding

cluster 102
blocked 119
cluster 82, 83

blocked 136
deleting 89, 98
re-creating 89, 98

copying 117
creating 30

cluster 83
critical 118
failover 66
initializing 117
map 111
maximum

cluster 75
migration

cluster 75
status 118

non-shared 75
merge group number 84

rebuild 118
status 118

rebuilding
cluster 75

shared 75, 83
disk signatures 94
drive letter 95
merge group number 83, 84
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logical drive 1 (continued)
states 11
status 118
stripe

bad 120
synchronization

RAID level-5 85, 93
status 118

synchronizing 118
volume label 95

M
map (IPSSEND) 111
merge group number 33

cluster 75
failover 62
logical drive

non-shared 84
shared 83, 84, 88, 96

messages
controller 125
POST 130
startup 130

Microsoft Cluster Service
certified 77
configuring 93
configuring controllers 79
failover 61
IBM ServeRAID Support CD 14
installing

ServeRAID Manager 93
Windows NT 4.0 85

ServeRAID files 14
uninstalling 89, 99
updating

other server 91
ServeRAID 90, 91

migrating logical drive 11
Mini-configuration program 107

Advanced Functions 108
Configure BIOS Settings 109
Copy the Configuration from Drives to

Controller 109
Restore to Factory Default Settings 108
Setting the Bootable CD-ROM feature 109
View Configuration 108
View Controller and PCI Information 109
View Controller Status 107

multiserver rollout 110

N
NetWare

Active PCI 17
device drivers 35, 43
Hot-plug PCI 17
installing

controller 20
IPSMON 56
IPSSEND 54
ServeRAID Manager 50

NetWare (continued)
IPSMON 123
starting

IPSSEND 110
ServeRAID Manager 57

web site 50
write-cache mode 33

nobackup (IPSSEND) 114
non-shared logical drive 84
notices

Non-IBM Web sites 165
Novell

High Availability Server 79
configuring controllers 79

Java Virtual Machine 50
Vinca High Availability for Novell 79
web site 50

NVRAM
cluster 81
failover 63

O
offline logical drive 11
okay logical drive 11
online physical drive 10
OpenServer

device drivers 38, 47
installing

IPSSEND 55
ServeRAID Manager 52

Java Development Kit 52
Java Runtime Environment 52
starting

IPSSEND 110
ServeRAID Manager 58
ServeRAID Manager agent 58

OS/2
device drivers 36, 46
installing

IPSSEND 54
ServeRAID Manager 51

IPSSEND 53
starting

IPSSEND 110
ServeRAID Manager 57

P
package contents 1
partition

cluster 94
problems 125

partition table
erasing 117

partner name 33
failover 62

performance tuning 10
physical drive

cluster
ownership 101

Index 173



physical drive (continued)
data loss 120
defunct 136
delaying 121
failure

RAID level-0 3
RAID level-1 4
RAID level-1E 5
RAID level-5 7
RAID level-5E 8
RAID level-x0 10

formatting 120
recovering from incomplete 137

rebuilding 136
starting 121
states 10

changing 118
verify media 119

POST messages 130

power outage 15

Predictive Failure Analysis 119, 120

problems

cluster 139
controller, replacing 142
error messages 144
failed controller 140
failed server 140, 143
failover 143

controller 121
error codes

BCS 131
ECS 131
ISPR 131

failover 138
recovering from power failure 139
replacing controller in hot-plug PCI slot 139
replacing controller in non-hot-plug PCI slot 138

messages
controller 125
POST 130

rebuilding defunct drive 136
rebuilding hot-swap drives 136
recovering from defunct drives 136
recovering from incomplete format 137
SCSI bus 120
SCSI device 120
ServeRAID Manager 125
solving 125

program

command-line 14
FlashMan 21
IPSMON 123

installing 53
IPSSEND 110

installing 53
Mini-configuration 107
ServeRAID Manager 22
updates 13

publications xii

Q
quorum drive 74, 83, 87, 96

RAID level-1 87

R
RAID

level
performance tuning 10
selecting 10

level-0 2
blocked 119, 136
supported number of drives 2

level-00 8
see RAID level-x0 8

level-1 3
cluster 83
quorum drive 87, 96
supported number of drives 5
synchronization 75

level-1 Enhanced
see RAID level-1E 4

level-10 8
see RAID level-x0 8

level-1E 4
level-1E0 8

see RAID level-x0 8
level-5 5

cluster 83
logical drive 116
supported number of drives 6
synchronization 85, 93

level-5 Enhanced
see RAID level-5E 7

level-50 8
see RAID level-x0 8

level-5E 7
cluster 83
supported number of drives 7

level-x0 8
supported number of drives 8

technology 1
read-ahead cache mode 33, 123
readahead (IPSSEND) 123
README 13
ready drive

failover 62
ready physical drive 11
rebuild

defunct drive 136
physical drive 10
rate 33

rebuild (IPSSEND) 118
Red Hat Linux 35
restore (IPSSEND) 117

S
scan for new drives 85, 93
SCO

web site 52
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SCSI
channel 15, 83
channels

shared 82
initiator ID 33

cluster 74
transfer speed 33

self-test
controller 121

selftest (IPSSEND) 121
ServeRAID

Active PCI Hot Replace Wizard 17
installation steps 13
logs

clearing 22
Manager 13

Active PCI 17
Active PCI Hot Replace Wizard 17
agent 58
configuration mode 23, 24, 25
information mode 23, 25, 33
installing 49, 50, 51, 52, 93
logs 22
starting 56, 57, 58
using 22
validate cluster 75

ServeRAID Manager
agent

starting 58
setstate (IPSSEND) 118
shared channel 83
shared logical drive 83, 84, 88, 96

disk signatures 94
software

IBM Netfinity Hot Plug for Windows NT 4.0 17
spanned array 8, 111

creating 28
logical drive 10

standby hot-spare physical drive 11
cluster 82

startdely (IPSSEND) 121
startup messages 125, 130
stop all (IPSSEND) 115
stripe 2

bad 120
stripe-unit size 2, 26, 33

cluster 74
failover 61
performance tuning 2
ServeRAID-4H 2
setting 123
stripe 2

stripesize (IPSSEND) 123
sub-logical drive 10
synch (IPSSEND) 118
synchronization 85, 93
synchronize 116
system logical drive 11

T
tape backup 110, 113
trademarks 165, 166

U
unattended (IPSSEND) 123
unattended mode 33, 123
unblock (IPSSEND) 119
United States electronic emission Class A notice 167
United States FCC Class A notice 167
UnixWare

device drivers 39, 47
installing

IPSSEND 55
ServeRAID Manager 52

starting
IPSSEND 110
ServeRAID Manager 58
ServeRAID Manager agent 58

updates 14
BIOS 13
command-line programs 13
device drivers 13
firmware 13
IBM Support page 13
ServeRAID Manager 13

updating
BIOS 91
device drivers 91
firmware 91
other server 91
ServeRAID

Cluster Solution 90
Manager 90
software 90

upgrading
IBM ServeRAID Cluster Solution 98

V
validate cluster 75, 79, 103
volume label 95

W
web sites

IBM Support 14
Novell NetWare 50
SCO 52

Windows 2000
Active PCI 17
Advanced Server CD 77
device drivers 34, 42
failover 61
FlashCopy 110
Hardware Compatibility List 77
Hot-plug PCI 17
IBM Server Proven List 77
installing

IPSSEND 54
ServeRAID Manager 50

Microsoft Cluster Service 93
problems

ServeRAID Manager 125
starting

IPSSEND 110
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Windows 2000 (continued)
ServeRAID Manager 56

Windows 95

installing ServeRAID Manager 50

Windows 98

installing ServeRAID Manager 50

Windows NT 4.0

Active PCI 17
device drivers 34, 43
failover 61
FlashCopy 110
Hot-plug PCI 17
IBM Netfinity Hot Plug for Windows NT 4.0

package 17
installing

IPSSEND 54
Microsoft Cluster Service 85
ServeRAID Manager 50

problems
ServeRAID Manager 125

starting
IPSSEND 110
ServeRAID Manager 56

write back

cluster 75

write-back mode 15, 115

write-cache mode 33

failover 62
NetWare 33

write through

cluster 75
failover 61
mode 33

NetWare 33

Y
year 2000 readiness and instructions 165

176 IBM
®

Netfinity
®

User’s Reference: ServeRAID™-4H Ultra160 SCSI Controller





����

Part Number: 00N9132

Printed in the United States of America
on recycled paper containing 10%
recovered post-consumer fiber.

SC00-N913-20

00
N9

13
2


	Safety Information
	Preface
	How this book is organized
	Notices used in this book
	Related publications

	Chapter 1. Getting started
	Option package contents
	Understanding RAID technology
	Stripe-unit size
	Supported RAID levels
	Selecting a RAID level and performance tuning
	Drive state descriptions


	Chapter 2. Installing and configuring ServeRAID controllers
	Obtaining ServeRAID updates
	Downloadable files from the World Wide Web

	Step 1: Installing and cabling a ServeRAID controller
	Controller features
	Connector locations
	Using a ServeRAID controller in a server with Hot-plug PCI features
	Installing the ServeRAID controller
	Connecting external devices

	Step 2: Updating BIOS and firmware code
	Step 3: Configuring ServeRAID controllers
	Using the ServeRAID Manager program

	Step 4: Installing device drivers
	Installing device drivers while installing the operating system
	Installing or updating device drivers after installing the operating system

	Step 5: Installing the ServeRAID Manager program and other utilities
	Installing the ServeRAID Manager program
	Installing the IPSSEND and IPSMON command-line programs

	Step 6: Starting the ServeRAID Manager program
	Starting the ServeRAID Manager program in Windows 2000 and Windows NT
	Starting the ServeRAID Manager program in NetWare
	Starting the ServeRAID Manager program in OS/2
	Starting the ServeRAID Manager program in OpenServer, UnixWare, and Linux

	Chapter 3. Configuring two ServeRAID controllers in a failover environment (Windows NT 4.0 and Windows 2000 only)
	Hardware requirements
	Installation guidelines and restrictions
	Preparing the controllers
	Connecting the expansion enclosures
	Configuring ServeRAID arrays and logical drives
	Completing the failover environment installation


	Chapter 4. Introduction to IBM ServeRAID Cluster Solution
	Chapter 5. Preparing to install or change a cluster solution
	Terms and definitions
	ServeRAID considerations
	Hardware considerations
	Controller considerations
	Array or logical drive considerations

	Chapter 6. Updating the ServeRAID BIOS, firmware, and software code
	Chapter 7. Configuring ServeRAID controllers for clustering
	Configuring the controller for Microsoft Cluster Service using Windows NT 4.0 or Windows 2000
	Configuring the controller for Microsoft Cluster Service using Windows NT 4.0 or Windows 2000
	Configuring the controller for Vinca High Availability for Novell IntranetWare or Novell High Availability Server
	Configuring a controller for clustering
	Configuring ServeRAID arrays and a logical drive
	Chapter 8. Installing the Microsoft Cluster Service software on Windows NT 4.0
	Installing the Microsoft Cluster Service
	Creating a ServeRAID disk resource on a Windows NT 4.0 ServeRAID cluster
	Deleting and re-creating a ServeRAID logical drive resource
	Uninstalling MSCS on ServeRAID servers
	Updating ServeRAID software in an MSCS cluster environment
	Step 1: Upgrading the IBM ServeRAID Manager program
	Step 2: Upgrading the IBM ServeRAID Microsoft Windows NT Cluster Solution
	Step 3: Upgrading the IBM ServeRAID Windows NT device driver
	Step 4: Upgrading the IBM ServeRAID BIOS and firmware
	Step 5: Upgrading the software for the other server in the cluster


	Chapter 9. Installing the Microsoft Cluster Service software on Windows 2000
	Installing the ServeRAID Manager program
	Installing the Microsoft Cluster Service
	Creating a ServeRAID disk resource on a Windows 2000 ServeRAID cluster
	Deleting and re-creating a ServeRAID logical drive resource
	Upgrading the IBM ServeRAID Cluster Solution from Microsoft Windows NT 4.0 to Windows 2000
	Uninstalling MSCS on ServeRAID servers

	Chapter 10. Monitoring and updating an IBM ServeRAID Cluster Solution
	Checking the ownership of a physical drive
	Adding logical drives to a cluster
	Validating a cluster
	Viewing merge group numbers and other cluster information

	Chapter 11. Using utility programs
	Using the ServeRAID Mini-Configuration program
	Viewing the controller status
	Viewing the configuration
	Using the advanced configuration functions

	Using the IPSSEND command-line program
	FlashCopy function (for Windows NT and Windows 2000 only)
	Server roll-out functions
	Error-recovery functions
	Problem-isolation and debug functions
	RAID Configuration functions

	Using the IPSMON command-line program (NetWare only)

	Chapter 12. Solving ServeRAID problems
	ServeRAID Manager fails to start (Windows NT and Windows 2000 only)
	ServeRAID controller messages
	ServeRAID startup (POST) messages
	ServeRAID ISPR, BCS, and ECS POST error codes

	Rebuilding a defunct drive
	Steps for recovering from defunct drives
	Rebuilding a hot-swap drive

	Recovering from an incomplete format of a physical drive
	Solving problems in a failover environment
	Recovering from a failure in a failover environment
	Replacing a controller of a failover pair in non-hot-plug PCI slot
	Replacing a controller of a failover pair in hot-plug PCI slot
	Recovering from a power failure during a failover

	Troubleshooting an IBM ServeRAID Cluster Solution
	Recovering from a failed ServeRAID server
	Recovering from a failed ServeRAID controller
	Recovering from a failover in a Microsoft Cluster Service server
	Recovering from a failed server in a ServeRAID cluster
	Troubleshooting ServeRAID subsystems in a cluster environment


	Chapter 13. Getting help, service, and information
	Service support
	Before you call for service
	Getting customer support and service
	Using the World Wide Web
	Using electronic support services
	Getting information by fax
	Getting help online
	Getting help by telephone
	Getting help around the world

	Purchasing additional services
	Enhanced PC support line
	900-number operating system and hardware support line
	Network and server support line
	Ordering support line services
	Warranty and repair services
	Ordering publications


	Appendix. Product warranties and notices
	Warranty Statements
	IBM Statement of Limited Warranty for United States, Puerto Rico, and Canada (Part 1 - General Terms)
	IBM Statement of Warranty Worldwide except Canada, Puerto Rico, Turkey, United States (Part 1 – General Terms)
	Part 2 -Worldwide Country-Unique Terms

	Notices
	Edition Notice
	Non-IBM Web sites
	Year 2000 readiness and instructions
	Trademarks
	Important notes

	Electronic emission notices
	Federal Communications Commission (FCC) Statement
	Industry Canada Class A emission compliance statement
	Australia and New Zealand Class A statement
	United Kingdom telecommunications safety requirement
	European community directive conformance statement
	Taiwan electrical emission statement
	Japanese Voluntary Control Council for Interference (VCCI) statement

	Index

